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Introduction 

License Agreement 
 
HIGHWAY CAPACITY SOFTWARE™ (HCS™)  
END-USER LICENSE AGREEMENT (EULA) 
 
Effective Date: 9/1/2025 
 
 
Copyright © 2025 University of Florida. All rights reserved. 
 
This End User License Agreement (“Agreement”) is a legal agreement between you (“End User”, “you”) 
and the University of Florida Board of Trustees for the benefit of the McTrans Center (“McTrans”, ”we”) 
regarding the use of the Highway Capacity Software (“Software”). By accessing or using the Software 
programs within the electronically transmitted package or direct download, you agree to be bound by the 
terms and conditions of this Agreement.  
 
 
1. INTEGRATION: 
This License Agreement is the complete and exclusive statement of the agreement between End User 
and McTrans and supersedes any previous End User License Agreements distributed by older versions 
of the software proposal or prior agreement, oral or written, and any other communications between End 
User and McTrans relating to the subject matter of this License Agreement. This EULA will supersede the 
End User License Agreement contained in the HCS Version 5, 6, and 7 modules disseminated as part of 
the Software. This License Agreement may only be modified by a written agreement made subsequent to 
the date hereof and signed by both parties. 
 
 
2. LICENSE GRANT: 
2.1 Subscription-Based License: 
McTrans grants you a non-exclusive, non-transferable license to access and use the Software, subject to 
the terms of your active subscription. The license is valid only for the duration of your subscription and is 
contingent upon full payment of all applicable fees. 
 
2.2 Access to Software Versions:  
Your subscription grants access to versions 5 (selected modules), 6 (selected modules), 7 and 8 series 
and beyond (2022 onward) of the Software. When a new version of the Software is released, the End 
User with an active subscription can download and access the latest version at no additional cost for the 
remainder of their subscription term. 
 
 
3. TYPES OF SUBSCRIPTIONS: 
The type of subscription determines the permitted use of the Software. Once a subscription type is 
selected, it cannot be changed or exchanged for a different type. 
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3.1 Office-Based Subscription: 
This subscription grants access to the Software for a predetermined number of computers within a 
physical office. An "office" refers exclusively to a fixed geographical location, typically a single physical 
address, where an organization conducts its business or operational activities. This location must consist 
of one or more contiguous rooms or spaces within a single building. Virtual offices or any non-physical 
locations are excluded from this definition. 
 
The Software may be installed on multiple devices within the office, and access is restricted to end users 
officially assigned to that licensed office. End Users may also use the Software on portable computers, 
such as laptops, while on official travel, provided that all (100%) such use is exclusively on behalf of the 
office for which this Software license was purchased. Additional offices must obtain proper licensing prior 
to accessing the Software. The Software may only be installed on devices owned or controlled by the 
licensed office. 
 
This subscription is intended exclusively for commercial use. 
 
Virtualization Restriction:  
The Software under an office-based subscription is prohibited from being used in a virtualized 
environment. All installations of the Software must be conducted on a physical computer, such as a 
desktop or laptop. Remote access technologies, such as remote desktop, are strictly prohibited under this 
subscription type. 
 
3.2 Computer-Based Subscription: 
This subscription permits the installation and use of the Software on a specified number of individual 
devices. An "individual device" refers to a single, standalone computing unit, such as a desktop or laptop, 
intended for use by a single user at a time. Concurrent or simultaneous access by multiple users on the 
same computer or through any means of remote connection is strictly prohibited. The Software may only 
be accessed directly from the device(s) on which it is installed, regardless of whether the device is 
located in a physical office or used in a virtual office. End users working remotely or in virtual offices must 
ensure that the device remains dedicated to their use and fully complies with the terms of this 
subscription. 
 
Virtualization Restriction:  
The Software under a computer-based subscription is prohibited from being used in a virtualized 
environment. All installations must be conducted on a physical computer, such as a desktop, PC, or 
laptop. Remote access to the Software via any technology, including but not limited to remote desktop, is 
strictly prohibited under this subscription type. 
 
3.3 Volume-Based Subscription: 
This subscription permits the installation and use of the Software on a specified number of individual 
devices. An "individual device" refers to a single, standalone computing unit, such as a desktop or laptop, 
intended for use by a single user at a time. Concurrent or simultaneous access by multiple users on the 
same computer or through any means of remote connection is strictly prohibited. The Software may only 
be accessed directly from the device(s) on which it is installed, regardless of whether the device is 
located in a physical office or used in a virtual office. End users working remotely or in virtual offices must 
ensure that the device remains dedicated to their use and fully complies with the terms of this 
subscription. 
 
Virtualization Restriction:  
The Software under a Volume-based subscription is prohibited from being used in a virtualized 
environment. All installations must be conducted on a physical computer, such as a desktop, PC, or 
laptop. Remote access to the Software via any technology, including but not limited to remote desktop, is 
strictly prohibited under this subscription type. 
 
3.4 Academic Subscription: 
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The academic subscription is available exclusively to academic institutions and grants access to a 
specified number of seats (copies) across the entire academic institution. This subscription is intended 
solely for use in a classroom setting for teaching or a lab for research purposes under the direct 
supervision of faculty or other authorized personnel. The Software may only be installed on devices 
owned or controlled by the academic institution. 
 
The End User is required to implement appropriate protection measures to prevent students or any other 
individuals from copying the Software and removing it from the lab or classroom environment. The 
responsibility for safeguarding the Software and preventing unauthorized copying or distribution rests 
entirely with the End User. 
 
Virtualization for Virtual Classrooms:  
Under the academic license, the End User may request permission to utilize a virtual environment for the 
installation and use of the Software. Such virtualization is only permitted with prior written consent from 
McTrans. If such permission is granted, the virtual environment must adhere to all protections and 
restrictions outlined in this Agreement, ensuring that the Software is used exclusively for its intended 
educational purposes and its access is limited to the institution's faculty and actively enrolled students 
only. Additionally, the number of seats purchased must be sufficient to cover the number of students and 
faculty accessing the virtual classroom. 
 
 
4. SUBSCRIPTION TERM: 
4.1 Duration: 
The subscription term begins on the date of purchase and continues for the period specified at the time of 
purchase ("Subscription Term"). The license granted under this Agreement is valid only for the duration of 
the Subscription Term. 
 
4.2 Renewal: 
Subscriptions may be renewed upon payment of applicable fees before the end of the Subscription Term. 
If the subscription is not renewed, access to the Software and all related services, including technical 
support, will be terminated. 
 
 
5. TECHNICAL SUPPORT: 
5.1 Support Services: 
During the active Subscription Term, the End User is entitled to reasonable telephone or email support 
provided during the normal business hours of McTrans. McTrans reserves the right to determine the 
extent of the support provided. 
 
5.2 Revisions and Enhancements: 
McTrans reserves the right to make substantial revisions and enhancements to the Software and to 
market such substantially revised versions as separate products. The End User shall not be entitled to 
receive such separate products without additional charge. Upon the release of any such revised version 
of the Software, the obligation to provide the above-described technical support services to the End User 
shall cease unless the End User chooses to pay to license the enhanced version of the Software, 
regardless of whether the End User has previously requested or received support on the prior version. 
 
 
6. NETWORK USE: 
The End User is strictly prohibited from using the Software on any network. This prohibition includes but is 
not limited to the use of the Software either directly or indirectly through commands, data, or instructions 
transmitted to or from a computer that is not licensed or is not part of the licensed internal network. This 
also includes any use for Internet or web hosting services or by any user who does not hold a valid 
license for the Software from McTrans. 
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The Software is not designed for network use, and such use is unsupported. McTrans will not provide 
technical support for any issues resulting from network incompatibilities or unauthorized network use. 
 
 
7. RESTRICTIONS ON USE: 
The End User agrees that they shall not, nor shall they permit any third party to: 

● Software Modification: Modify, adapt, translate, or create derivative works based on the Software, 
in whole or in part, without the express prior written consent of McTrans. 

● Reverse Engineering: Reverse engineer, decompile, disassemble, or otherwise attempt to derive 
the source code of the Software, except to the extent expressly permitted by applicable law. 

● Unauthorized Use: Use the Software for any purpose other than as expressly permitted under this 
Agreement, including unauthorized copying, distribution, or dissemination of the Software. 

● Intellectual Property Infringement: Engage in any activity that infringes on the intellectual property 
rights of McTrans, including any unauthorized copying or distribution of the Software or 
associated documentation. 

● Copying and Distribution: Copy, reproduce, or distribute the Software or associated printed 
documentation for sale, distribution, or dissemination, except as expressly provided under the 
terms of this Agreement or with the express prior written consent of McTrans. 

● Documentation Use: Reproduce the associated documentation only as necessary for use within 
the permitted scope of the subscription type as outlined in this Agreement. 

● AI Training and LLMS Restriction: The End User agrees not to use the Software to train or 
develop any artificial intelligence (AI) model or large language model system (LLMS) without the 
express prior written consent of McTrans. This includes, but is not limited to, using the Software 
to generate or fine-tune AI models, create or modify LLMS, or use the Software as a data source 
for AI or LLMS training. Any attempts to do so will be considered a material breach of this 
Agreement and may result in termination of the license. 

 
Ownership of Software Modifications:  
Any modifications, adaptations, translations, derivative works, or any other products or materials resulting 
from any prohibited actions shall become the exclusive property of McTrans, regardless of whether such 
actions were performed with or without McTrans’ consent. 
 
 
8. INTELLECTUAL PROPERTY RIGHTS: 
The Software and all associated intellectual property rights are owned by McTrans. No rights are granted 
to the End User other than the limited license expressly set forth in this Agreement. 
 
 
9. USE OF RESULTS IN RESEARCH AND COMMERCIAL PUBLICATIONS: 
McTrans grants the End User legal permission to use the results generated by the Software in academic, 
research, or commercial publications, provided that such use complies with the terms of this agreement. 
The End User may publish or present findings derived from the Software as part of their research or 
commercial work as long as the Software is properly cited and all applicable license terms and restrictions 
are adhered to. Unauthorized reproduction or distribution of the Software itself remains strictly prohibited. 
 
 
10. TRANSFER OF LICENSE AND DEACTIVATION RESTRICTIONS:  
The Software is licensed only to the End User, and this License Agreement may not be assigned or 
transferred to anyone without McTrans’ prior written consent. Any authorized transferee of this License 
Agreement shall be bound by the terms of this License Agreement. The End User may not transfer, 
assign, rent, lease, sell, or otherwise dispose of the Software except as expressly provided in this License 
Agreement. 
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Deactivation requests are granted on a limited basis, such as hardware failure, device replacement or 
upgrade, reassignment of equipment, etc. To request deactivation, please email mctrans@ce.ufl.edu with 
a brief reason for your request and include the name of the computer or the machine you wish to 
deactivate. McTrans will then provide you with instructions on how to deactivate a license so you can use 
it on a different machine.  
 
 
11. LIMITED WARRANTY AND LIMITATIONS OF REMEDIES: 
End User acknowledges and agrees that it is the sole responsibility of End User to fully understand the 
limitations and assumptions underlying the Software and to refrain from using the Software without the 
assistance of personnel with appropriate expertise. The End User accepts full responsibility for reviewing, 
interpreting, applying, and utilizing the output of the Software and for ensuring that such output complies 
with any applicable design codes, standards, or project specifications. 
 
Except as expressly provided herein, the Software is provided “AS IS” without warranty of any kind, 
whether expressed or implied, including, but not limited to, implied warranties of merchantability and 
fitness for a particular purpose. McTrans does not warrant that the functions contained in the Software will 
meet the End User’s requirements or that the operation of the Software will be uninterrupted or error-free. 
The entire risk as to the quality and performance of the product is with the End User.  
 
In no event will McTrans be liable to the End User for any damages, including any lost profits, lost 
savings, or other incidental or consequential damages arising out of the use of or inability to use the 
Software, even if McTrans has been advised of the possibility of such damages, or for any claim by any 
other party. The above warranty gives the End User specific legal rights, and the End User may also have 
other rights in the United States, which vary from state to state.  
 
Use of the Software where the End User believes or has reason to believe that damage may occur 
constitutes a violation of any and all warranties. McTrans has no knowledge of the hardware or Software 
configurations of the End User and assumes no liability for their damage. 
 
 
12. TERMINATION: 
12.1 Termination by McTrans: 
McTrans may terminate this Agreement immediately upon notice if you fail to comply with any term or 
condition of this Agreement. Upon termination, you must cease all use of the Software and destroy all 
copies of the Software in your possession. 
 
12.2 Termination by End User: 
You may terminate this Agreement at any time by discontinuing the use of the Software and notifying 
McTrans. No refunds will be provided for any remaining portion of the Subscription Term. 
 
 
13. GOVERNING LAW: 
This License Agreement shall be governed by the laws of the State of Florida, U.S.A. Venue for all 
disputes related to this License Agreement shall be in the United States District Court of the Northern 
District of Florida, Gainesville Division, or in the Circuit Court of the Eighth Judicial Circuit for Alachua 
County, Florida. 
 
 
14. U.S. GOVERNMENT RESTRICTED RIGHTS: 
The Software and associated documentation are provided with RESTRICTED RIGHTS. Use, duplication, 
or disclosure by the U.S. Government is subject to restrictions as set forth in subdivision (c)(1)(ii) of The 
Rights in Technical Data and Computer Software clause at 52.227-7013 or subparagraphs (c)(1) and (2) 
of the Commercial Computer Software - Restricted Rights at 48CFR52.227-19. The contractor is 
McTrans, University of Florida, PO Box 116585, Gainesville, FL 32611-6585. 
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15. EXPORT REGULATION: 
The Software may be subject to U.S. export control laws and regulations, including the U.S. Export 
Control Reform Act and its associated regulations. End User will not directly or indirectly export, re-export, 
transfer, or release the Software to, or make the Software accessible from, any country, jurisdiction, or 
person to which export, re-export, transfer, or release is prohibited by applicable U.S. laws and 
regulations. End User will comply with all applicable laws and regulations and complete all required 
undertakings (including obtaining any necessary export license or other governmental approval) prior to 
exporting, re-exporting, transferring, or releasing, or otherwise making the Software available, outside the 
U.S. End User shall not export, re-export, transfer, or release the software or software source code to any 
country which is comprehensively sanctioned by the U.S. Department of the Treasury, Office of Foreign 
Assets Control (OFAC). 
 
 
16. SEVERABILITY:  
If any portion of this License Agreement shall be declared void or a nullity by a court of competent 
jurisdiction, then the remainder shall survive and remain in full force. Should you have any questions 
concerning this license, you may contact the McTrans Center, University of Florida, PO Box 116585, 
Gainesville, FL 32611-6585, U.S.A., [1] (800) 226-1013. 
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HCM Chapter 18 

This chapter describes the methodologies for evaluating the operation of each of the following urban 
street travel modes: motorized vehicles, pedestrian, bicycle, and transit. Each methodology is used to 
evaluate the quality of service provided to road users traveling along and urban street segment. 

This chapter describes methodologies for evaluating urban street segment performance from the 
perspective of motorist, pedestrians, bicyclists, and transit riders. These methodologies are referred to as 
the motorized vehicle methodology, the pedestrian methodology, the bicycle methodology, and the transit 
methodology. Collectively, the methodologies can be used to evaluate an urban street segment operation 
from a multimodal perspective. 

A street segment’s performance is described by the use of one or more quantitative measures that 
characterize some aspect of the service provided to a specific road-user group. Performance measures 
cited in this chapter include motorized vehicle travel speed, motorized vehicle stop rate, automobile 
traveler perception score, pedestrian travel speed, pedestrian space, pedestrian level-of-service (LOS) 
score, bicycle travel speed, bicycle LOS score, transit vehicle travel speed, transit wait-ride score, and 
transit passenger LOS score. 

The motorized vehicle computational procedure in this chapter can be used to estimate the capacity and 
level of service (LOS) of urban street segments. The analysis considers a wide variety of conditions 
including, but not limited to, the amount and distribution of traffic movements, traffic composition, 
geometric considerations, and details of movement phases and timing. Urban Street LOS is estimated as 
a function of arterial travel speed and arterial volume-to-capacity ratio. Signalized intersection operations 
are modeled largely on the basis of the HCM Chapter 19 procedures, albeit with key adjustments for 
signal coordination and platooned vehicle arrivals. 

Limitations of the Methodology 
The HCM Chapter 18 procedure does not directly account for mid-block parking activity, mid-block 
significant grade, mid-block capacity constraints, queue spillback between intersections, and turn bay 
queue spillover. The HCM Chapter 18 procedure is also affected by the same limitations contained within 
the HCM Chapter 19 procedure. 
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HCM Chapter 19 

This chapter describes separate methodologies for evaluating the operation of each of the following 
intersection travel modes: motorized vehicle, pedestrian, and bicycle. Each methodology is used to 
evaluate quality of service provided to road users traveling through a signalized intersection. 

This chapter describes methodologies for evaluating intersection performance from the perspective of 
motorist, pedestrians, and bicyclists. These methodologies are referred to as the motorized vehicle 
methodology, the pedestrian methodology, and the bicycle methodology. Collectively, the methodologies 
can be used to evaluate the intersection operation from a multimodal perspective. 

An intersection’s performance is described by the use of one or more quantitative measures that 
characterize some aspect of the service provided to a specific road-user group. Performance measures 
cited in this chapter include volume-to-capacity ratio, motorized vehicle control delay, pedestrian corner 
circulation area, pedestrian delay, pedestrian level-of-service (LOS) score, bicycle delay, and bicycle LOS 
score. 

The motorized vehicle computational procedure in this chapter can be used to analyze the capacity and 
level of service (LOS) of signalized intersections. The analysis considers a wide variety of conditions 
including, but not limited to, the amount and distribution of traffic movements, traffic composition, 
geometric considerations, and details of movement phases and timing. The primary focus is the 
determination of approach and intersection delay as well as the corresponding LOS. Signalized 
intersections, as addressed by HCM, are consistent with Urban Streets. 

Limitations of the Methodology 
This chapter does not account for turn-bay overflow and queue spillback. A queue storage ratio is 
calculated, but does not provide any adjustments to the capacity of the adjacent through lane. Free right 
turns for movements not under signal control are not modeled by this method. Right turn on red (RTOR) 
volumes are subtracted from the total right-turn flow since they are not processed during the green. The 
procedure does not allow for gap reduction or rest-in-walk for actuated signals. 
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HCM Chapter 23 

The computational procedure in this chapter can be used to estimate the capacity and level of service 
(LOS) of interchange ramp terminals and alternative intersections. The analysis considers a wide variety 
of conditions including but not limited to, the amount and distribution of traffic movements, traffic 
composition, geometric considerations, and details of movement phases and timing. Interchange Ramp 
Terminal LOS is estimated as combination of delays for a series of origin-destination movement pairs and 
the volume-to-capacity ratio and queue-storage ratio for each movement. Alternative Intersection LOS is 
dictated by the experienced travel time (ETT) for each origin-destination movement and the volume-to-
capacity ratio and queue-storage ratio for each movement. Signalized intersection operations are 
modeled largely on the basis of the HCM Chapter 19 procedures, albeit with key adjustments for signal 
coordination and platooned vehicle arrivals. 

Limitations of the Methodology 
This chapter does not account for turn-bay overflow and queue spillback. A queue storage ratio is 
calculated, but does not provide any adjustments to the capacity of the adjacent through lane. Right turn 
on red (RTOR) volumes are subtracted from the total right-turn flow since they are not processed during 
the green. HCS does not allow for gap reduction or rest-in-walk for actuated signals. 
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Getting Started 

System Requirements 
HCS is designed for standard Windows installations. For optimal performance, the system should be 
Windows 10 or newer. While HCS may be compatible with older versions of Windows, any installation 
and operational issues arising from using these older versions will be the sole responsibility of the end 
user. 

Getting Started 
To begin, click on File then New (or the “New File” icon). You will be presented with a dialog box to input 
the basic phase timing and base values for the intersection. (NOTE:  It is important to set the Forward 
Direction as the direction for your project. The software does not allow for the user to change this 
information once the program starts.)  Once these choices are made, click on “OK” to continue the input 
data process. 

Normal Windows keyboard and mouse functions are available. Arrow keys now navigate through the data 
fields. Tabbing, clicking to a new field, or pressing the Enter key will trigger a recalculation and update the 
Report pane. 

Templates 
 
The Signals and Streets modules of HCS provide the ability to import and export input data “templates”, 
to define intersections more efficiently. The Template feature allows important subsections of input data 
(lane configurations, phasing sequences, signal timings) to be automatically imported, or transferred 
between intersections, or transferred between datasets. If the desired data cannot be found within the 
existing templates, users can create and customize their own templates. When creating a brand-new 
dataset it is also possible to select a template on the Quick Start screen. 

 
Importing a Template - Templates can be imported by selecting File > Import > Template and then 
choosing from a list of available templates. A short description is provided for each template. If a user has 
already created and exported a template, it can be found under the All Templates option and the specific 
category option within which it was created. For example if a template was exported as a Detailed Input 
template, it can be found under the Detailed Input option (as well as under the All Templates option) from 
the Import Template dialog. 

Exporting a Template - Users can create and customize their own templates by selecting File > Export > 
Template. The subsequent menu will allow the user to specify a template file name, provide a short 
description, and then save the template into the appropriate folder. Once a template has been saved it 
can then be imported in the future as needed. 
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General Controls 

File 
 
New – Creates a new Streets file (*.xus) and starts a new analysis project. 
Open – Opens an existing HCS Streets file (*.xus), HCS2010 Signals file (*.xhs), or DAITA file (*.xhd). 
Example Folder – Opens folder with all HCS examples in File Explorer  
Recent Files – Allows quick access to files that have recently been created or altered. 
Close – Closes an existing Streets file (*.xus). 
Save – Saves an opened Streets file (*.xus) using the current file name. 
Save As – Saves an opened Streets file (*.xus) using a specified file name. 
Print – Prints a Signals/Streets report to the printer or specified electronic file. 
Print Preview – Displays preview of current report before printing. 
Import 

Streets CSV File – Imports data from a Streets CSV file. 
 QuickStreets CSV File – Imports data from a QuickStreets file. 
 Synchro-To-Streets Converter – Imports data from a Synchro CSV file. 
 Streets Data Template – Imports data from an existing template file. 
 DAITA File – Imports data from a DAITA file. 
CSV Import Wizard – Opens import wizard for importing data from a Streets CSV file. 
Export - Exports data in template form. 
 Streets CSV File – Exports data in a CSV file. 
 Streets Data Template – Exports data in template form. 
CORSIM 

View Animation – Sends data to the TSIS-CORSIM program for simulation and/or animation 
purposes; TRAFVU can be opened within TSIS-CORSIM to allow user to view animation 
Generate TRF File – Saves an open Streets file (*.xus) as a CORSIM file (*trf), which is a file that 
contains the input data used to define a CORSIM network and to drive the CORSIM simulation for 
a single simulation case 
Generate Input and Output Files – Saves an open Streets file (*.xus) as a CORSIM file (*trf), 
which is a file that contains the input data used to define a CORSIM network and to drive the 
CORSIM simulation for a single simulation case 

Exit – Exits Streets.  

View 
 
Toolbar – Toggles shortcuts from file menu near the top of the program. 
Status Bar – Provides additional information about the active input data field. 
Startup Screen – Opens the startup screen that initially showed when opening Streets 
Reports – Allows user to switch view of reports to either below or to the right of the input screen. 
Classic / Visual Mode – Toggles between Classic Mode and Visual Mode. 
Primary Data – Expands/collapses the screen to include/hide the primary data screen. 
Detailed Data – Expands/collapses the screen to include/hide the detailed input data screen. 
Interchange Data – Expands/collapses the screen to include/hide the detailed input data screen which 
includes interchange inputs 
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Multimodal Data – Expands/collapses the screen to include/hide the multimodal input data screen. 
Quick Lanes – Toggles enlarged lanes input screen. 
Quick Phases – Toggles enlarged phases input screen. 
Reports Panel – Toggles view of the report panel. 
Information – Toggles view of information (error and warning messages) regarding the current file. 
Auto-Calculate – Activates auto-calculate mode for whenever input values are changed. Auto-calculate 
mode can sometimes slow down the program when there are multiple intersections and/or time periods. 
Force Calculations – Forces a calculation whenever the user needs to refresh output data. Force 
Calculations is only applicable when Auto-Calculate mode is turned off. 
Quick Animation – Exports data to TSIS-CORSIM for animation purposes. 
Quick Optimization – Exports data to TRANSYT-7F to provide optimization of the urban street. 
Full Optimization – Internally performs HCM-based genetic algorithm optimization for the urban street. 
Time-Space Diagram – Provides a time-space diagram of the urban street. 
Flow Profile Diagram – Provides flow profile diagrams for the urban street. 

Edit 
 
Undo – Reverse previous editing operation. 
Redo – Revert to previous editing operation. 
Cut – Deletes data and moves it to clipboard. 
Paste – Places data from clipboard into the input panes. 
Settings – Provides preferences for exporting data and appearance of data in the reports. Also provides 
defaults for Analyst, Agency/Co, Time Period, Jurisdiction, and units. 

Windows 
 
New Window – Opens a new window for a new intersection. 
Cascade – Places the current files into smaller windows to allow a better view to multiple files. 
Tile Vertical – Files appear in column form for side-by-side analysis. 
Tile Horizontal – Files appear in row form for side-by-side analysis. 
Close All – Closes all windows, but leaves the HCS program open. 

Reports 
 
Signals/Streets Text Report – The text report contains mostly unformatted text outputs, although zoom 
magnification is available. The text report also contains a small number of outputs that are not available in 
the formatted reports. 
Input Report – The input report, which is formatted to display enhanced fonts and graphics, provides an 
echo of the input data. 
Results Report – The results report, which is formatted to display enhanced fonts and graphics, provides 
a summary of the most important output measures of effectiveness from the Chapter 19 procedure. 
Intermediate Report – The intermediate report, which is formatted to display enhanced fonts and 
graphics, provides additional outputs that are not available in the results report. Many of these outputs are 
called “intermediate” because they are computed prior to the final results, and because they are used to 
influence the final results. 
Graphical Summary – The graphical summary, which is formatted to display enhanced fonts and 
graphics, provides a visual representation of the intersection delay, queue, and LOS. 
Messages Report – The messages report contains warning messages and/or error messages, which are 
automatically generated by HCS upon analyzing the input/output data. These warning and error 
messages can also be viewed in a dialog screen by clicking on the “Information” toolbar icon. The 
messages report may also contain any user “comments” entered inside the Information screen. 
Full Report – The full report is a combination of the input, results, intermediate, and messages reports. 



 

Urban Streets Users Guide General Controls    13 

Safety and Emissions Report – The safety and emissions report, which is formatted to display 
enhanced fonts and graphics, provide a summary of the most important output measures related to safety 
and emissions. 
Segment Report – The segment report, which is formatted to display enhanced fonts and graphics, 
provides a summary of the most important output measures of effectiveness from the Chapter 18 
procedure. 
Access Point Report – This report provides information on each access point with lanes, volumes, 
balanced flow, proportion time blocked (for use in TWSC), and thru vehicle delay estimates. 
Street Heatmap – The street heatmap, which is formatted to display enhanced fonts and graphics, 
provides a visual representation of the % of BFFS and LOS of the urban street. 
Flow Profile Data – This report provides a text printout of flow profile values for each intersection and 
each segment. 
Interchanges Results – The Interchanges report details demand, delay and LOS by origin-destination 
pairs, as well as providing input and results summaries for each signalized intersection. 
Alternative Intersections Report – The alternative intersections report details flow rate, control delay, 
EDTT, ETT, and LOS by origin-destination, as well as providing input and results summaries for each 
intersection. 
Phasing and Time Summary – The phasing and timing summary, which is formatted to display 
enhanced fonts and graphics, provides a summary of the phasing and timing of each intersection within 
the dataset. 
Intersection Summary – The intersection summary, which is formatted to display enhanced fonts and 
graphics, provides a summary of each intersection within the dataset. 
None - Blanks out the report pane, and sometimes allows for faster program operation. 

Help 
 
Contents – Provides access to a glossary, acknowledgements, copyrights, information on Visual Mode, 
and information on the Chapter 18/19 procedures. 
Index/Search – Allows user to search for key terms or phrases within the contents. 
User Guide – Provides a comprehensive user guide in PDF format. 
HCM Reference Guide – Opens the McTrans website in the default web browser to request access to a 
reference guide for the HCM in PDF format. 
HCM Volume 4 Website – Opens the Highway Capacity Manual Volume 4 website in the default web 
browser to access the free online resource. 
HCS Updates – Sends the HCS version number anonymously without any personally identifiable 
information to McTrans to check for a newer version. 
HCM/HCS Training – Opens the McTrans Training Page in the default web browser to view the latest 
training opportunities. 
HCQS Website – Opens the TRB Highway Capacity and Quality of Service Committee website in the 
default web browser. 
Support – Provides user access to any FAQs, as well as McTrans contact information for any issues or 
concerns. 
About HCS – Opens an about window with software version information, EULA, general 
acknowledgements, contact information, and other relevant links. 

Toolbar Icons 
 
New – Creates a new Streets file (*.xus) and starts a new analysis project. 
Open – Opens an existing HCS Streets file (*.xus), HCS2010 Signals file (*.xhs), or DAITA file (*.xhd). 
Save – Saves an opened Streets file (*.xus) using the current file name. 
Print – Prints a Signals/Streets report to the printer or specified electronic file. 
Quick Animation – Exports data to TSIS-CORSIM for animation purposes. 
Quick Optimization – Exports data to TRANSYT-7F to provide optimization of the urban street. 
Full Optimization – Internally performs HCM-based genetic algorithm optimization for the urban street. 
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Time-Space Diagram – Provides a time-space diagram of the urban street. 
Flow Profile Diagram – Provides flow profile diagrams for the urban street. 
Auto-Calculate – Activates auto-calculate mode for whenever input values are changed. Auto-calculate 
mode can sometimes slow down the program when there are multiple intersections and/or time periods. 
Force Calculations – Forces a calculation whenever the user needs to refresh output data. Force 
Calculations is only applicable when Auto-Calculate mode is turned off. 
Information – Toggles view of information (error and warning messages) regarding the current file. 

Shortcuts 
 
Ctrl - N = create a new file 
Ctrl - O = open an existing file 
Ctrl - S = save data to file 
Ctrl - P = print report 
Ctrl - I = pop up the “information” dialog 
Ctrl - F1 = view the “help contents” 
F5 = toggle between Classic Mode and Visual Mode 
F6 = collapse/expand the “detailed input data” section 
F7 = collapse/expand the “multimodal input data” section 
F8 = pop up the “quick lanes” dialog 
F9 = pop up the “quick phases” dialog 
F11 = toggle the “reports panel” 
Ctrl - Shift - A = toggle the “auto-calculate” mode  
Ctrl - Shift - R = force calculations (if auto-calculate is turned off) 
Ctrl - Shift - L = launch “quick animation” 
Ctrl - Shift - O = launch “quick optimization” via one-touch export to TRANSYT-7F 
Ctrl - Shift - F = launch “full optimization” via HCM-based internal genetic algorithm 
Ctrl - Shift - T = view the time-space diagram 
Ctrl - Shift - P = view the flow profile diagrams 
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Operational Data 

General 
The user will first enter the General Information into the respective fields: Urban Street, Intersection and 
Project Description. The user may change the forward direction of the major street as well as the area 
type. The forward direction is important for relating the intersection to other intersections and upstream 
filtering when dealing with arterials or urban streets. The Area Type is defined as being in a “CBD or 
Similar” environment or not. Choosing this option will affect the Area Type Adjustment Factor for the 
saturation flow rate. The user may also enter the duration of the study and the peak hour factor (PHF). 
The duration is coded as the analysis period, which is normally 15 minutes (T=0.25 hours) to represent 
the length of time the peak flow is constant. The PHF is coded to change the volumes into flow rates, 
generally for planning applications. For operational applications, demands are coded in vehicles per 
period for a multiple-period analysis without use of the PHF. 

The input data screen and report screen are placed concurrently in the window. The user has the ability 
to place the report screen below or to the right of the input data screen.  

Note: The Status Bar at the bottom of the screen will identify the current field, the possible range or 
choices to input into the field, and default values that the software provides for a new file. 

The Quick Lanes control can be used for graphical coding of lane configuration data. Text input fields for 
number of lanes and shared lanes are also available under Detailed Input Data, if non-graphical coding of 
lane configuration data is needed. On the Quick Lanes control, lane combinations can be selected by 
clicking on the appropriate arrows to place them on the diagram for each approach. The geometry of 
each approach is described by coding the number of lanes and the movements allowed in each lane, 
including whether movements are exclusive or shared. This data is coordinated with the normal data 
entry screen, so changes in either view are reflected in the other. The Clear button can be used to delete 
all existing lanes if needed. 

Traffic 
Demand is coded for each movement of the intersection. Arrival demand in vehicles per period is required 
for any movement to be included in the analysis. If actual demand data are not collected for congested 
conditions, the rate cannot exceed capacity (by definition) and the analysis can significantly 
underestimate delay and queue.  

Note: Counting vehicles as they cross the stop line is not adequate for collecting data to analyze 
congested conditions. If demand approaches or exceeds capacity, arrival rate must be known to use 
demand in this methodology by collecting arrival data upstream of all queues associated with the 
approach, then reconciling the approach rate to each movement at the stop line. 

Multiple-Period Analysis is necessary to analyze congested conditions and properly model the operation 
for reasonable delay, queue and level of service results. Otherwise, the initial queue (d3) delay that builds 
and dissipates over the peak period is not considered in these computations. This analysis must begin 
and end with undersaturated periods to capture the complete oversaturated process. 
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Note:  If a user wishes to analyze additional time periods, they may add periods at the top of the screen. 
Adding a period will allow a user to change demand related data, but intersection geometry and phasing 
data will remain constant through all periods. 

Lane Width is entered as an average width for all the lanes in the lane group. 

Storage Length can be coded into the software and will have a direct effect on the Queue Storage Ratio 
(QSR). Users must take caution with the QSR. If the QSR exceeds 1.0, HCS will not identify that there will 
be spillovers into other lanes and cause unforeseen delays. If possible, any QSR above 1.0 should be 
alleviated prior to finalizing the analysis. If not possible, simulation is recommended. 

Base Saturation Flow Rate is available by lane group, but one value for all lane groups is typical. In fact, 
this is normally a jurisdiction-wide parameter that should be calibrated for each local area. It is adjusted to 
account for different factors and prevailing conditions. 

Note: Calibration from field data is detailed in HCM Chapter 31 and involves measuring the prevailing 
saturation flow rate for at least 15 cycles including a minimum of 8 vehicles in queue per cycle, excluding 
the first five vehicles (to account for start-up lost time) and permitted left turn lane groups (because of the 
complexity involved). The prevailing rate is compared with the computed rate to generate a proportion to 
apply to the base saturation flow rate to be used for any analyses performed within the jurisdiction. The 
HCM suggests this calibration be performed only every few years or when there is evidence of a change 
in driver behavior. Calibration of base saturation flow rate for local conditions is critical for accurate results 
within this procedure, since these rates can vary dramatically by jurisdiction. For example, larger cities 
typically have base rates well over 2000, while smaller towns can be well under 1600 – and this 
significantly changes the basis for capacity, ultimately used to compute delay and level of service. 

Percent Heavy Vehicles is coded to adjust the saturation flow rate for the effects of heavy vehicles in the 
traffic stream. Heavy vehicles occupy more space and have different operating capabilities with respect to 
passenger cars. The Heavy Vehicle Factor typically assumes 2.0 passenger cars per heavy vehicle, but 
this can be modified under Detailed Input Data. 

Percent Grade is entered for each approach to determine the Grade Adjustment Factor for saturation flow 
adjustment to account for the effects of grade on all vehicles. 

Buses 

Parking 

Bicycles 

Pedestrians 

Arrival Type is used to describe the quality of traffic progression as it approaches the intersection in 
question. The arrival type ranges between 1 and 6 with 1 being poor progression, 2 being unfavorable 
progression, 3 being random arrivals, 4 being favorable progression, and 6 being exceptional 
progression. These values and descriptions can be found in Chapter 19 of the HCM. 

Upstream Filtering (I) allows the user to select an upstream Signals data file for calculating the I-factor, for 
each approach with a signalized intersection within 0.6 miles. 

If there is an Initial Queue (unmet demand from the previous period), this value is coded by lane group in 
units of total vehicles. This value will have a direct effect on the value of d3 in the intersection delay 
calculations. 

Speed Limit 

Detector Length 

RTOR 
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Phasing and Timing 
The signal phasing sequence is specified by clicking on the dual-ring phasing diagram (phases 1 through 
8), also known as “Quick Phases”. Only the left-turn phasing needs to be specified, because thru 
movements and right-turn movements are automatically added to the phasing sequence as a function of 
laneage. The dual-ring phasing diagram contains logic to prevent invalid phasing sequences from being 
entered, given the available laneage. Left-turn movements in odd-numbered phases are used to reflect 
protected left-turns (i.e., “green arrow”), whereas left-turn movements in even-numbered phases are used 
to reflect permitted left-turns (i.e., “green ball” or “flashing yellow arrow”). When exclusive right-turn lanes 
exist, shielded right-turns may be added by clicking twice on the corresponding odd-numbered phase. 
Green, yellow, and all-red clearance times may be entered in the group box labeled “Timing”. After the 
signal phasing and timing are entered a sequential phasing diagram (labeled “Phase Duration”) will 
display the phase durations as computed by the HCM procedure in an equivalent “single-ring” format. 

Note:  Phase Durations are average times calculated for the fifteen-minute analysis period and may not 
represent times for any one cycle. For phases with very low demand, the average green may be lower 
than the minimum specified because some cycles would serve the minimum and some cycles would skip 
the phase. And, if the average is equal to the clearance time, the green may be displayed as zero. This is 
necessary to both show the averages and have them sum to the cycle length. 

Each distinct phase time is defined by coding the Phase Split (if coordinated), Maximum Green (if 
uncoordinated), Yellow Change, Red Clearance and Minimum Green times. Users may also code 
passage time and mark any movement for having a lag phase, dual entry, simultaneous gap out, or 
Dallas Phasing. For coordinated intersections the software will automatically update non-actuated phase 
splits, to reflect the cycle length and the actuated phase splits. 

The software also allows users to input field-measured phase times to be used directly if the actual values 
are known, eliminating the phase duration estimation procedure. If an intersection is labeled as 
coordinated, the cycle length and offset time become available options to coincide with the corresponding 
intersections. The timing lists an overall Phase Split which will change to keep the cycle length consistent 
for all movements. For coordinated intersections, the non-actuated phases (typically 2+6) will be 
computed from the sum of the actuated phase times honoring the specified cycle length. Uncoordinated 
intersections will not have the option of a cycle length or offset since the timing only affects the 
intersection in question. The phase split now becomes a Maximum Green and each phase is 
independent, so the user has the ability to change each movement. 

Detailed Input Data 
The user may input detailed information about the project including the Analyst, Agency or Company, 
Date, Time Period, Year and Jurisdiction of the Project. Many values within the Detailed Input Data 
screen are set values from the HCM, but the user has the ability to change any of them for local 
calibration. 

Global Optimization contains an array of inputs for signal timing design, if desired. These inputs may 
affect Quick Optimization (via one-touch export to TRANSYT-7F) and/or Full Optimization (via HCM-
based internal genetic algorithm). 

Multimodal Input Data 
If an intersection contains data for pedestrians and/or bicycles, the user can enter Signals multimodal 
data to determine a level of service score and corresponding LOS. Similar to vehicle data, the user may 
input multimodal volumes and geometry for the intersection in question. By entering this data, the user 
can obtain multimodal outputs and level of service in the reports section of the software. If an urban street 
contains segment-based data for pedestrians, bicycles, or transit, the user may enter Streets multimodal 
data to determine a segment-based multimodal LOS. For “operations only” analyses, checkboxes (“Hide 
Results”) are available to hide multimodal outputs on the Results Report and the Intermediate Report. 
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Interchange Ramp Terminals 
Beyond coding the signalized intersection(s), the user codes information specific to an interchange by 
defining the Interchange Type, Interchange U-Turn Volume and Turn Radius for (normally) two 
intersections selected as Interchange Intersections. 

HCS can evaluate various interchanges, including Diamond, Diverging Diamond, SPUI, and Parclo (A-
2Q, A-4Q, B-2Q, B-4Q, AB-2Q, and AB-4Q). To design an interchange in HCS, the user must define the 
intersection as an "Interchange Intersection" and select the appropriate interchange type under Detailed 
Input Data. For all interchanges except SPUI, two intersections must be defined as the same interchange 
type for proper analysis. For SPUI interchanges, only one intersection needs to be defined as an 
interchange. 

HCS adheres to the HCM layout for interchanges, which defaults the forward direction to Eastbound. For 
example, when designing a Parclo A-2Q interchange with the forward direction as EB, selecting "Parclo 
A-2Q" as the interchange type for both intersections will result in the following interchange layout. 

 

In this layout, Intersection 1 represents the intersection to the west of the interchange, while Intersection 2 
corresponds to the intersection to the east of the interchange. If the user wants to design an interchange 
with a different forward direction, corresponding adjustments must be made during the design process for 
both intersections. For instance, when selecting the Northbound direction, Intersection 1 becomes the 
one to the south, and Intersection 2 becomes the one to the north. Similar adjustments must be made 
when designing an urban facility. 

Alternative Intersections 
To model an alternative intersection, the user first codes the inputs for a conventional intersection and 
then specifies the desired type of alternative intersection (e.g., MUT with TWSC, RCUT, DLT). This will 
convert the file to the specified alternative intersection, allow for additional inputs relevant to any 
supplemental junctions, and generate an alternative intersection report. Note: Some alternative 
intersections such as MUT and RCUT require additional files to be attached before full results can be 
generated. 
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Signals/Streets Reports 
The lower pane (or right pane depending on user preference) displays the analysis outputs in a dynamic 
form, reacting to changes in the upper (or left) Entry pane. The Report portion of the screen can be 
viewed simultaneously with the Entry pane. All or a portion of the report can be copied to the Windows 
clipboard for insertion into other files by right-clicking into the Report pane, selecting all, and copying. The 
Report pane can also be printed or saved to an electronic file through File > Print. 

For signalized intersection analysis the user will have the option of viewing reports for Input Data, Results 
Summary, Intermediate Values, Messages and Comments, or a combination of all four reports. These 
formatted reports contain enhanced fonts and graphics, but a text option is also available. The text report 
contains mostly unformatted text outputs, although zoom magnification is available. The text report also 
contains a small number of outputs that are not available in the formatted reports. If results (e.g., Delay 
and Level of Service) do not appear on the Results Summary report, the user can review the Messages 
Report (or Information button) for possible errors within the input data. 

For urban street analysis, the user can choose between a segment-based formatted report, and a 
segment-based text report. These reports also contain access point input and output data, if any access 
points exist. As with the signalized intersection reports, the segment text report also contains a small 
number of outputs that are not available in the formatted reports. 

Users who wish to print any report should ensure that this report is displayed in the report pane of the 
software. Accessing the print option under the File menu will present the traditional printing options. A 
preview of all pages to be printed is recommended. Changing the margins of the report will allow more 
information to fit on fewer pages, as opposed to having very little information appear on an extra page. 

It is also possible to view the reports in XPS format. This format provides an image to be seen by using a 
XPS Viewer or an Internet Browser such as Internet Explorer. Mozilla Firefox is not compatible with 
showing XPS files. This procedure can be done by selecting File > Print and choosing “Microsoft XPS 
Document Writer.”  This will allow a user to save the file in (*.xps format) and can later be viewed by the 
recommended web browsers. 
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Visual Mode 

Overview of Visual Mode 
 
A map rendering screen (“Visual Mode”) is available for displaying urban street geometry, and editing 
urban street input data. Visual Mode may allow the user to better understand the data entry process, and 
may assist in explaining the model to unfamiliar parties. In addition, the ability to display input and output 
data on the map can be useful for verification and validation of the model. User-supplied bitmap 
background images can be helpful for understanding the real-world signal system represented by the link-
node diagram, and can be helpful when dragging and dropping intersections to their appropriate 
locations. 
 
When an Urban Streets (*.xus) input file is open, a tab for switching to Visual Mode is located next to the 
Classic Mode tab, near the upper left-hand corner of the program screen. Pressing the F5 key will also 
toggle between Visual Mode and Classic Mode. Visual Mode currently offers the following features: 
 

 Adding curvature 
 Adding a new access point 
 Showing or hiding the grid 
 Easy bitmap background scaling 
 Map colors and layout properties 
 Zoom in, zoom out, pan, show all 
 Align intersections vertically or horizontally 
 Graphical adding and deleting of intersections 
 Select and move entire groups of intersections 
 Ability to underlay user-supplied bitmap backgrounds and aerial photos 
 Right-click or double-click on intersections to edit their properties (tabular view) 
 View intersection delay and LOS by moving the mouse pointer over an intersection 
 Copy-and-paste intersections, to avoid re-coding lane configuration, volumes, and timings 
 View option for showing Intersection Name, Intersection LOS, Intersection Delay, Segment 

Length, Segment Name, Speed Limit, Access points and Access Point Name 
 
An example of Visual Mode is illustrated below. 
 
 



 

Urban Streets Users Guide Visual Mode    21 

 
 
The default segment length is typically 1000 feet for brand-new data files. The first time Visual Mode is 
selected, intersections will be placed at 1000-foot increments, unless the user has already modified 
segment lengths within Classic Mode. Intersections will be oriented according to the Urban Street 
Forward Direction. 
 
There are two methods (manual and graphical) for entering segment lengths. If segment lengths are 
entered manually, intersections will continue to be positioned in a straight line, consistent with the Urban 
Street Forward Direction. In Classic Mode, segment lengths can be entered manually after clicking on the 
“All Segment Lengths” button. The Segment Lengths dialog for manual specification of segment lengths 
is shown below. 
 

 
 
Segment lengths are adjusted graphically whenever the user 1) drags and drops intersections into 
different positions, or 2) the user right-clicks on intersections to enter specific node coordinates, or 3) 
adds curvature to a segment. In this case, segment lengths will be automatically re-calculated by Visual 
Mode as a function of node coordinates, and any segment curvature that might exist. Segment lengths 
can be changed graphically at all times, but they can only be entered manually when intersections are 
positioned in a straight line with no curvature. The Segment Lengths dialog for manual specification of 
segment lengths will be disabled if curvature exists, or if intersections are not positioned in a straight line. 
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Link connections (a.k.a. segments) between intersections automatically appear whenever intersections 
are added. Intersection details can be specified by right-clicking and selecting the “Edit” option, or by 
switching back to Classic Mode. 
  
When Visual Mode is initially opened, the Pointer icon is activated on the toolbar toward the top of the 
screen. When the Pointer icon is activated, the user can select individual intersections (or groups of 
intersections), drag-and-drop intersections, and right-click on intersections to edit their properties. Other 
toolbar icons may be used to superimpose input/output information on the map, add or delete 
intersections, add or delete curvature, or change the view (zoom in, zoom out, show all). Certain toolbar 
icons will cause the mouse cursor to change shape, to indicate a different mode of operation. For 
example, if the “Zoom In” icon is selected, the mouse cursor takes the shape of a magnifying glass. To 
return to the default Pointer mode at any point during the session, the user can either right-click on the 
general map area, or click back on the Pointer icon. 
 
The Pointer icon can be used to draw a “rubber band” around groups of intersections. To do this, left-click 
on the general map area, hold the mouse button down without releasing, drag the rubber band around a 
group of intersections, and then release the mouse button. Any intersections within the rubber band area 
should become highlighted. This group of intersections can then be dragged-and-dropped across the 
map, or lined up to have the same X or Y coordinate. After modifying a particular group of intersections, 
you can “unselect” them by clicking anywhere in the general map area. 
 
Available “hotkeys” include F5 (toggle between Visual Mode and Classic Mode), F8 (Quick Lanes), F9 
(Quick Phases), and F11 (Reports). Scrolling up and down via scroll wheel results in zoom in and zoom 
out. 

Toolbar Icons in Visual Mode 
 
Show All 
When Visual Mode is initially opened, the “Show All” function is automatically applied. Typically after 
zooming or scrolling the map for some time, the user will want to return to that initial view where the link-
node diagram was centered within the screen. Clicking on the Show All icon accomplishes this. If the link-
node diagram is too large to fit within the screen, the Zoom Factor will be reduced to the largest possible 
value that makes the entire link-node diagram visible. 
 
Pointer 
The Pointer icon allows the user to select individual nodes (or groups of nodes), drag-and-drop nodes, 
and right-click on nodes to edit their properties. Groups of intersections can also be selected by dragging 
a rubber band around them.  
 
Zoom In 
After clicking on the Zoom In icon, the user can drag a rubber band around a section of the map to be 
magnified. If the horizontal and vertical proportions of this rubber band area match the horizontal and 
vertical proportions of the screen, the selected area can become the exact viewing area on the entire 
screen. Secondly, analog zooming can be achieved by simply left-clicking once inside the general map 
area. When analog zoom is used, Visual Mode will zoom in on the clicked spot by a fixed percentage. 
 
Zoom Out 
After clicking on the Zoom Out icon, the user can click on a map spot they wish to zoom out from. Visual 
Mode will then zoom out from the clicked spot by a fixed percentage. 
 
Pan 
After clicking on the Pan icon, the user can then drag the entire map in any direction. 
 
New Intersection 
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After clicking on the New Intersection icon, the user can then drop a new intersection anywhere on the 
map. If the user wishes to add several new intersections in rapid succession, having the same default 
values, this can be performed by copying and pasting any chosen intersection. 
 
Delete Intersection 
After the Delete Intersection icon is selected, the user can then click on the most recent intersection to be 
deleted. 
 
Add Curvature 
After the Add Curvature icon is selected, two control points are automatically placed in the middle of each 
link (segment). Dragging and dropping either one of these control points will then create link curvature. 
When zooming and scrolling the map, link curvature is preserved. However, when dragging and dropping 
one or more nodes across the map, curvature control points are not automatically updated. Because of 
this, link curvature may need to be re-drawn after moving nodes across the map. It may be preferable to 
code link curvature after all nodes are already in their final positions. Curvature can also be added by left-
clicking on any segment between two intersections. 
 
New Access Point 
After clicking on the New Access Point icon, access points can then be added on to any given segment. 
Access point input data can then be entered by right-clicking on the access point and selecting Edit. 
 

 
 
Align Nodes 
Selecting a group of intersections causes the Align Nodes Horizontally and Align Nodes Vertically icons to 
appear on the toolbar. The dialog shown below can then be used to align all intersections horizontally or 
vertically, if desired. 
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Map Colors and Properties 
This icon opens the Layout Properties dialog. Values and settings within this dialog are stored into 
memory on the computer every time the “OK” button is pressed. 
 

 
 
 
Show Grid 
If the Show Grid icon is activated, horizontal and vertical gridlines will be displayed across the map. This 
can be helpful for understanding the amount of real-world distance represented by the map. 
 
Show Background Image 
This icon can be used to show or hide the bitmap background. The icon is only enabled if a bitmap 
background image has been loaded (using Background Image Properties). 
 
Background Image Properties 
The Background Image Properties dialog screen is shown below. The Browse button allows the user to 
search for available bitmap background files on the computer. Image origin specifies the lower left-hand 
X, Y coordinates of the bitmap background (the adjacent picture allows the user to change the origin via 
drag-and-drop). The Bitmap Scaling icon is probably a more effective mechanism for bitmap background 
scaling, but the image scale coordinates below allow for manual scaling of the bitmap background. 
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Background Image Scaling 
The Background Image Scaling icon is only enabled if a bitmap background image has been loaded 
(using Background Image Properties). After clicking on this icon, the user can draw a line between any 
two points on the map, where the distance between these two points is known. After the line has been 
drawn, the dialog screen shown below will pop up. After the actual distance (in units of feet) between 
these two points is entered, the bitmap background image will automatically scale itself to the proper size. 
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Advanced Features 

Quick Animation 
Please refer to the CORSIM section. 

CORSIM  
Selecting File > CORSIM > View Animation, will display CORSIM Animation (also known as TRAFVU) for 
the currently loaded HCS data file. HCS-Streets will automatically generate a CORSIM input (*.trf) file, 
process the TRF file through CORSIM and then launch TRAFVU to provide animation of the urban street 
(or signalized intersection, if only one intersection exists in the dataset). 

 

 

 

This overall process may take a few seconds. Once TRAFVU is loaded, the user will need to: 

 Click on the red “Vehicle” icon to display vehicles 
 Zoom in on a certain part of the link-node diagram 
 Adjust the “APC settings” to slow down animation 
 Press “Play” to begin animation 

CORSIM and HCS contain different modeling methodologies, so the visible results (e.g., queue lengths) 
from CORSIM animation may not always be consistent with HCM procedure results from HCS. 

TRAFVU graphics are very informative for learning about actuated control. By turning on the map 
adornment for Sensors, it is possible to show typical detector layouts for semi-actuated or fully-actuated 



 

Urban Streets Users Guide Advanced Features    27 

control. Clicking on an actuated signal will reveal the dual-ring phasing sequence. For semi-actuated 
signals, pie charts are available for graphic display of permissive periods and force-offs. 

The following HCS inputs are exported to CORSIM and displayed by TRAFVU:  Peak adjusted traffic 
volumes, signal timing, lane configuration, adjusted saturation flow rates, start-up lost times, percent 
heavy vehicles, right-turns on red, duration of analysis, available queue storage, intersection names, and 
segment names. Link-specific mean discharge headways in CORSIM do not reflect any heavy vehicle or 
turn movement saturation flow rate adjustments from HCS, because this would constitute “double-
counting” their effect on results. 

The following HCS inputs are not exported to CORSIM:  Average queue spacing, initial unmet demand, 
arrival type, I-factor, extension of effective green, pedestrian data 

The following data ranges are enforced: 

 Start-up lost time (0.0-9.9 seconds) 
 Turn pocket or turn bay length (20-1000 feet) 
 Link length (50-9999 feet) 
 Saturation flow rate (1000-4000 vehicles per lane per hour) 
 Number of turn pockets (maximum of 2 LT and 2 RT pockets) 
 Volume (maximum of 9999 vehicles per hour) 
 Green plus yellow time must be at least 8 seconds for non-overlap phases 
 Green time must be at least 5 seconds for non-overlap phases 

The following assumptions and limitations also exist:  Vehicle arrivals to an isolated intersection in 
CORSIM are always random, and cannot be forced to be platooned by coding an “Arrival Type” other 
than ‘3’ in HCS. Link lengths and turn pocket lengths for CORSIM are taken from the “Available Queue 
Storage” fields in HCS. If no queue storage lengths are coded in HCS, link lengths are automatically set 
to 2000 feet. When a left-turn in HCS is opposed by a right-turn, but is not opposed by a thru movement, 
assumptions are made in CORSIM regarding left-turn protection and signal phasing. For actuated 
coordination, if dual lagging left-turns are present on the major street, it is assumed that any protected 
left-turns on the minor street will also lag their associated thru movements. If a protected right-turn green 
arrow moves in the same phase as a conflicting thru movement in HCS, CORSIM may not illustrate this. 
Green time in HCS should not be given to any turning movements whose “adjusted” volumes are equal to 
zero. T-intersections in CORSIM will sometimes be illustrated with four approaches, where one approach 
contains no moving traffic. If three or more exclusive left-turn lanes are coded in HCS-Signals, only two 
exclusive left-turn lanes will be transferred to CORSIM. If three or more exclusive right-turn lanes are 
coded in HCS-Signals, only two exclusive right-turn lanes will be transferred to CORSIM. If six or more 
thru lanes are coded in HCS-Signals, only five thru lanes will be transferred to CORSIM. 

These are not limitations of CORSIM, because CORSIM itself can simulate these conditions. These are 
only limitations of the conversion process between HCS and CORSIM. If any of these assumptions or 
limitations do not match conditions in the field, the user can select File > CORSIM > Generate TRF File, 
and customize the CORSIM input data within TSIS.  

If an error message says “This feature requires TSIS-CORSIM” even after TSIS has been installed, it may 
be necessary to first run TSIS in the standalone mode, so that TSIS-CORSIM can be properly registered 
on the computer. If the user does not have administrator rights, they may encounter an error message 
that says “ERROR: Failed to find file”. This error message should not hinder animation, so the user 
should simply click “OK” and then view animation normally. 

Quick Optimization 
There are two options for signal timing optimization: Quick Optimization (via one-touch export to 
TRANSYT-7F) and Full Optimization (via HCM-based internal genetic algorithm). Generally speaking, 
Quick Optimization is preferable for quickly finding a reasonable and effective timing plan, whereas Full 
Optimization is preferable for locating the “global optimum solution”. The Minimum Cycle Length, 
Maximum Cycle Length, and Cycle Length Increment input fields (under Detailed Input Data > Global 
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Optimization) can be used to automatically request cycle length optimization. When the user clicks on the 
Quick Optimization icon, volumes and timings from the HCS dataset are automatically transferred to a 
corresponding TRANSYT-7F dataset, and the optimization process begins immediately. Following 
optimization, outputs are automatically displayed in the dual-ring report shown below. 
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Compared to Full Optimization, the Quick Optimization feature has specific strengths and weaknesses. 
Quick Optimization employs the hill-climb optimization method, which is much faster than the genetic 
algorithm. However, the hill-climb method is also a less effective search technique than the genetic 
algorithm. Thus Quick Optimization is faster than Full Optimization, but may result in a less effective 
timing plan. Other miscellaneous advantages of Quick Optimization include queue spillback analysis and 
lane-by-lane analysis, which are innate features of TRANSYT-7F. Other disadvantages include model 
results that may differ from HCS (particularly in the case of permissive left-turns), and the inability to 
optimize multi-period datasets. To circumvent the disadvantages related to hill-climb optimization and 
multi-period optimizations, the user may launch TRANSYT-7F in stand-alone mode and import the *.xus 
files (s) from HCS. When running in stand-alone mode, TRANSYT-7F has the ability to perform genetic 
algorithm optimization and multi-period optimization; but such optimizations require more extensive run 
times on the computer, and would no longer be considered “quick optimization”. 

Full Optimization 
Full optimizations may require extensive run times on the computer, but the user may terminate the 
optimization process at any time. The genetic algorithm search technique is specifically designed to 
locate the global optimum solution provided that 1) the original dataset already has a reasonable and 
effective timing plan, 2) the “number of generations” is sufficiently high, and 3) the detailed settings 
(population size, mutation probability, etc.) are reasonably tailored to the given urban street. Thus Full 
Optimization is slower than Quick Optimization, but it should result in a more effective timing plan. The 
optimization “dashboard” is shown below. 

 

 

 

When the user clicks on the Full Optimization icon, the optimization dashboard will be displayed. The 
Input Parameters section of the dashboard will be displayed by default; the user will then have the 
opportunity to adjust optimization settings before the optimization run. The Info button, which is linked to 
the Diagnostic Messages section, will be enabled if the dashboard detects any inputs that might make the 
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optimization process less efficient. Clicking on the Start button will begin the optimization process. The 
dashboard value of “Generation Optimum” will increase each time a better signal timing plan is 
successfully located. 

Currently there are three possible ways that the optimization process can terminate: 1) termination via 
convergence threshold, 2) termination via max number of generations, and 3) termination via user 
request. Termination via convergence threshold will occur whenever the optimization process detects that 
little additional improvement is possible. Termination via max number of generations will occur whenever 
the optimization process reaches the user-specified maximum number of generations. Termination via 
user request will occur whenever the user clicks on the Stop button. Because of the “start-stop-resume” 
feature, the user can stop and re-start the optimization process at any time. 

Other miscellaneous advantages of Full Optimization include HCM-compliant modeling for each 
candidate timing plan, and optimized timings presented in the HCS format. Other disadvantages include 
the need to specify appropriate genetic algorithm settings for the given urban street, but the Info button 
(and Diagnostic Messages section) is designed to prevent the use of inefficient settings. 

Larger urban streets will typically benefit from lower mutation probabilities, higher population sizes, and a 
larger number of generations. Apart from the number of generations, which must frequently be 
customized to match the amount of optimization needed, the default genetic algorithm settings should 
work well for most medium-sized urban streets. For a more detailed discussion of genetic algorithm 
theory, refer to Chapter 5 of the TRANSYT-7F User Guide. 

Phasing sequence optimization is currently designed to optimize lead/lag phasing (and sometimes Dallas 
Phasing) on the major street, and will not modify phasing sequences on the minor street. If Full 
Optimization generates dual lagging left turns at one or more intersections, but the user’s original timing 
plan does not contain dual lagging left turns at any intersections, values of lead/lag and Dallas Phasing 
will revert to the user’s original values at the dual lagging intersections. If Full Optimization generates dual 
lagging left turns at one or more intersections, and the user’s original timing plan contained dual lagging 
left turns at one or more intersections, the dual lagging values will be allowed to stick, and Dallas Phasing 
will be turned off at these intersections. 

When performing phasing sequence optimization, the “Dallas Phasing Optimization” checkbox can be 
activated to prevent phasing sequences that would result in a “yellow trap” for the permissive left-turners. 
If the Phasing Sequence Optimization checkbox is selected without Dallas Phasing Optimization, the 
dashboard will post a warning message, but the optimization process will not modify the user’s original 
values of Dallas Phasing. If Phasing Sequence Optimization is selected with Dallas Phasing Optimization, 
the optimization process will turn on Dallas Phasing when a lagging left turn is opposed by a permissive 
left turn, and will turn off Dallas Phasing when both left turns are leading. 

Although the Info button (linked to the Diagnostic Messages section) will be enabled when detecting 
inputs that might make the optimization process less efficient, there are some macroscopic strategies that 
the user should also consider. One such strategy could involve turning off the “Allow Optimization” 
checkbox at intersections that are already performing well (level of service A or B), so the optimization 
process can focus on re-timing the poorly-performing intersections. Another strategy could involve turning 
off phasing sequence optimization for arterials that already have an effective phasing sequence in place, 
so the optimization process can focus on fine-tuning the splits and offsets. Another strategy could involve 
using a more narrow range of minimum and maximum cycle length values, because examining a wide 
range of ineffective cycle length values could definitely make the optimization process less efficient. 

After a Full Optimization run has been completed, the amount of optimization improvement over time can 
be plotted on the Flow Profile Diagram. Refer to the Flow Profile Diagram section of the documentation 
for more details. 

Time-Space Diagram 
 
The Time-Space Diagram screen provides a mechanism for visualizing the available progression 
between intersections along the major street. 
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Timing Plan Representation 
 
Signal timing plans are painted vertically, with only the major street green times and yellow times colored 
green and yellow. Green and yellow intervals for all minor movements are painted red, usually resulting in 
the appearance of numerous discrete and consecutive red intervals. Node numbers are listed in the white 
circles at the bottom of the Time-Space Diagram screen. If an uncoordinated intersection (based on the 
“Uncoordinated Intersection” checkbox) is included within a progression route, the entire vertical distance 
will be painted red, which will terminate any incoming progression bands. 
 
Signal timing plans are fitted to the screen vertically, such that the vertical distances of each “bar 
diagram” represent the background system cycle length of the urban street. Thus, the green time painted 
for each bar diagram represents the proportion of the cycle length occupied by the major street through 
movements. The vertical location of a green interval is a function of the offset and the reference phase. 
Scrollbars at the side of the screen can be used to simultaneously change vertical locations of all intervals 
and green bands, but have no net effect on the offsets and reference phases. 
 
When progression bands are being drawn in one direction (forward or reverse) only, the Time-Space 
Diagram screen is capable of painting multiple green intervals for major route movements. For example, if 
the forward direction is Eastbound, and the eastbound through movement begins before the westbound 
through movement, the eastbound movement will have multiple forward progression green intervals. 
When progression bands are being drawn in both directions, only the coordinated phase (with both major 
street segments moving simultaneously) is painted green. 
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Interactive Coding of Offsets 
 
Moving the mouse cursor inside any of the vertical bar diagrams will allow the user to click and drag 
timing plans vertically. This automatically modifies the corresponding offset within the *.xus file. By 
adjusting the offsets interactively, it might be possible to quickly achieve an excellent bandwidth. When 
adjusting the offsets interactively, it is also helpful to take note of the efficiency and attainability values, as 
discussed later. 
 
Forward Direction 
 
The urban street forward direction (NB, SB, EB, or WB) is displayed in a disabled combo box, in the 
upper left-hand corner of the screen. The progression band direction (Fwd, Rev, or Both) is displayed in a 
second combo box. When the Time-Space Diagram screen is first loaded, progression bands are drawn 
in the “forward” direction of travel only. The user can switch the progression band combo box to draw 
these lines in the reverse direction, or in both directions, if desired. For one-way streets, this combo box is 
disabled and only displays the forward direction. 
 
Efficiency and Attainability 
 
When optimizing offsets interactively, the efficiency and attainability values at the top of the screen are 
updated automatically. By paying attention to comments such as “fair progression” and “increase shortest 
green”, it can be possible to determine whether further improvements are needed. If an uncoordinated 
intersection is present on the urban street, the screen will state that “This artery contains uncoordinated 
nodes”. Efficiency and attainability will always be zero for arteries that contain uncoordinated nodes, 
because it is not possible to achieve reliable progression through an uncoordinated intersection. 
 
Cumulative Bands 
 
The initial progression bandwidth is based on the major street through movement's green time at the 
“first” intersection only. As new intersections are encountered, it is possible to observe where the 
bandwidth is becoming partitioned, and gradually reduced. 
 
Progression bands typically do not begin and end exactly when the major street green time begins and 
ends. Instead, the progression band begins a few seconds after the onset of green, and ends a few 
seconds after the onset of yellow. This is a reflection of the effective green time, which is affected by 
user-entered start-up lost times and extension of effective green times. 
 
The progression bands are drawn as dashed lines across the screen; their slope is a function of segment 
length, and segment travel speed. 
 
Width 
 
When the Time-Space Diagram screen is first loaded, the initial view is a “fit to screen” view. All 
intersections on the urban street should be horizontally visible on the screen at one time. The horizontal 
distance from one end of the urban street to the other is displayed in the Width field. Although the width of 
the software screen remains constant, the displayed value (in units of feet) indicates the “represented” 
real-world distance of the urban street. 
 
Number of Cycles 
 
A drop-down combo box can be used to specify how many signal cycles will be displayed on the diagram. 
Note that displaying multiple cycles can cause the screen to operate more slowly, which could affect 
speed of the vertical scrollbars, or interactive offset adjustment. 
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Flow Profile Diagram 
 
The Flow Profile Diagram screen can be used to view static graphics that describe Streets simulation 
results. To operate this screen, the user can select their desired segment number within the urban street. 
The user can also select their desired flow profile category. Available flow profile categories include 
Downstream Arrival Rate, Downstream Projected Rate, Upstream Departure Rate, Access Point Arrival 
Rate, and Optimization Improvement. Optimization Improvement can only be plotted if a Full Optimization 
run has been performed recently. 
 
 

 
 
 
After selecting the desired segment number and flow profile category, the user can select their desired 
direction of travel, which is either forward (“Fwd”) or reverse (“Rev”). For example, if the user views the 
Downstream Arrival Rate for segment #1 in the forward direction, the Flow Profile Diagram will display the 
arrival rate of vehicles at downstream intersection #2. Finally, the user can select their desired 
intersection turn movements for plotting flow profiles. Up to four turn movements can be selected if the 
user wishes to view aggregated results for left-turn, thru, right-turn, and midblock traffic movements. The 
aggregated midblock traffic movements can only be plotted for the Downstream Projected Rate and the 
Upstream Departure Rate. 
 
For multiple period analyses, flow profiles are displayed for the “active” time period within the Streets 
user-interface. On the X-axis, the system background cycle length is used to compute flow profile 
dimensions. The Y-axis is automatically scaled to display the highest flow profile value. Flow profiles will 
not be displayed for any intersections specified as uncoordinated intersections, based on the 
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“Uncoordinated Intersection” checkbox. 
 
The Average Value displayed at the top of the screen represents the average profile value across every 
step of simulation. This can be useful for validating some of the simulation results. For example, the 
average input flow rate value of 1177 veh/h shown in the screen image above suggests that the hourly 
flow rate for this segment was 1177 veh/h, despite platoon dispersion that temporarily caused flow rates 
as high as 2755 veh/h. 
 
When plotting the Downstream Arrival Rate, the green shaded area is used to indicate when green time is 
occurring at the downstream signalized intersection. When plotting the Downstream Projected Rate and 
the Upstream Departure Rate, access point “zero” is used to indicate downstream intersection flows that 
originated at the nearest upstream access point. Moreover, access point #1 is used to indicate access 
point flows that originated at the upstream signalized intersection. If more than one access point exists on 
the segment, access point #2 is used to indicate downstream access point flows that originated at 
upstream access point #1, and so forth. When plotting the Access Point Arrival Rate, access point “zero” 
is no longer applicable, and the access point number indicates which location along the segment is being 
plotted. 
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Diverging Diamond Interchange 
(DDI) 

Overview 
The Diverging Diamond Interchange (DDI) is a variation of the traditional diamond interchange in which 
arterial traffic briefly drives on the opposite side of the road from what is customary. This innovative 
roadway geometry allows a two-phase signal timing operation, which provides significant operational and 
safety benefits. The DDI geometric design also allows left-turning traffic from the arterial to enter the 
freeway on-ramp without stopping. 

Given the unique nature of DDI movements and free-flowing left turns, specific data entry methods are 
needed to achieve accurate modeling of DDIs in an HCM context. These data entry methods, which are 
outlined in this guide and in the example datasets, are summarized as follows for the HCS Streets 
software (hereinafter referred to as ‘Streets’): 

 Major-street split phasing is achieved by entering lead-lag phasing with no overlap. (Section VI.) 

 Off-ramp left turns on to the arterial must be defined as right turns, so they can move concurrently 
with outbound arterial through movements. (Section III.) 

 Turning radii for the off-ramp left turns must be modified accordingly, because the default right-
turn radii will produce incorrect capacities. (Section III.) 

 Arterial left turns on the freeway must be defined as exclusive lanes even if they are shares 
lanes, to allow the phasing to work properly (a special checkbox is provided to indicate shared 
lanes for this case, to achieve proper lane utilization adjustment factor). (Section III.) 

 Streets allows entry of high start-up lost times, for when off-ramp movements must be held 
longer. (Section III). 

 Streets allows entry of negative extension of effective green times, for when off-ramp movements 
must terminate earlier. (Section III.) 

 User inputs are now provided for extra distance travel time (EDTT). (Section V.) 

Interchanges and Alternative Intersections 
To define a DDI interchange in Streets, both intersections should be marked as Interchange Intersections, 
with the Interchange Type being set to Diverging Diamond. This input field is found under the Detailed 
Input Data section of Streets. Once these inputs are set, the Diverging Diamond Data and EDTT Data 
input buttons (details in a later section) become enabled. 
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In Streets, this appears as shown below: 
 

 

Coding Movements 
Below is a generic example of a DDI: 

 
Source: HCM 

Initially, DDI intersections should be coded in Streets as seen in real life. However, in order to analyze a 
DDI facility in Streets, adjustments need to be made to the coded intersections to allow for overlap 
phasing and general program function. Adjustments that need to be made are shown below: 
 

 M8/M4 – In addition to the off-ramp right turn, a through movement (with demand of zero vehicles 
per hour) should be added along the same direction to allow phasing to operate normally. 

 M7/M3 – In order to create overlap phasing with M5/M1, this movement should be coded on the 
approach opposite of M8/M4 (meaning that if M8/M4 is a southbound movement, then M7/M3 
should be a northbound movement, and vice versa). Once the direction is set, the approach lane 
configuration is coded as one through lane with demand of 1 veh/h, and one or more exclusive 
right turn lanes. Note that because these right-turn movements are in fact left turns in real life, the 
user should edit the right-turn radius so it reflects the actual off-ramp left-turning radius. Accepting 
the defaults right-turn radius in this situation will produce incorrect capacity estimates. 
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 M6/M2 – In order to create overlap phasing with M8/M4, an exclusive left turn lane (with demand 
of 1 veh/h) should be added to the approach. Additionally, the on-ramp right turn movement 
should be marked as an Unsignalized Movement.  

 M5/M1 – The on-ramp left-turn movement should be coded as an exclusive left-turn lane and 
marked as an Unsignalized Movement. If the on-ramp left-turn movement is made from a shared 
lane in real life, it must be coded as an exclusive left-turn lane and an additional through lane. A 
subsequent check box (described later) is available to indicate the exclusive left-turn lane and 
through lane as a shared lane. 
 

Below are the adjusted lane configurations for both DDI intersections, as viewed within Streets, for the 
above example: 

 
 
With the exception of specific demands mentioned in the prior list of adjustments, all other demands 
should be coded normally. Most other inputs such as Lane Width, Heavy Vehicle percentage, Turn 
Radius, etc. can be applied normally. However, off-ramp movements that flow towards the middle of the 
DDI are coded on the opposite sides of the intersection (e.g., northbound right turn instead of southbound 
left turn at intersection #1 in the above example, and southbound right turn instead of northbound left turn 
at intersection #2 in the above example), so their accompanying movement-specific characteristics 
should also be coded on the opposite sides of the intersection. 
 
Note: The HCM does not provide a procedure to model any queue blockage that would delay left-turning 
vehicles from a DDI to a freeway on-ramp. For such cases, the use of alternative tools is advised. 

Automation for the DDI Additional Lost Time procedure is not completed as of this release. In order to 
temporarily compensate for this, please compute overlap lost time on the Diverging Diamond Data screen 
(details in a later section) and estimate the other lost times. Once this is completed, then manually code 
the appropriate values of Start-Up Lost Time in order to model these effects. 

Diverging Diamond Data 
The purpose of this function is to determine lost time for the off-ramp movements (M7/M8/M3/M4) for 
each intersection in a DDI. Additionally, if a shared lane is present and was coded as an exclusive left-
turn lane and an additional through lane, the check box available to indicate the exclusive left-turn lane 
and through lane as a shared lane is found here. 
 
In Streets, this appears as shown below: 
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The remaining input fields shown above are represented graphically in the image below:  
 

 
Source: HCM 

EDTT Data 
The purpose of this function is to calculate the Extra Distance Travel Time (EDTT) for each origin-
destination (O-D) Movement. The EDTT is then applied to the Total Control Delay to find the Experienced 
Travel Time (s/veh) for each O-D Movement. The extra distance traveled (ft) and the design speed (mi/h) 
for each O-D Movement, which can be measured from design drawings or aerial images, is used to 
calculate the Extra Distance Travel Time (EDTT). In Streets, this appears as shown below: 
 



 

Urban Streets Users Guide Diverging Diamond Interchange (DDI)    39 

 

For O-D movements, please see the diagram found at the bottom of the interchanges formatted report. 
To access this, please select “Interchanges Results Report” under the Report menu. A large schematic of 
all interchange O-Ds will show with the letters that match the EDTT data window. Please see the example 
figure below. 
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Signal Timing Inputs 
The input settings listed below are strongly recommended. HCM example problem datasets 
(automatically installed along with the software) are available to demonstrate these coding techniques, 
and all other coding techniques described within this guide. 
 

 Major-Street Split Phasing 
o The user-entered Phase Split for phase 1 should be equal to the user-entered Phase 

Split for phase 5. Additionally, one of the two major-street left-turn phases should be 
designated as the Lag Phase. Similarly, the user-entered Phase Split for phase 2 should 
be equal to the user-entered Phase Split for phase 6. 

 Field-Measures Phase Times (this checkbox should be turned on) 
 
A typical example of signal phasing entry is shown below. 
 

 
Intersection: 1 

 
Intersection: 2 

Phases 1 and 5 are the overlap phases created by the adjustments made to M6/M2 and M7/M3. Signal 
phasing must be entered for both DDI intersections individually. Generally it will be necessary for phases 
1 and 5 to be coded as overlap phases at both intersections. Additionally, there should not be any 
Permitted Left-Turn Phases in either intersection. 

Timing inputs should be associated with the following movements: 
 M6/M1 – EBT 
 M5/M2 - WBT 
 M8/M3 – EBL (Due to overlap phasing) 
 M7/M4 – WBL (Due to overlap phasing) 

For the ‘dummy’ through movements with a demand of 1 veh/h (NBT/SBT in the above example), these 
are represented by phases 4 and 8. The following timing is recommended to minimize their impact: 

 

Output Reports 
Results for a DDI are provided in both the Interchanges Text Report and the Interchanges Results 
Report. Once again, due to the unique nature of DDIs, there are differences in these reports from the 
ones generated for other interchanges. An explanation of the unique characteristics of each report is 
given below: 
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Interchanges Text Report – The text report provides detailed intermediate outputs that are required 
components of the DDI procedure, but are too extensive to fit on the formatted reports. These 
intermediate outputs include saturation flow rate adjustment factors, effective green times, queue storage 
ratios, and lost times for each movement and timer. The following adjustments to the base saturation flow 
rate are specifically related to the DDI procedure: 
 

 DDI Factor (fDDI) – an adjustment factor of 0.913 for the crossover through movements in a DDI 
 Lane Utilization Adjustment Factor (fLU) – the procedure for a DDI differs from other interchanges 

as the adjustments for the external crossover are a function of left-turn demand ratio at the 
internal crossover. Additionally, this procedure takes into consideration the lane configuration of 
the DDI and distinguishes between exclusive and shared lane configurations. 

 Traffic Pressure Adjustment Factor (fV) 

An example of the Interchanges Text Report is shown below: 

 
Interchanges Results Report – The formatted report summarizes the most important inputs and outputs 
associated with the DDI procedure. The relevant input information includes project-specific information, 
demand volumes at both DDI intersections, lane geometries at both DDI intersections, and signal timings 
at both DDI intersections. Relevant output data includes performance measures for each individual 
movement, O-D movement, and intersection within the DDI. The full report is shown in the next page: 
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Alternative Intersections 

Modeling Capability in HCS 
HCS has the capability of modeling five types of alternative intersections supported by HCM: 

 Restricted Crossing U-Turn Intersections (RCUT) with Signals 

 Restricted Crossing U-Turn Intersections (RCUT) with Stop Signs 

 Restricted Crossing U-Turn Intersections (RCUT) with Merges 

 Median U-Turn Intersections (MUT) with Stop Signs 

 Partial Displaced Left-Turn Intersections (DLT) 

The computations procedure for each type of alternative intersection can be used to estimate the control 
delay, extra distance travel time (EDTT), and experienced travel time (ETT) per origin-destination (O-D) 
demand movement. The level of service (LOS) for alternative intersections is dictated by the ETT value. 
RCUT with Signals, MUT with Stop Signs, and Partial DLT are applicable to the Streets module. 

Please note that alternative intersections are not non-signalized intersections (i.e., AWSC, TWSC, or 
Roundabouts). However, the operation of TWSC intersections can be mimicked by modeling access 
points within Streets. 

Creating New Alternative Intersection Datasets 
 

Steps to Build an RCUT with Signals 
To conduct a full RCUT analysis, two separate Streets (*.xus) files are needed. Each file will contain two 
intersections, essentially splitting the 4-intersection RCUT in half. The second file must have a forward 
direction opposite of the first file. The figure below presents the structure of the two RCUT files along with 
the lane configurations for each intersection. 
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1. Create a new Streets (*.xus) file. This will serve as the conventional intersection file. Enter the 
conventional intersection demand and any desired universal inputs such as the peak hour factor, 
% heavy vehicles, speed limit, and timing data.  

a. The universal inputs will be copied over to the two intersections generated by converting 
the conventional file to RCUT 

b. The demand input, outlined in red below, will be redistributed to the two intersections 
generated by converting the conventional file to RCUT 

 
 

2. Save the conventional intersection file. This file will be used to create the first set of RCUT 
intersections (1&2), but it is also needed to create the second set of RCUT intersections (3&4). 
Do not overwrite the conventional intersection file. This is a one-way-only process that 
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cannot be reversed. It is strongly recommended to save a copy of your original file for future 
reference.    
 

3. Go to the Alternative group box, which is found in the Detailed Input Data. Check the Alternative 
Intersection box. 

 
 

4. The Intersection Type dropdown will now become editable. Select RCUT and click Yes on the 
confirmation pop-up message.  
 

5. The file is now of type RCUT. 
 

6. Use the Save As command to save the current RCUT file. 
 

7. Open the original conventional intersection file. It will now be used to create the second set of 
RCUT intersections, as mentioned in Step 2. 
 

8. Change the forward direction to the opposing direction as the first RCUT file. For example, if the 
forward direction was SB for the first RCUT conversion, switch it to NB for this conversion. 

 
 

9. Repeat steps 3 – 6.  
 

10. Now that there are two separate RCUT files containing two intersections each, the full RCUT can 
be constructed. In either RCUT file, navigate back to the Alternative group box and select Open 
RCUT File. Select the opposing RCUT file.  

 
 

11. Upon opening the opposing RCUT file, a pop-up titled Additional RCUT Inputs will appear. 
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Specify the type of median at the U-Turn crossover. This is used to apply a saturation adjustment 
factor to the crossover movement. Conventional demand fields are already populated with the 
demand values from the conventional intersection file, as shown in Step 1. Any desired changes 
to the original conventional demand values may be edited here. 

a. Note: Streets automatically redistributes the Conventional RCUT Demand to the two 
intersections in the currently active file. The individual intersection demand input 
fields are greyed out but populated with the redistributed demand, as displayed 
below. This is by design and implemented to keep in accordance with the HCM 
procedure. If changing individual intersection demands is desired, the Conventional 
RCUT Demands in both of the RCUT files must be edited. Similarly, if the U-Turn 
Crossover Median Widths differ from Typical, this must be specified in each of the 
RCUT files. 

 
b. Note: The Additional RCUT Inputs button only becomes active once a second RCUT 

file has been opened. 
 

12. To view results, go to the Reports dropdown in the top menu and select Alternative Intersections 
Report.  
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13. Note: The EDTT for RCUT is calculated based on the Field Free-Flow Speed. This input field is 
found in the Segment group box of the Detailed Input Data. Please edit this field in each of the 
RCUT intersections – coding the speed limit will not change the EDTT. 

 
14. Please see below for an example of an RCUT where the main street is East-West. 

a. In the Traffic tab, include the RCUT adjusted demand for the central intersection 
considering the conventional (i.e., Conv) demand and the following equations: 
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b. In the Traffic tab, include the RCUT adjusted demand for the crossover considering the 
following equations: 

 

 
15. Please see below for an example of an RCUT where the main street is North-South: 

a. In the Traffic tab, include the RCUT adjusted demand for the central intersection 
considering the conventional (i.e., Conv) demand and the following equations 
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b. In the Traffic tab, include the RCUT adjusted demand for the crossover considering the 

following equations: 
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Steps to Build an MUT with Stop Signs 
To conduct an MUT with stop signs analysis, both the Streets module and the Two-Way Stop Control 
module are used. The main intersection is coded in a Streets (*.xus) file, while the upstream and 
downstream crossover junctions are coded in TWSC (*.xtw) files. The TWSC files are then attached in the 
Streets module. This is a one-way-only process that cannot be reversed. It is strongly recommended to 
save a copy of your original file for future reference. 

 
1. Start a new Streets (*.xus) file and enter the conventional intersection demand. For this 

intersection, the O-D must be considered for a conventional intersection. 

a. Note: The demand entered now will automatically be redistributed to the MUT 
intersection after conversion. 
 

2. Go to the Alternative group box which is found in the Detailed Input Data. Check the Alternative 
Intersection box. 
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3. The Intersection Type dropdown will now become editable. Select ‘MUT with TWSC’ and click 
‘Yes’ on the confirmation pop-up message. By selecting this, the demand will be updated for the 
center intersection of the MUT and will be used for further analysis.  
 

4. Return to the Alternative group box to attach the upstream and downstream stop-controlled 
intersection (*.xtw) files, which are created in the TWSC module.  

 
a. If these files have not been created, open the TWSC module and code the 

upstream/downstream crossovers. Note: TWSC crossover junctions should only have major 
street through lanes and a single major street U-Turn coded. Streets will not accept files 
coded differently. The image below presents a sample downstream crossover configuration 
for an East-West arterial with an EB forward direction specified in Streets. Keep in mind that 
the upstream/downstream TWSC files created should be relative to the forward direction 
specified in Streets. For example, when creating a file for the EB direction, the upstream 
intersection is the intersection to the west of the MUT and the downstream intersection is the 
intersection to the east of the MUT. 

 
b. Enter the redistributed volume for the movements at the crossover. Note: The crossover 

volume distribution must be determined manually. Neither TWSC nor Streets automatically 
redistributes conventional demand in the crossover files. See Example Problem 15 in 
Chapter 34 of the HCM for reference.  

c. Once all input data has been coded in the two crossover junctions and the files have been 
saved, return to the Streets module.  
 

5. Navigate back to the Alternative group box and use the Upstream/Downstream buttons to attach 
the respective TWSC (*.xtw) files. A confirmation message with inputs and results from the 
crossover file will appear if the file was opened successfully. 
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6. In the Segment group box, edit the Free-Flow Speed and Length fields as appropriate. Note: 
EDTT is calculated using these inputs.  

 
 

7. To view results, go to the Reports dropdown in the top menu and select ‘Alternative Intersections 
Report’. Note: The ‘Alternative Intersections Report’ only becomes accessible after at least one 
TWSC crossover file has been attached using the Upstream/Downstream buttons. 
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8. Please see below for an example of an MUT with EB as the forward direction: 
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9. Please see below for an example of an MUT with SB as the forward direction: 
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Steps to Build a Partial DLT 
To conduct a partial DLT analysis, one Streets (*.xus) file is needed. This file will then be converted to a 
DLT composed of three intersections: an upstream crossover, a main intersection, and a downstream 
crossover. This is a one-way-only process that cannot be reversed. It is strongly recommended to save a 
copy of your original file for future reference. 

 
1. Start a new Streets (*.xus) file. This will serve as the conventional intersection file. Enter the 

conventional intersection demand and any desired universal inputs such as the peak hour factor, 
% heavy vehicles, speed limit, and timing data.  

a. The universal inputs will be copied over to the three intersections generated by 
converting the conventional file to DLT. 

b. The demand input will be redistributed to the three intersections generated by converting 
the conventional file to DLT. 
 

2. Go to the Alternative group box which is found in the Detailed Input Data. Check the Alternative 
Intersection box. 

 
 

3. The Intersection Type dropdown will now become editable. Select DLT and click Yes on the 
confirmation pop-up message.  
 

4. The file is now of type DLT.  
a. Note: After converting the conventional intersection to a partial DLT alternative 

intersection with a set of three intersections, there may be an error generated by Streets. 
It is due to the existing data in the conventional file that causes a phase split summation 
error after conversion. This can be easily corrected by adjusting the phase split values at 
Intersection Two. Intersections One and Three may also show errors due to a refreshing 
issue. Navigating to the upstream and downstream intersection once, or twice in some 
cases, will eliminate those errors. 

b. Note: Offsets at the upstream and downstream intersections are disabled. This is by 
definition. The DLT procedure automatically calculates offsets at the supplemental 
intersections based on free-flow travel times, phase durations, reference phases, 
reference points, and the background cycle length. 
 

5. To view the results, go to the Reports dropdown in the top menu and select Alternative 
Intersections Report. 
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How To 

Create a New File 
1. There are four options for creating a new file: 
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a. Selecting the New tab in the initial window when first opening the Streets program and 
selecting the mode to create a new dataset  

 

b. Selecting File > New from the main menu; this can be found by selecting “File” in the top 
left-hand corner of the screen above the toolbar and then selecting “New”  

 

c. Using the keyboard shortcut “Ctrl+N” for New 
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d. Selecting the New icon in the toolbar; this can be found in the top left-hand corner of the 
screen in the toolbar; it is the first icon from the left and has an image of a blank paper 

 

2. Once a new file is created, a Quick Start window will appear allowing you to specify general 
inputs for the new file; these inputs can be changed after the file is created. When finished 
changing any of the necessary defaults, select OK.  

 

3. A Forward Direction dialog box will appear confirming if you want to proceed with the Forward 
Direction you selected. Select ‘Yes’ if you want to proceed or ‘No’ if you do not want to proceed. 
This message can be hidden in the future when creating new files if the ‘Do not show this again’ 
checkbox is checked.  

 

a. Selecting ‘Yes’ will create a new file with the inputs specified in the Quick Start dialog 
box. 

b. Selecting ‘No’ will bring you back to the Quick Start dialog box to make any changes. 

4. A new file will be created and you will be brought to whichever mode was last used if not 
specified using the first option. 
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Open an Existing File 
1. There are six options for opening an existing file: 

a. Selecting the Open tab in the initial window when first opening the Streets program and 
selecting a file from either the ‘EXAMPLE FILES’ list or ‘RECENT FILES’ list, or by 
clicking the ‘Browse’ button and selecting a file in the Open dialog box.  
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b. Selecting File > Open from the main menu; this can be found by selecting “File” in the top 
left-hand corner of the screen above the toolbar and then selecting “Open”  

 

c. Using the keyboard shortcut “Ctrl+O” for Open 

d. Selecting the Open icon in the toolbar; this can be found in the top left-hand corner of the 
screen in the toolbar; it is the second icon from the left and has an image of an open 
folder with an arrow  

 

e. Selecting File > Example Folder from the main menu; this can be found by selecting 
“File” in the top left-hand corner of the screen above the toolbar and then selecting 
“Example Folder”. Opening the example folder will open the path of the HCS example 
files in File Explorer. The desired example file can be double-clicked or right-clicked and 
selecting ‘Open’, which will open the example file in the Streets program. 
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f. Selecting File > Recent Files > *.xus from the main meu; this can be found by selecting 
“File” in the top left-hand corner of the screen above the toolbar, hovering over “Recent 
Files”, and then selecting the desired Streets file. 

 

2. Once an existing file is opened, you will be brought to whichever mode was last used. 

Save a File 
1. There are five options for saving an open file: 
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a. Selecting File > Save from the main menu; this can be found by selecting “File” in the top 
left-hand corner of the screen above the toolbar and then selecting “Save’  

 

b. Selecting File > Save As from the main menu; this can be found by selecting “File” in the 
top left-hand corner of the screen above the toolbar and then selecting “Save As”  

 

c. Using the keyboard shortcut “Ctrl+S” for Save 

d. Selecting the Save icon in the toolbar; this can be found in the top left-hand corner of the 
screen in the toolbar; it is the third icon from the left and has an image of a floppy disk 
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e. Exiting the program or closing the file without saving changes beforehand; this will 
prompt you to save changes to the file before anything is closed  

 

i. Selecting “Yes” will save the file if it is an existing file. If the file has not been 
previously saved, the Save As dialog box will pop up allowing you to change the 
file name and save it. 

ii. Selecting “No” will exit the program or close the file without saving the file 

iii. Selecting “Cancel” will prevent the file from closing 

Note: Using Save with an existing file will save a file without prompting you to specify a file name. Using 
Save with a new file will bring up the Save As dialog box for you to specify a file name for saving. Using 
Save As will always bring up the Save As dialog box for you to specify a file name for saving. 

Close a File 
1. There are four options for closing a file: 

a. Selecting File > Close from the main menu; this can be found by selecting “File” in the top 
left-hand corner of the screen above the toolbar and then selecting “Close”  

 

b. Selecting Windows > Close All from the main menu; this can be found by selecting 
“Windows” in the top left-hand corner of the screen above the toolbar and then selecting 
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“Close All”  

 

i. “Windows” is the fourth menu item from the left 

ii. Selecting “Close All” will close all open files 

c. Selecting “x” in the top right-hand corner of the file window; this can be found below in the 
red boxes  

 

d. Exiting the program itself; please see How To: Exit the Program 

Exit the Program 
1. There are three options for exiting the program: 



 

Urban Streets Users Guide How To    65 

a. Selecting File > Exit from the main menu; this can be found by selecting “File” in the top 
left-hand corner of the screen above the toolbar and then selecting “Exit”  

 

b. Using the keyboard shortcut “Alt+F4” for Exit 

c. Selecting “X” in the top right-hand corner of the screen; this can be found below in the red 
box 

 

Change the Mode 
1. There are two main mode options: Classic and Visual 
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a. Classic Mode: provides a split screen of all inputs with a results report located either to 
the right of the inputs or below the inputs; the inputs are sectioned off into PRIMARY 
INPUT DATA, DETAILED INPUT DATA, and MULTIMODAL INPUT DATA  

 

b. Visual Mode: provides a split screen of a map of the intersection(s) and segment(s) with 
a results report located either to the right of the map or below the map; the inputs can be 
accessed by either double clicking the intersection nodes or segment lines within the map 
or by right clicking them and selecting Edit from the menu. Note: Please see the Visual 
Mode section for more details.  

 

2. To change between modes, there are four options: 
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a. Selecting the desired mode when creating a New file on the initial start of the Streets 
program 

 

b. Selecting the desired mode by selecting one of the tabs at the top left-hand corner of the 
screen when a file is open  

 

c. Selecting View > Classic / Visual Mode from the main menu; this can be found by 
selecting “View” in the top left-hand corner of the screen above the toolbar and then 
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selecting “Classic / Visual Mode”; “View” is the second menu item from the left  

 

d. Using the keyboard shortcut F5 to switch between the two modes 

Run Animation 
1. There is one option for running animation: CORSIM 

a.  
Note: Please see CORSIM under the Advanced Features section for more details. 

2. There are four options for running animation through Streets: 
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a. Selecting the Quick Animation button from the toolbar  

 

b. Selecting File > CORSIM > View Animation from the main menu; this can be found by 
selecting “File” in the top left-hand corner of the screen above the toolbar, hovering over 
“CORSIM”, and then selecting “View Animation”  

 

c. Selecting View > Quick Animation from the main menu; this can be found by selecting 
“View in the top left-hand corner of the screen above the toolbar and then selecting 
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“Quick Animation”  

 

d. Using the keyboard shortcut Ctrl+Shift+L  

Run Optimization 
1. There are two main options for running optimization: Quick Optimization and Full Optimization 

a. Quick Optimization; this is a one-touch export to TRANSYT-7F  
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Note: Please see Quick Optimization under the Advanced Features section for more 
details. 
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b. Full Optimization; this is an HCM-based internal genetic algorithm  

 
Note: Please see Full Optimization under the Advanced Features section for more 
details. 

i. Inputs for optimization can be found under the Optimization section in the 
DETAILED INPUT DATA but can again be accessed in the Full Optimization 
window under Input Parameters 

ii. The Full Optimization window includes four drop down sections:  

1. Input Parameters  
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2. Optimization Status  

 

3. Diagnostic Messages  

 

4. Safety, Emission, Delay Values  
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iii. There Full Optimization window includes five buttons: 

1. Start; clicking this will start running full optimization using the inputs 
specified under Input Parameters  

 

2. Info; clicking this will show the Diagnostic Messages  
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3. Stop; clicking this will stop full optimization in the middle of a run  

 

4. Save; clicking this will save the changes as a result of running 
optimization 
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5. Cancel; clicking this will exit the Full Optimization window without saving 
any changes  

 

2. There are multiple ways to run optimization for a Streets file: 

a. Using the toolbar icons 

i. T7F Optimization (Quick Optimization)  

 

ii. Full Optimization  

 

b. Using the View menu items 

i. To run Quick Optimization, select View > Quick Optimization from the main 
menu; this can be found by selecting “View” in the top left-hand corner of the 
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screen above the toolbar and then selecting “Quick Optimization”  

 

ii. To run Full Optimization, select View > Full Optimization from the main menu; 
this can be found by selecting “View” in the top left-hand corner of the screen 
above the toolbar and then selecting “Full Optimization”  

 

c. Using keyboard shortcuts 

i. Quick Optimization: keyboard shortcut is Ctrl+Shift+O 

ii. Full Optimization: keyboard shortcut is Ctrl+Shirt+F 

Import 
1. There are five options for import: Streets CSV File, QuickStreets CSV File, Synchro-To-Streets 

Converter, Streets Data Template, and DAITA File 

a. Import Streets CSV File; this imports input data from a Streets CSV file to the current 
Streets dataset 
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a. Import QuickStreets CSV File; this imports data from a QuickStreets file to the current 
Streets dataset 

 

b. Import with Synchro-To-Streets Converter; this imports data from a Synchro CSV file to 
the current Streets dataset 
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c. Import Streets Data Template; this imports input data from an existing template to the 
current Streets dataset  

 
Note: Please see Templates under the Getting Started section for more details. 

d. Import DAITA File; this imports traffic counts from a DAITA file (*.xhd) to the current 
Streets dataset  

 

2. To import a Streets CSV File, select File > Import > Streets CSV File from the main menu; this 
can be found by selecting “File” in the top left-hand corner of the screen above the toolbar, 
hovering over “Import”, and then selecting “Streets CSV File”. Note: Please close the CSV file in 
other applications, such as Microsoft Excel, before importing. 
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3. To import a QuickStreets CSV File, select File > Import > QuickStreets CSV File from the main 
menu; this can be found by selecting “File” in the top left-hand corner of the screen above the 
toolbar, hovering over “Import”, and then selecting “QuickStreets CSV File”. Note: Please close 
the CSV file in other applications, such as Microsoft Excel, before importing. 

 

4. To import with the Synchro-To-Streets Converter, select File > Import > Synchro-To-Streets 
Converter from the main menu; this can be found by selecting “File” in the top left-hand corner of 
the screen above the toolbar; hovering over “Import”, and then selecting “Synchro-To-Streets 
Converter”. 
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5. To import a Streets Data Template, select File > Import > Streets Data Template from the main 
menu; this can be found by selecting “File” in the top left-hand corner of the screen above the 
toolbar, hovering over “Import”, and then selecting “Streets Data Template”. 

 

6. To import a DAITA File, select File > Import > DAITA File from the main menu; this can be found 
by selecting “File” in the top left-hand corner of the screen above the toolbar, hovering over 
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“Import”, and then selecting “DAITA File”.  

 

Export 
2. There are two options for export: Streets CSV File and Streets Data Template 

a. Export Streets CSV File; this exports input data from the Streets file to a CSV file 

 

b. Export Streets Data Template; this exports input data from the Streets file to a template 
file  
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Note: Please see Templates under the Getting Started section for more details. 

3. To export a Streets CSV File, select File > Export > Streets CSV File from the main menu; this 
can be found by selecting “File” in the top left-hand corner of the screen above the tool bar, 
hovering over “Export”, and then selecting “Streets CSV File”. 

 

4. To export a Streets Data Template, select File > Export > Streets Data Template from the main 
menu; this can be found by selecting “File” in the top left-hand corner of the screen above the 
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toolbar, hovering over “Export”, and then selecting “Streets Data Template”.  

 

View Results of the Analysis 
1. After editing all the necessary inputs, results of the analysis can be found in the form of reports. 

2. Reports can be found in the Reports menu in the top left-hand corner of the screen; “Reports” is 
the fifth menu item from the left  

 

3. There are multiple options for reports: 

a. Signals Text Report  

b. Signals Multiple-Period Text Report  

c. Streets Text Report  

d. Safety/Emissions Text Report 
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e. Streets Multiple-Period Text Report 

f. Interchanges Text Report  

g. Input Report  

h. Results Report  

i. Intermediate Report  

j. Graphical Summary  

k. Messages Report  

l. Full Report  

m. Safety and Emissions Report 

n. Segment Report  

o. Access Point Report  

p. Street Heatmap  

q. Flow Profile Data  

r. Interchanges Results Report  

s. Alternative Intersections Report  

t. Phasing and Timing Summary  

u. Intersection Summary  

v. None 

4. Report availability is dependent on the analysis of the dataset. For example, if the dataset only 
has a single intersection instead of two or more intersections, both the Streets Text Report and 
Streets Multiple-Period Text Report will be disabled. 

Print a Report 
1. There are four options for printing a report: 

a. Selecting File > Print from the main menu; this can be found by selecting “File” in the top 
left-hand corner of the screen above the toolbar and then selecting “Print”  
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b. Selecting File > Print Preview from the main menu; this can be found by selecting “File” in 
the top left-hand corner of the screen above the toolbar and then selecting “Print 
Preview” 

 

c. Using the keyboard shortcut “Ctrl+P” for Print 

d. Selecting the Print icon in the toolbar; this can be found in the top left-hand corner of the 
screen in the toolbar; it is the fourth icon from the left and has an image of a printer 

 

2. Print 

a. Using Print will bring up a Print dialog box where you can select which printer to print to 

3. Print Preview 

a. Using Print Preview will bring up a window where you can view how the report will look 
on paper before sending it to the printer 

b. The print icon in the toolbar found in the top left-hand corner can then be selected 

c. A print dialog box will pop up where you can select which printer to print to 
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Glossary of Terms 

Acceleration Rate 
Description:  This entry specifies the average constant acceleration rate. 

Impact on model results:  Accel-decel delays affect the computation of uniform stops and uniform 
queue. This entry also affects access point operations. 

Access Point Critical Gap Time 
Description:  This entry specifies the critical gap required for left-turners from the major street at an 
access point. 

Impact on model results:  This entry affects access point operations. Access point operations are used 
to modify the proportion of arrivals on green for downstream major-street movements. The proportion of 
arrivals on green impacts many aspects of the overall model; including queue service times, actuated 
phase times, and control delays. 

Access Point Deceleration Rate 
Description:  This entry specifies the average constant deceleration rate in response to turning vehicles. 

Impact on model results:  This entry affects access point operations. Access point operations are used 
to modify the proportion of arrivals on green for downstream major-street movements. The proportion of 
arrivals on green impacts many aspects of the overall model; including queue service times, actuated 
phase times, and control delays. 

Access Point Dropdown 
Description:  The access point dropdown control allows the user to switch between active access points, 
for editing input data. 

Impact on model results:  None 

Access Point Follow Up Time 
Description:  This entry specifies the follow-up time required for left-turners from the major street at an 
access point. 

Impact on model results:  This entry affects access point operations. Access point operations are used 
to modify the proportion of arrivals on green for downstream major-street movements. The proportion of 
arrivals on green impacts many aspects of the overall model; including queue service times, actuated 
phase times, and control delays. 
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Access Point Lanes 
Description:  This entry specifies lane geometry at the active (i.e., more than 10 veh/h) unsignalized 
access point. 

Impact on model results:  Access point operations are used to modify the proportion of arrivals on green 
for downstream major-street movements. The proportion of arrivals on green impacts many aspects of the 
overall model; including queue service times, actuated phase times, and control delays. 

Access Point Location 
Description:  This entry specifies the distance from the active (i.e., more than 10 vph) unsignalized 
access point to the upstream signalized intersection. 

Impact on model results:  Access point operations are used to modify the proportion of arrivals on green 
for downstream major-street movements. The proportion of arrivals on green impacts many aspects of the 
overall model; including queue service times, actuated phase times, and control delays. 

Access Point Maximum Bay Length 
Description:  This entry specifies the maximum length of a turn bay, at an access point. 

Impact on model results:  This entry affects access point operations. Access point operations are used 
to modify the proportion of arrivals on green for downstream major-street movements. The proportion of 
arrivals on green impacts many aspects of the overall model; including queue service times, actuated 
phase times, and control delays. 

Access Point Name 
Description:  This entry is used to document the name of the active (i.e., more than 10 vph) unsignalized 
access point. 

Impact on model results:  None 

Access Point Peak Hour Factor 
Description:  This entry specifies the proportion of access point volume occurring in the peak 15 
minutes. Peak 15-minute volume is computed as the hourly volume divided by four times the PHF. 

Impact on model results:  The PHF (when lower than 1.0) simply factors up the associated movement 
volume, to reflect increased flow rates during the peak 15-minute period. Access point volumes affect the 
proportion of arrivals on green for downstream major-street movements. 

Access Point Right Turn Equivalency 
Description:  This entry specifies the ratio of through to right-turn saturation flow rate, at an access point. 

Impact on model results:  This entry affects access point operations. Access point operations are used 
to modify the proportion of arrivals on green for downstream major-street movements. The proportion of 
arrivals on green impacts many aspects of the overall model; including queue service times, actuated 
phase times, and control delays. 

Access Point Right Turn Speed 
Description:  This entry specifies the average turn speed for a right-turn maneuver at an access point. 
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Impact on model results:  This entry affects access point operations. Access point operations are used 
to modify the proportion of arrivals on green for downstream major-street movements. The proportion of 
arrivals on green impacts many aspects of the overall model; including queue service times, actuated 
phase times, and control delays. 

Access Point Volumes 
Description:  This entry specifies movement volumes at the active (i.e., more than 10 vph) unsignalized 
access point. When the analysis contains more than one time period, access point volumes can be 
entered in units of vehicles per period. 

Impact on model results:  Access point operations affect the proportion of arrivals on green for 
downstream major-street movements. The proportion of arrivals on green impacts many aspects of the 
overall model; including queue service times, actuated phase times, and control delays. 

Additional RCUT Inputs 
Description: This button opens a dialog box for the user to input the U-Turn Crossover Median Width 
and Conventional RCUT Demands. 

Impact on model results: This button is only applicable to RCUT alternative intersection and is 
necessary for the completion of one RCUT alternative intersection. 

Agency or Company 
Description:  This entry documents the agency or company associated with this analysis or project. 

Impact on model results:  None 

All Segment Lengths 
Description:  This pop-up dialog allows the user to specify all segment lengths on one form. This dialog 
is only available when intersections can be assumed to be located in a straight line, and when 
intersection drag-and-drop has not been performed within Visual Mode. Segments are only relevant when 
there is more than one intersection within the analysis. 

Impact on model results:  Segment lengths are used in the computation of travel speeds and vehicle 
delays. 

Allow Optimization 
Description:  This checkbox allows the user to suppress optimization at certain intersections, during an 
optimization run. Turning off the Allow Optimization checkbox at intersections that are already performing 
well (level of service A or B) can sometimes make the optimization process more efficient, by allowing it to 
focus on re-timing the poorly-performing intersections. 

Impact on model results:  This entry is only applicable to optimization runs. 

Alternative Intersection 
Description:  This checkbox allows the user to convert a conventional intersection into one of the 
available alternative intersections. Checking this will enable the Intersection Type combo box. 

Please note that alternative intersections are not non-signalized intersections (i.e., AWSC, TWSC, or 
Roundabouts). However, the operation of TWSC intersections can be mimicked by modeling access 
points within Streets. 
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Impact on model results:  None 

Analysis Time Period 
Description:  This entry documents the time period covered by the analysis. 

Impact on model results:  None 

Analysis Time Period Duration 
Description:  This entry specifies the length of time (T) during which flow is assumed to remain constant. 
If T is equal to one hour, the PHF for each movement should be set to 1.00. 

Impact on model results:  If the degree of saturation (v/c) exceeds 0.90, control delay is significantly 
affected by the value of T. 

Analysis Year 
Description:  This entry documents the year for which the analysis is being performed. 

Impact on model results:  None 

Analyst 
Description:  This entry documents the individual performing the analysis. 

Impact on model results:  None 

Area Type 
Description:  This entry specifies whether or not the intersection is in a central business district (CBD) 
type of environment. An intersection is considered to be in a CBD, or a similar type of area, when its 
characteristics include narrow street rights-of-way, frequent parking maneuvers, vehicle blockages, taxi 
and bus activity, small-radius turns, limited use of exclusive turn lanes, high pedestrian activity, dense 
population, and mid-block curb cuts. The average saturation headway of vehicles at intersections in areas 
with these characteristics will be significantly longer than those found at similar intersections but in more 
suburban settings. 

Impact on model results:  The "CBD or similar" selection decreases the saturation flow rate for all 
movements by 10%, resulting in higher delays, travel times, queues, etc. The "Other" selection has no 
impact on model results, except to avoid saturation flow rate reductions that would have been caused by 
"CBD or similar". 

Arrival Type 
Description:  Arrival type is used to describe the quality of signal progression for the corresponding 
movement group. Values of arrival type range from 1 to 6. An arrival type of 1 represents poor 
progression, whereas an arrival type of 6 represents excellent progression. An arrival type of 3 represents 
random vehicle arrivals. Arrival type 1 is characterized by a dense platoon of more than 80 percent of the 
movement group volume arriving at the start of the red interval. This arrival type is often associated with 
shorter segments. If the two signals are not coordinated, then poor progression will likely exist for both 
travel directions. If coordination is provided for only one direction of travel, then poor progression may 
exist for the other direction. Arrival type 2 is characterized by a moderately dense platoon arriving in the 
middle of the red interval or a dispersed platoon containing 40 to 80 percent of the movement group 
volume arriving throughout the red interval. Arrival type 3 describes one of two conditions. If the signals 
bounding the segment are coordinated, then this arrival type is characterized by a platoon containing less 
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than 40 percent of the movement group volume arriving partially during the red interval and partly during 
the green interval. If the signals are not coordinated, then this arrival type is characterized by platoons 
that arrive at the subject intersection at different points in time over the course of the analysis period such 
that arrivals are effectively random. Arrival type 4 is characterized by a moderately dense platoon arriving 
in the middle of the green interval or a dispersed platoon containing 40 to 80 percent of the movement 
group volume arriving throughout the green interval. Arrival type 5 is characterized by a dense platoon of 
more than 80 percent of the movement group volume arriving at the start of the green interval. This arrival 
type may occur on shorter segments with a low-to-moderate number of side street entries and good 
signal coordination. Arrival type 6 is characterized by a dense platoon of more than 80 percent of the 
movement group volume arriving during the green interval. This arrival type occurs only on short 
segments with negligible side street entries and near-ideal signal coordination. It is reserved for 
exceptional progression quality on routes with near-ideal characteristics. 

Impact on model results:  Within the computational procedure, arrival type (AT) is first converted to a 
platoon ratio (Rp = AT / 3) for each movement. Next, platoon ratio is converted to a proportion of arrivals 
on green (ProportionOnGreen = Rp * g / C) for each movement. If upstream signal information has been 
entered, PortionOnGreen is automatically recalculated to reflect the expected vehicle arrival pattern from 
the upstream intersection. PortionOnGreen impacts many aspects of the overall model; including queue 
service times, actuated phase times, and control delays. 

Average Passenger Trip Length (multimodal) 
Description:  This entry specifies the average passenger trip length along a particular transit route. 

Impact on model results:  Average passenger trip length is used to determine the impact of late 
departures on overall trip speed, and is used to compute the perceived travel time factor. 

Base Saturation Flow Rate 
Description:  The base saturation flow rate represents the expected average flow rate for a through 
traffic lane having geometric and traffic conditions that correspond to a value of 1.0 for each adjustment 
factor. Typically, one base rate is selected to represent all signalized intersections in the jurisdiction (or 
area) within which the subject intersection is located. 

Impact on model results:  Adjusted saturation flow rates affect capacities and queue service times, 
which in turn affect many aspects of the overall model; including control delay, time until onset of queue 
spillback, queue lengths, and travel time. 

Base Travel Time Rate (multimodal) 
Description:  This entry should specify 6.0 min/mi (or 3.73 min/km in metric) for the central business 
district of a metropolitan area with 5 million persons or more; otherwise use 4.0 min/mi (or 2.49 min/km in 
metric). 

Impact on model results:  Base travel time rate is used to compute the transit wait-ride score. 

Bicycle Lane Width (multimodal) 
Description:  This entry specifies the width of the bicycle lane (adjacent to the outside thru vehicle lane) 
on the subject approach. 

Impact on model results:  The bicycle lane width affects the cross section width adjustment factor. 
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Bicycle Running Speed (multimodal) 
Description:  This entry specifies tan estimate of the average bicycle running speed. The best basis for 
this estimate is a field measurement of mid-segment bicycle speed on representative streets in the vicinity 
of the subject street. There are many factors that might affect bicycle speed including adjacent motor 
vehicle traffic, adjacent on-street parking activity, commercial and residential driveways, lateral 
obstructions, and significant grades.  

Impact on model results:  Bicycle running speed is used to compute bicycle travel speed. Bicycle travel 
speed is an output measure of effectiveness, and is not used to determine bicycle level of service. 

Bicycles per Hour 
Description:  This entry specifies the number of bicycles whose travel path is crossed by vehicles turning 
right from the subject approach during the analysis period. These bicycles may travel on the shoulder or 
in a bike lane. Any bicycle traffic operating in the right lane with automobile traffic should not be included 
in this count. Rather, they are ignored in the analysis because this interaction is not modeled by the 
procedure. The count is divided by the analysis period duration to yield an hourly flow rate. 

Impact on model results:  Non-zero bicycles per hour decrease the saturation flow rate for associated 
movements, resulting in higher delays, travel times, queues, etc. 

Buffer Object Spacing (multimodal) 
Description:  The buffer is the distance between the outside edge of the paved roadway (or face of curb, 
if present) and the near edge of the sidewalk. This element of the cross section is not designed for use by 
pedestrians or motorized vehicles. It may be unpaved or include various vertical objects that are 
continuous (e.g., barrier) or discontinuous (e.g., trees, bollards) to prevent pedestrian use. If vertical 
objects are in the buffer, then the average spacing of those objects that are 3 feet (or 0.9 meters in 
metric) or more in height should be recorded. 

Impact on model results:  The buffer width coefficient determination is based on the presence of a 
continuous barrier in the buffer. When making this determination, repetitive vertical objects (e.g., trees, 
bollards, etc.) are considered to represent a continuous barrier if they are at least 3 feet (or 0.9 meters in 
metric) high and have an average spacing of 20 feet (or 6.1 meters in metric) or less. 

Buffer Width (multimodal) 
Description:  This entry specifies the distance between the outside edge of the paved roadway (or face 
of curb, if present) and the near edge of the sidewalk. This element of the cross section is not designed 
for use by pedestrians or motorized vehicles. It may be unpaved or include various vertical objects that 
are continuous (e.g., barrier) or discontinuous (e.g., trees, bollards) to prevent pedestrian use. If vertical 
objects are in the buffer, then the average spacing of those objects that are 3 feet (or 0.9 meters in 
metric) or more in height should also be recorded. 

Impact on model results:  Buffer width is used to compute the available sidewalk width. 

Bus Blockage Time 
Description:  The saturation flow rate adjustment factor for bus blockage accounts for the impact of local 
transit buses that stop to discharge or pick up passengers at a near-side or far-side bus stop within 250 
feet (or 76.2 meters in metric) of the stop line (upstream or downstream). This factor should only be used 
when stopping buses block traffic flow in the subject lane group. The bus blockage adjustment factor 
assumes an average bus blockage time of 14.4 seconds during the green indication. 

Impact on model results:  Higher bus blockage times decrease saturation flow rates for their associated 
movements; resulting in higher delays, travel times, queues, etc. 
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Bus Stops per Hour 
Description:  This entry specifies the number of local buses that block traffic flow in a movement group 
within 250 feet (or 76.2 meters in metric) of the stop line (upstream or downstream), as measured during 
the analysis period. A local bus is a bus that stops to discharge or pick up passengers at a bus stop. The 
stop can be on the near side or the far side of the intersection. If more than 250 buses per hour exist, a 
practical limit of 250 should be used. 

Impact on model results:  Non-zero bus stops per hour decrease the saturation flow rate for associated 
movements, resulting in higher delays, travel times, queues, etc. 

Calculate Emissions 
Description: This button updates the Emissions Output displayed in the Safety and Emission dialog box. 

Impact on model results: None 

Calculate Safety 
Description: This button updates the Safety Output displayed in the Safety and Emission dialog box. 

Impact on model results: None 

Circulating Pedestrian Volume (multimodal) 
Description:  This entry specifies the total number of pedestrians traversing the corner but never entering 
the intersection. For example, on the eastbound approach, circulating pedestrians on the eastbound 
sidewalk will turn southbound upon reaching the southwest intersection corner. Also on the eastbound 
approach, circulating pedestrians on the northbound (western-most) sidewalk will turn westbound upon 
reaching the southwest corner. Eastbound circulating volume is thus the summation of eastbound 
sidewalk pedestrians who turn southbound (upon reaching the southwest corner) and northbound 
sidewalk pedestrians who turn westbound (upon reaching the southwest corner). 

Impact on model results:  Circulating pedestrian volume affects the corner circulation area per 
pedestrian. 

Clear 
Description:  The Clear button automatically deletes all lanes from the active intersection. In some cases 
this may allow for faster specification of certain lane configurations. 

Impact on model results:  Intersection laneage has a fundamental effect on all aspects of the model 
results. 

Conventional RCUT Demands 
Description:  The Conventional RCUT Demand inputs are enabled only for files specified as type RCUT 
in the Alternative group box. These input fields represent the movement demands at a standard 4-leg 
intersection.  

Impact on model results:  This entry is only applicable to RCUT alternative intersections. Conventional 
RCUT Demands are used to calculate redistributed demands (found in the greyed out individual RCUT 
junction demand fields) and to calculate experienced travel times. 
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Convergence Threshold 
Description:  This entry specifies the (genetic algorithm) convergence threshold in a signal timing 
optimization run. During optimization, the optimal function value and average function value are 
constantly recomputed. The optimal function value represents the best objective function value when 
considering all candidate timing plans in that particular generation. The average function value is the 
average performance index value from all candidate solutions in that particular generation. During 
successive generations, the optimal function value and the average function value tend to improve due to 
the genetic selection process. The average function value can occasionally become worse due to a "bad 
mutation", but the optimal function value should always stay the same or improve. Convergence is 
achieved when the average function value becomes sufficiently close to the optimal function value. 
Increasing the maximum number of generations (or decreasing the convergence threshold) tends to 
produce longer program running times, but better timing plans. Of course, once the global optimum 
solution has been reached, additional generations and tighter convergence thresholds have no additional 
benefit. Complex traffic networks tend to require substantially more generations of candidate solutions 
before an optimal solution is obtained. 

Impact on model results:  This entry is only applicable to optimization runs. 

Corner Radius (multimodal) 
Description:  The corner radius describes radius of curvature at the sidewalk corner. 

Impact on model results:  Corner radius affects the available corner time-space. 

Critical Left Turn Gap Time 
Description:  This entry specifies the critical gap time required for permissive left-turners at a signalized 
intersection. 

Impact on model results:  This entry affects saturation flow rates and actuated phase times for left-turns 
operating under protected-permissive or permissive-only phasing. 

Critical Merge Gap 
Description:  This entry specifies the minimum gap required for merging into an adjacent lane. 

Impact on model results:  Critical merge gap affects the distribution of volumes and saturation flow rates 
among shared lane groups, and also affects access point operations. 

Crossover Probability 
Description:  This entry specifies the (genetic algorithm) crossover probability in a signal timing 
optimization run. The genetic algorithm initially considers a trial population of signal timing plan 
candidates. Within this population a competition takes place where the weak candidates are discarded, 
and the strong candidates are allowed to breed and perform crossover. Following crossover, a new 
generation of candidate solutions is born. Low crossover probabilities result in younger generations of 
solutions that are more similar to the older generations, whereas high crossover probabilities result in 
younger generations that are less similar to the older generations. This entry may affect the number of 
generations needed to locate the global optimum solution. 

Impact on model results:  This entry is only applicable to optimization runs. 
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Crosswalk Closed (multimodal) 
Description:  If the subject crosswalk is closed in the signalized intersections procedure, then the 
pedestrian delay is estimated as the value obtained for the subject crosswalk, plus two increments of the 
delay for the perpendicular crosswalk. This adjustment reflects the additional delay pedestrians incur 
when crossing the other three legs of the intersection so that they can continue walking in the desired 
direction. The urban streets procedure must know the “distance to nearest signal-controlled crossing” if 
there is an identifiable pedestrian path that (a) intersects the segment and continues on beyond the 
segment and (b) on which most crossing pedestrians travel. This entry defines the distance pedestrians 
must travel along the segment should they divert from the path to cross the segment at the nearest 
signalized crossing. The crossing will typically be at a signalized intersection. However, it may also be at 
a signalized crosswalk provided at a mid-segment location. If the crossing is at a signalized intersection, it 
will likely occur in the crosswalk on the side of the intersection that is nearest to the segment. 
Occasionally, it will be on the far side of the intersection because the near-side crosswalk is closed (or a 
crossing at this location is otherwise prohibited). This distance is measured along one side of the subject 
segment; the methodology accounts for the return distance once the pedestrian arrives at the other side 
of the segment. 

Impact on model results:  Crosswalk Closed is used to compute the pedestrian diversion delay. 

Crosswalk Length (multimodal) 
Description:  Crosswalk length is measured from outside edge to outside edge of road pavement (or 
curb to curb, if present) along the marked pedestrian travel path. 

Impact on model results:  Crosswalk length affects the available crosswalk time-space, and the 
pedestrian service time. 

Crosswalk Width (multimodal) 
Description:  The crosswalk width represents an effective width. Unless there is a known width 
constraint, the crosswalk’s effective width should be the same as its physical width. A width constraint 
may be found when vehicles are observed to regularly encroach into the crosswalk area, or when an 
obstruction in the median (e.g., a signal pole, or reduced-width cut in the median curb) narrows the 
walking space. 

Impact on model results:  Crosswalk width affects the available crosswalk time-space, the time-space 
occupied by turning vehicles, and the pedestrian service time. 

Curb-to-Curb Street Width (multimodal) 
Description:  This entry specifies the width of the cross street as measured along the outside through 
vehicle lane on the subject approach, between the extended curb line limits of the cross street. 

Impact on model results:  The street width affects the cross section width adjustment factor. 

Cycle Length Increment 
Description:  This entry specifies the cycle length increments to be considered in a signal timing 
optimization run. For example, for cycle lengths in the range of 80-100 seconds with a 5-second 
increment, the optimization process would consider cycle lengths of 80, 85, 90, 95, and 100 seconds. 

Impact on model results:  This entry is only applicable to optimization runs. 
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Cycle Length Optimization Flag 
Description:  This entry specifies whether or not cycle lengths are to be optimized in a signal timing 
optimization run. 

Impact on model results:  This entry is only applicable to optimization runs. 

Dallas Phasing 
Description:  This entry potentially allows left-turn movements to operate in the protected-permitted 
mode without causing a “yellow trap” safety concern. It effectively ties the left-turn’s permitted period 
signal indication to the opposing through signal indication. 

Impact on model results:  The Dallas phasing mode is considered when computing queue service times 
and effective green times for permissive-only and protected-permissive left-turn movements. This in turn 
potentially affects actuated phase times and control delays for all movements. 

Dallas Phasing Optimization 
Description:  This checkbox allows the user to request “Dallas Phasing” optimization during a Full 
Optimization run. When performing phasing sequence optimization, Dallas Phasing Optimization can be 
activated to prevent phasing sequences that would result in a “yellow trap” for the permissive left-turners. 
If the Phasing Sequence Optimization checkbox is selected without Dallas Phasing Optimization, the 
dashboard will post a warning message, but the optimization process will not modify the user’s original 
values of Dallas Phasing. If Phasing Sequence Optimization is selected with Dallas Phasing Optimization, 
the optimization process will turn on Dallas Phasing when a lagging left turn is opposed by a permissive 
left turn, and will turn off Dallas Phasing when both left turns are leading. 

Impact on model results:  This entry is only applicable to optimization runs. 

Date 
Description:  This entry documents the date on which the analysis was performed. 

Impact on model results:  None 

Deceleration Rate 
Description:  This entry specifies the average constant deceleration rate in response to a red indication. 

Impact on model results:  Accel-decel delays affect the computation of uniform stops and uniform 
queue. 

Delete Access Point 
Description:  This button is used to delete access points from the analysis. Access points can also be 
deleted graphically within Visual Mode. 

Delete Intersection 
Description:  This button is used to delete intersections from the analysis. Intersections can also be 
deleted graphically within Visual Mode. 



 

Urban Streets Users Guide Glossary of Terms    97 

Delete Time Period 
Description:  This button is used to delete existing time periods from the analysis. When the button is 
clicked, the final time period will be deleted. When oversaturated conditions exist, a multiple-period 
analysis can more accurately capture the effects of traffic congestion. The number of time periods should 
be chosen such that the first and last time periods are undersaturated. 

Demand 
Description:  This entry specifies vehicular demand for each movement. Demand flow rate represents 
the flow rate of vehicles arriving at the intersection. When measured in the field, this flow rate is based on 
a traffic count taken upstream of the queue associated with the subject intersection. This distinction is 
important when counting during congested periods because the count of vehicles departing from a 
congested approach will produce a demand flow rate that is lower than the true rate. (All uses of the word 
“volume” or the phrase “volume-to-capacity ratio” refer to demand volume or demand volume-to-capacity 
ratio.) 

Demand must be provided as an hourly flow rate (veh/h) when a single analysis period is considered with 
HCS. If a multi-period analysis is applied (more than one analysis period), the demand input format will 
automatically be changed to veh/p (vehicles per analysis period). For example, for a typical 15-min 
analysis, the user must provide the 15-min turning movement counts. 

Impact on model results:  The movement demands affect most aspects of the overall model; including 
control delay, time until onset of queue spillback, queue lengths, and travel time. 

Demand Growth 
Description:  This entry automatically modifies the vehicular demand volume for each movement. 

Impact on model results:  The movement volumes affect most aspects of the overall model; including 
control delay, time until onset of queue spillback, queue lengths, and travel time. 

Design Speed 
Description: This entry specifies the design speed of the loop ramp or diverted movement. The speed 
used should provide safe passage of the conflict zone for the vast majority of drivers. If a DDI is newly 
constructed, the design speed of the curve should be utilized to provide an estimate of speed; however, 
to provide safe crossing for the slowest of vehicles, it should be decreased by 5 mi/h (or 1.6 km/h in 
metric). 

Impact on model results: The design speed is used in the computation of extra distance travel time 
(EDTT) for each O-D movement, which in turn is used in the computation of experienced travel time 
(ETT) for each O-D movement. 

Design Vehicle Length 
Description: This entry specifies the design length of a vehicle in feet (or meters in metric). The design 
vehicle length is typically 20 feet (or 6.1 meters in metric). 

Impact on model results: This entry is only applicable to DDI alternative intersections. Along with free-
flow speeds, clear zone widths, and the space between ramp stop bar and conflict zone, vehicle lengths 
contribute to the calculation of lost times that are applied to DDI off-ramp movements. 

Detected Vehicle Length 
Description:  This entry specifies the detected length of a vehicle. 
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Impact on model results:  Detected vehicle length is used to compute maximum allowable headways 
(MAH) for each actuated movement. MAH impacts many aspects of the overall model; including actuated 
phase times, and control delays. Detected vehicle length is also used to compute queue storage ratio. 

Detector Length 
Description:  This entry typically specifies the length of a presence detector at the stop line. If the 
detector length is set equal to 1 foot, pulse mode detection is assumed. The stop line detector length 
represents the length of the detection zone used to extend the green indication for queue service. This 
detection zone is typically located near the stop line and may have a length greater than 40 feet (or 12.2 
meters in metric). However, it can be located some distance upstream of the stop line and be as short as 
6 feet (or 1.8 meters in metric) in length. This latter configuration typically requires a long minimum green 
or use of the controller’s variable initial setting. If a video-image vehicle detection system is used to 
provide stop line detection, then the length that is input should reflect the physical length of roadway that 
is monitored by the video detection zone plus an additional length of 5 to 10 feet (or 1.5 to 3.1 meters in 
metric) to account for the projection of the vehicle image into the plane of the pavement (with larger 
values in this range used for wider intersections). 

Impact on model results:  Detector lengths affect the calculation of actuated phase times. The HCM 
Chapter 19/31 procedures do not recognize advance detection, detector setbacks, or volume-density 
control. In cases such as this, where the HCM procedures may have trouble estimating phase times 
accurately, the “Field Measured Phase Times” feature can be used. 

Diverging Diamond Data 
Description: This button opens a dialog box with inputs relevant to a Diverging Diamond Interchange 
intersection. It will only appear when Diverging Diamond is selected under Interchange Type. 

Impact on model results: None 

Downstream 
Description: This button open a dialog box for the user to select and open the downstream crossover 
junction file coded in TWSC. Once opened, the TWSC file (.xtw) becomes attached in the Streets module. 

Impact on model results: This button is only applicable to MUT with TWSC alternative intersections and 
is necessary for the completion of one MUT with Stop Signs alternative intersection. 

Downstream Intersection Width (multimodal) 
Description:  This entry specifies the width of the downstream intersection. 

Impact on model results:  Downstream intersection width affects diversion distance in cases where 
pedestrians choose to cross at the farthest downstream crosswalk. 

Dual Entry 
Description:  This entry specifies whether or not a phase is to be activated (green) even though it has 
not received a call for service. A phase operating in dual entry is available to be called by the controller, 
even if no actuations have been received for this phase. A phase operating in single entry will only be 
called if actuations have been received. When timing a cycle, a point is reached where the next phase (or 
phases) to be timed is on the other side of a barrier. At this point, the controller will check the phases in 
each ring and determine which phase to activate. If a call does not exist in a ring, a phase designated as 
dual entry in that ring will be activated by the controller. If two phases are designated as dual entry in this 
ring, then the first phase to occur in the phase sequence is activated. 



 

Urban Streets Users Guide Glossary of Terms    99 

Impact on model results:  Dual entry affects the amount of vehicular and pedestrian calling flow for each 
actuated phase, potentially affecting actuated phase times and control delays. 

Dwell Time (multimodal) 
Description:  This entry specifies the time that the transit vehicle is stopped at the curb to serve 
passenger movements, including the time required to open and close the doors. It does not include time 
spent stopped after passenger movements have ceased (e.g., waiting for a traffic signal or waiting for a 
gap in traffic to re-enter the travel lane). Dwell times are typically in the range of 10-60 seconds, 
depending on boarding and alighting demand. 

Impact on model results:  Dwell time is used to compute the total delay due to the transit stop. 

EDTT Data 
Description: This button opens a dialog box with inputs relevant to Extra Distance Travel Time (EDTT) 
Data for an interchange intersection. 

Impact on model results: None 

Excess Wait Time (multimodal) 
Description:  This entry specifies the average number of minutes passengers must wait at a stop past 
the scheduled departure time. It is measured in the field as the sum of the differences between the 
scheduled and actual departure times at the preceding timepoint, divided by the number of transit vehicle 
arrivals. 

Impact on model results:  Excess wait time is used to compute the perceived travel time factor, which in 
turn affects the transit LOS score. 

Exclusive Pedestrian Phase Time 
Description:  This entry specifies the amount of cycle time to be used by an exclusive pedestrian phase 
at each intersection. Currently, this calculation is only supported for uncoordinated intersections. 

Impact on model results:  For uncoordinated (Chapter 19) operations, exclusive pedestrian phase times 
affect the cycle length computed by the procedure. The cycle length and vehicular phase times affect 
most aspects of the overall model; including control delay, queue lengths, and travel time. 

Extension of Effective Green Time 
Description:  This entry specifies the amount of the change and clearance interval at the end of the 
phase for a lane group, usable by its vehicles. 

Impact on model results:  Extension of effective green times affect the calculation of actuated phase 
times and queue service times. 

Extra Distance 
Description: The entry specifies the distance traveled along the loop ramp or diverted movement in an 
interchange. 

Impact on model results: The extra distance is used in the computation of extra distance travel time 
(EDTT) for each O-D movement, which in turn is used in the computation of the experienced travel time 
(ETT) for each O-D movement. 
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Field Free-Flow Speed 
Description:  This value can be field measured following the guidance in HCM Chapter 30 Section 5 and 
coded here to override the parameter computed by the procedure. 

Impact on model results:  This value is used to compute Percent Free-Flow Speed, which determines 
Level of Service using HCM Exhibit 18-1. 

Field Proportion Arriving on Green 
Description: Proportion arriving on green is the proportion of vehicles that arrive during the green signal 
indication. A procedure is described in Section 3 of Chapter 30 that can be used to estimate the arrival 
flow profile for an intersection approach when this approach is evaluated as part of an urban street 
segment. The procedure uses the profile to compute the proportion of arrivals during the green indication. 

Impact on results: Control delay and queue size at a signalized intersection are highly dependent on the 
proportion of vehicles that arrive during the green and red signal indications. Delay and queue size are 
smaller when a larger proportion of vehicles arrive during the green indication. 

Field Travel Speed 
Description:  This value can be field measured following the guidance in HCM Chapter 30 Section 5 and 
coded here to override the parameter computed by the procedure. 

Impact on model results:  This value is used to compute Percent Free-Flow Speed, which determines 
Level of Service using HCM Exhibit 18-1. 

Field-Measured Phase Times 
Description:  This entry specifies that user-entered phase splits and/or maximum greens will not be 
modified, as they normally would be, by the computational procedure to estimate signal phase durations. 

Impact on model results:  When this entry is used, Streets will produce timings that match or closely 
approximate the Maximum Splits for that intersection, while keeping the overall configuration for a 
coordinated corridor (constant cycle, actuation effects, etc.). 

Follow Up Left Turn Time 
Description:  This entry specifies the follow-up time required for permissive left-turners at a signalized 
intersection. 

Impact on model results:  This entry affects saturation flow rates and actuated phase times for left-turns 
operating under protected-permissive or permissive-only phasing. 

Force Mode 
Description:  For uncoordinated (Chapter 19) operations, the force mode is not used. For coordinated 
(Chapter 18) operations, this entry specifies the force-off mode (fixed or floating), which governs 
reallocation of green time within the cycle. The controller calculates the phase force-off point for each 
actuated phase based on the force mode and the phase splits. When set to the fixed mode, each 
actuated phase has its force-off point set at a fixed time in the cycle, relative to time zero on the system 
master. This operation allows unused split time to revert to the following phase. When set to the floating 
mode, each actuated phase has its force-off point set at the split time after the phase first becomes 
active. This operation allows unused split time to revert to the coordinated phase via an early return to 
green. 
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Impact on model results:  Changing the force mode would potentially reallocation of green time within 
the cycle, possibly changing the amount of green time available to each movement. The amount of 
available green time impacts most aspects of the overall model; including queue lengths, stops, and 
control delays. 

Forward Segment Length 
Description:  This entry specifies distance from the subject intersection to the next downstream 
intersection, typically in the "phase 2" direction of travel. 

Impact on model results:  The forward segment length impacts many aspects of the overall model; 
including the proportion of vehicles arriving on green, time until onset of queue spillback, and travel time. 

Forward Weighting 
Description:  This entry specifies the forward arterial weighting in a signal timing optimization run. For 
example, if “Travel Time” were chosen as the objective function, and if “Both Major Street Directions” 
were chosen as the objective function direction, the optimization process would attempt to find a timing 
plan that would minimize travel times that were multiplied by the forward and reverse weighting factors. 
This entry has no effect on the approach-specific objective functions (approach stops, approach delay). 

Impact on model results:  This entry is only applicable to optimization runs. 

Free-Flow Speed of Vehicle 
Description: This entry specifies the average speed of vehicles on a given segment, measured under 
low-volume conditions, when drivers are free to drive at their desired speed and are not constrained by 
the presence of other vehicles or downstream traffic control devices. 

Impact on model results: This entry is only applicable to DDI alternative intersections. Along with clear-
zone widths, vehicle speeds, and the space between ramp stop bar and conflict zone, free-flow speeds 
contribute to the calculation of lost times that are applied to DDI off-ramp movements. 

Heaviest Lane Volume 
Description:  This entry specifies the single-lane volume with the highest volume of each movement 
group. 

Impact on model results:  Heaviest lane volume affects the lane utilization adjustment factor, which in 
turn affects the adjusted saturation flow rates. 

Heavy Vehicle Equivalency 
Description:  This entry specifies the ratio of passenger car to heavy vehicle saturation flow rate, at 
signalized intersections. The equivalent number of passenger cars for each heavy vehicle is typically 2.0. 

Impact on model results:  This entry affects the heavy vehicle adjustment factor and the adjusted 
saturation flow rate. 

Hide Multimodal Results (multimodal) 
Description:  For “operations only” analyses, this checkbox can be used to hide multimodal outputs on 
the Results Report and the Intermediate Report. 

Impact on model results:  None. 
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Incoming Pedestrian Volume (multimodal) 
Description:  This entry specifies the number of pedestrians walking in the reverse direction of travel. For 
example, on the eastbound approach, incoming pedestrians will travel westbound on the southern-most 
crosswalk. 

Impact on model results:  Incoming pedestrian volume affects the number of pedestrians arriving at 
each intersection corner during each cycle, and the total number of circulating pedestrians at each corner. 

Initial Queue Length 
Description:  This entry specifies the initial queue at the beginning of the first analysis period, either 
observed in the field or carried over from the computations of a previous analysis period. The initial queue 
for the subject period is the unmet demand from the previous period and represents the number of 
vehicles present in the movement group at the start of the analysis period. The value entered represents 
the total number of vehicles observed in the subject traffic lanes at the start of this time period. The initial 
queue value should not include vehicles in queue due to random, cycle-by-cycle fluctuations. Initial queue 
is estimated as the queue count at the start of the red indication. Whether or not an initial queue value is 
coded for the first time period, unmet demand will be computed for each period and will be carried 
forward as the initial queue for the subsequent period. 

Impact on model results:  Initial queue analyses (in which one or more movements are coded with a 
non-zero initial queue length) invoke a substantially more extensive computational procedure than 
analyses with no initial queues. Model results (from initial queue analyses) are more likely to reflect the 
increased congestion caused by period-to-period unmet demand. 

Inside Object Effective Width (multimodal) 
Description:  This entry specifies the effective width of fixed objects on the inside of the sidewalk. These 
objects include light poles, traffic signs, planter boxes, etc. 

Impact on model results:  Inside object effective width is used to compute the effective sidewalk width. 

Interchange Intersection 
Description:  This entry specifies whether or not this intersection can be classified as being part of an 
interchange ramp terminal facility. 

Impact on model results:  Interchange intersections are potentially affected by the traffic pressure 
adjustment factor, additional lost time from queue spillback, additional lost time from demand starvation, 
and lane utilization adjustments based on the interchange type. 

Interchange Type 
Description:  If this intersection has been flagged as an interchange intersection, this entry specifies the 
type of an interchange ramp terminal facility (e.g., Parclo, Diamond, SPUI). 

Please refer to the following HCM exhibits for O-D and turning movements for conventional interchanges. 

 Exhibit 34-162: O-D Flows for Each Interchange Configuration 

 Exhibit 34-163: Worksheet for Obtaining O-D Movements from Turning Movements for Parclo A-
2Q Interchanges 

 Exhibit 34-164: Worksheet for Obtaining O-D Movements from Turning Movements for Parclo A-
4Q Interchanges 

 Exhibit 34-165: Worksheet for Obtaining O-D Movements from Turning Movements for Parclo 
AB-2Q Interchanges 
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 Exhibit 34-166: Worksheet for Obtaining O-D Movements from Turning Movements for Parclo 
AB-4Q Interchanges 

 Exhibit 34-167: Worksheet for Obtaining O-D Movements from Turning Movements for Parclo B-
2Q Interchanges 

 Exhibit 34-168: Worksheet for Obtaining O-D Movements from Turning Movements for Parclo B-
4Q Interchanges 

 Exhibit 34-169: Worksheet for Obtaining O-D Movements from Turning Movements for Diamond 
Interchanges 

 Exhibit 31-170: Worksheet for Obtaining O-D Movements from Turning Movements for SPUIs 

O-D movements are also shown in the interchanges formatted report within Streets. To access this, 
please select “Interchanges Results Report” under the Report menu. A large schematic of all interchange 
O-Ds will show with the letters that match the EDTT data window. Please see the example figure below. 

 

Impact on model results:  Lane utilization adjustments are based on the interchange type. 

Intersection Depth 
Description: This is the distance between the stop bar on the approach and the beginning of the 
downstream intersection leg. 

Impact on model results: This variable defines intersection size, as: (a) Small: depth of 82 ft (or 25.0 m 
in metric) or less (1 or 2 lanes per approach); (b) Medium: depth between 82 ft (or 25.0 m in metric) and 
131 ft (or 39.9 m in metric) (2 lanes per approach); and (c) Large: depth larger than 131 ft (or 39.9 m in 
metric) (3 or more lanes for at least two approaches). 

Intersection Dropdown 
Description:  The intersection dropdown control allows the user to switch between active intersections 
for editing input data, and for viewing reports. 

Impact on model results:  None 
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Intersection Name 
Description:  This entry documents the name of the intersection being analyzed. These names can then 
be viewed within output reports, and within Quick Animation. 

Impact on model results:  None 

Intersection Type 
Description:  When the Alternative Intersection checkbox is checked, this combo box will enable, 
allowing the user to convert a coded conventional intersection into an alternative intersection. The 
choices of Intersection Type include MUT with TWSC, RCUT, and DLT. 

Please note that alternative intersections are not non-signalized intersections (i.e., AWSC, TWSC, or 
Roundabouts). However, the operation of TWSC intersections can be mimicked by modeling access 
points within Streets. 

 Median U-Turn (MUT) intersections with Two-Way Stop-Control (TWSC): At-grade intersections 
at which major- and minor-street left turns are rerouted. Minor-street through movements are not 
rerouted. U-Turn crossovers are stop-controlled instead of signalized. 

 Restricted Crossing U-Turn (RCUT) intersections: At-grade intersections at which minor-street 
left-turn and through movements are rerouted. Major-street left turns are not rerouted. 

 Displaced Left-Turn (DLT) intersections: At-grade intersections where left-turning vehicles cross 
opposing through traffic before reaching the main intersection, thus reducing conflicts at the main 
intersection. 

Impact on model results:  This entry is only applicable to Alternative Intersections. 

Jurisdiction 
Description:  This entry documents the jurisdiction for which the analysis is being performed. 

Impact on model results:  None 

K Factor, % 
Description: The K factor is the proportion of the annual average daily traffic (AADT) that occurs in the 
peak hour. It is used by Streets to convert the hourly demand used by the HCM methodologies to AADT, 
which is used by the crash prediction model. 

Impact on model results: Higher values for this variable indicate higher concentration of traffic in the 
peak hours and, consequently, lower AADT year-round. Since all safety models predict crashes 
proportionally to AADT, the higher the K factor, the lower the expected number of yearly crashes. 

Lag Phase 
Description:  This entry specifies whether or not the associated left-turn phase occurs immediately after 
the opposing (through movement) phase terminates. If split phasing is in effect, this entry indicates which 
through movement phase (4 or 8) occurs first. 

Impact on model results:  Changing the phasing sequence (via Lag Phase) would potentially shift the 
window of major street green time to a different part of the cycle, possibly changing the proportion of 
arrivals on green for one or more movements. The proportion of arrivals on green impacts many aspects 
of the overall model; including queue service times, actuated phase times, and control delays. The minor 
street phasing sequence could also affect the times during which cross street vehicles are released on to 
the major street, again affecting the proportion of arrivals on green. 
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Lane Width 
Description:  This entry specifies the average width of lanes represented in a movement group. The 
minimum average lane width is 8 feet (or 2.4 meters in metric). Standard lane widths are 12 feet (or 3.7 
meters in metric). Lane widths greater than 16 feet can be included; however, the analyst should consider 
whether the wide lane actually operates as two narrow lanes. The analysis should reflect the way in which 
the lane width is actually used or expected to be used. 

Impact on model results:  Lane widths below 10 feet (or 3.0 meters in metric) decrease the saturation 
flow rate for the associated movement, resulting in higher delays, travel times, queues, etc. Lane widths 
above 12.9 feet (or 3.93 meters in metric) increase the saturation flow rate for the associated movement, 
resulting in lower delays, travel times, queues, etc. 

Left Turn Equivalency 
Description:  This entry specifies the ratio of through to left-turn saturation flow rate, at signalized 
intersections. 

Impact on model results:  Left turn equivalency affects the distribution of saturation flow rates among 
lanes, which in turn affects many aspects of the overall model. Left turn equivalency also affects the 
computation of maximum allowable headways (MAH) for each actuated movement, which impacts 
actuated phase times. 

Legal Mid-Segment Crossing (multimodal) 
Description:  This entry indicates whether a pedestrian can cross the segment at any point along its 
length, regardless of location. If it is illegal to make this crossing at any point, then the pedestrian is 
assumed to be required to divert to the nearest signalized intersection to cross the segment. 

Impact on model results:  If mid-segment crossing is not legal, pedestrian waiting delay should be zero. 
If mid-segment crossing is legal, pedestrian waiting delay should be estimated by the analyst or 
computed using Chapter 20 procedures. 

Map X/Y Coordinate 
Description:  These entries specify node coordinate locations for drawing link-node geometry on the 
map and are only available in Visual Mode. The X coordinate is the horizontal value in a pair of 
coordinates and describes how far along left or right the point is from the origin (0,0). The Y coordinate is 
the vertical value in a pair of coordinates and describes how far or up or down the point is from the origin. 
(0,0). 

Impact on model results:  Segment lengths will be automatically re-calculated by Visual Mode as a 
function of node coordinates, and any segment curvature that might exist. 

Map X/Y Curve Point 1 and Point 2 
Description:  These entries specify control point for drawing roadway curvature on the map. 

Impact on model results:  None 

Master Intersection Number 
Description:  This entry specifies the master intersection number for a signal timing optimization run. 
Offsets for the master intersection will not be modified during an optimization run. If desired the master 
intersection number can be set to zero, thus allowing offsets to be modified at all intersections during an 
optimization run. This entry will be ignored if the master intersection number does not match any of the 
intersection numbers within the dataset. 
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Impact on model results:  This entry is only applicable to optimization runs. 

Maximum Cycle Length 
Description:  This entry specifies the maximum candidate cycle length to be considered in a signal timing 
optimization run. 

Impact on model results:  This entry is only applicable to optimization runs. 

Maximum Green 
Description: For uncoordinated (Chapter 19) operations, this entry specifies the maximum amount of 
time that a green signal indication can be displayed in the presence of conflicting demand. Typical 
maximum green values for left-turn phases range from 15 to 30 s. Typical values for through phases 
serving the minor-street approach range from 20 to 40 s, and values for through phases serving the 
major-street approach range from 30 to 60 s. For coordinated (Chapter 18) operations, maximum green is 
not used. For an analysis of coordinated-actuated operation, the maximum green is disabled through the 
inhibit mode, and the phase splits are used to determine the maximum length of the actuated phases. 

When field-measured phase times are used, maximum greens will not be modified, as they normally 
would be, by the computational procedure to estimate signal phase durations. 

Impact on model results: The amount of available green time impacts most aspects of the overall 
model; including queue lengths, stops, and control delays. This entry is applicable only when 
Uncoordinated Intersection is checked. 

Maximum Number of Generations 
Description:  This entry specifies the (genetic algorithm) maximum number of generations in a signal 
timing optimization run. During optimization, the optimal function value and average function value are 
constantly recomputed. The optimal function value represents the best objective function value when 
considering all candidate timing plans in that particular generation. The average function value is the 
average performance index value from all candidate solutions in that particular generation. During 
successive generations, the optimal function value and the average function value tend to improve due to 
the genetic selection process. The average function value can occasionally become worse due to a "bad 
mutation", but the optimal function value should always stay the same or improve. Convergence is 
achieved when the average function value becomes sufficiently close to the optimal function value. 
Increasing the maximum number of generations (or decreasing the convergence threshold) tends to 
produce longer program running times, but better timing plans. Of course, once the global optimum 
solution has been reached, additional generations and tighter convergence thresholds have no additional 
benefit. Complex traffic networks tend to require substantially more generations of candidate solutions 
before an optimal solution is obtained. 

Impact on model results:  This entry is only applicable to optimization runs. 

Maximum Platoon Headway 
Description:  This entry specifies the maximum time headway that defines a platooned vehicle. 

Impact on model results:  This entry affects access point operations. Access point operations are used 
to modify the proportion of arrivals on green for downstream major-street movements. The proportion of 
arrivals on green impacts many aspects of the overall model; including queue service times, actuated 
phase times, and control delays. 
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Median Type (multimodal) 
Description:  The median type is designated as undivided, non-restrictive (e.g., two-way left-turn lane), 
or restrictive (e.g., raised curb). 

Impact on model results:  Median type affects the cross section width adjustment factor. 

Mid-Segment 85th-Percentile Speed (multimodal) 
Description:  The 85th percentile speed represents the speed of the vehicle whose speed is exceeded 
by only 15% of the population of vehicles. The speed of interest is that of vehicles traveling along the 
street approaching the subject intersection. It is measured at a location that is sufficiently distant from the 
intersection that speed is not influenced by intersection operation. This speed is likely to be influenced by 
traffic conditions, so it should reflect the conditions present during the analysis period. 

Impact on model results:  The 85th percentile speed affects the motorized vehicle speed adjustment 
factor. 

Minimum Cycle Length 
Description:  This entry specifies the minimum candidate cycle length to be considered in a signal timing 
optimization run. 

Impact on model results:  This entry is only applicable to optimization runs. 

Minimum Green 
Description:  This entry specifies the shortest amount of time that a green signal indication will be 
displayed for a movement. It is input for each non-coordinated signal phase. Its duration is based on 
considerations of driver reaction time, queue length, and driver expectancy. Minimum green may be as 
short as 3 seconds for a left-turn phase, and 5 to 10 seconds for a through movement. For intersections 
without pedestrian push buttons, the minimum green interval may also need to be sufficiently long to 
allow a pedestrian to cross during the concurrent vehicular phase. 

Impact on model results:  Minimum green time affects the amount of available green time, which 
impacts most aspects of the overall model; including queue lengths, stops, and control delays. Minimum 
green time may also affect the probability of traffic accidents under certain conditions. 

Minimum Platoon Headway 
Description:  This entry specifies the minimum time headway between vehicles traveling in a platoon. 

Impact on model results:  This entry affects access point operations. Access point operations are used 
to modify the proportion of arrivals on green for downstream major-street movements. The proportion of 
arrivals on green impacts many aspects of the overall model; including queue service times, actuated 
phase times, and control delays. 

MUT Segment Free-Flow Speed 
Description:  When the Alternative Intersection checkbox is checked and the Intersection Type selected 
is MUT with TWSC, fields for Segment Free-Flow Speed will enable. 

Impact on model results:  This entry affects the Extra Distance Travel Time (EDTT) for the movements 
that are rerouted as a result of converting to the alternative intersection. 
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MUT Segment Length 
Description:  When the Alternative Intersection checkbox is checked and the Intersection Type selected 
is MUT with TWSC, fields for Segment Length will enable. 

Impact on model results:  This entry affects the Extra Distance Travel Time (EDTT) for the movements 
that are rerouted as a result of converting to the alternative intersection. 

Mutation Probability 
Description:  This entry specifies the (genetic algorithm) mutation probability in a signal timing 
optimization run. Mutation is an arbitrary modification of randomly selected genes. The proportion of 
mutated genes is affected by the mutation probability. The mutation process prevents the gene pool from 
becoming stale and failing to recognize new possibilities. In addition, the mutation process allows the 
genetic algorithm to locate the global optimum solution instead of a local optimum solution. Beware that 
excessively high mutation probabilities may significantly increase the amount of time required for 
optimization, or may prevent optimization altogether. If the optimization process is converging too quickly, 
or if the analyst wishes to examine a wider range of timing plan possibilities, then increasing the mutation 
probability may be helpful. If the optimization process is not converging quickly enough, or if the analyst 
wishes to acquire a reasonable and effective local optimum solution, then decreasing the mutation 
probability may be helpful. 

Impact on model results:  This entry is only applicable to optimization runs. 

Nearest Signal Distance (multimodal) 
Description:  This input parameter is needed if there is an identifiable pedestrian path that (a) intersects 
the segment and continues on beyond the segment and (b) on which most crossing pedestrians travel. 
This entry defines the distance pedestrians must travel along the segment should they divert from the 
path to cross the segment at the nearest signalized crossing. The crossing will typically be at a signalized 
intersection. However, it may also be at a signalized crosswalk provided at a mid-segment location. If the 
crossing is at a signalized intersection, it will likely occur in the crosswalk on the side of the intersection 
that is nearest to the segment. Occasionally, it will be on the far side of the intersection because the near-
side crosswalk is closed (or a crossing at this location is otherwise prohibited). This distance is measured 
along one side of the subject segment; the methodology accounts for the return distance once the 
pedestrian arrives at the other side of the segment. 

Impact on model results:  Nearest signal distance is used to compute diversion delay. 

New Access Point 
Description:  This button is used to add new access points to the analysis. New access points can also 
be added graphically within Visual Mode. 

New Intersection 
Description:  This button is used to add new intersections to the analysis. New intersections can also be 
added graphically within Visual Mode. 

New Time Period 
Description:  This button is used to add new time periods to the analysis. When the button is clicked a 
new, final time period will be added at the end of all existing time periods. When oversaturated conditions 
exist, a multiple-period analysis can more accurately capture the effects of traffic congestion. The number 
of time periods should be chosen such that the first and last time periods are undersaturated. 
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Number of Active Access Points 
Description:  This entry specifies the number of active access points on the segment. Unlike the “non-
active” access points for which volumes, laneage, and locations are not coded, these access points 
serving more than 10 vehicles per hour. 

Impact on model results:  Active access points affect the proportion of vehicles arriving on green at the 
downstream intersection. 

Number of Intersections 
Description:  This entry specifies the number of intersections in a brand-new dataset. After the new 
dataset is created, intersections can be added or deleted at any time. 

Number of Iterations 
Description:  This entry specifies a number of model iterations for the computation of actuated phase 
times. Queue service times are dependent on green interval durations. This dependency introduces a 
circularity in the calculation process. Thus, the procedure is iterative, where an initial estimate of green 
interval duration is provided and the green interval duration is re-computed. The computed duration is 
compared with the initial estimate and, if they are different, then the computed value becomes the new 
initial estimate and the procedure is repeated. Iterations are repeated until the initial estimate and 
computed green interval duration are equal. 

Impact on model results:  If the number of model iterations is too small, this could compromise the 
accuracy of the model. Higher numbers of model iterations may require longer computation times on the 
computer. The number of model iterations may have no impact on the model results of intersections 
under pre-timed operation (indicated by max recall on every phase). 

Number of Lanes 
Description:  This entry specifies the number of intersection lanes available for use by each movement. 
For through movements, this would include shared L+T, T+R, and L+T+R lanes. For left-turn and right-
turn movements, only the number of exclusive (non-shared) turn lanes should be entered. The procedure 
does not explicitly allow specification of L+R approaches with zero through vehicles; such as a one-lane 
approach with L+R, or a two-lane approach with LT-only and RT-only. Mechanics of the analysis for a one 
lane approach with L+R should be the same as for a one-lane approach with L+T+R and a through 
volume equal to 1 vph. Mechanics of the analysis for a two-lane approach with LT-only and RT-
only should be the same as when the approach is coded having one exclusive left-turn lane (LT-only), 
one shared through-right lane T+R, and a through volume equal to 1 vph. Alternatively, mechanics of the 
analysis for a two-lane approach with LT-only and RT-only should also be the same as when the 
approach is coded as having two lanes with L+T+R and a through volume equal to 1 vph. 

Impact on model results:  Intersection laneage has a fundamental effect on all aspects of the model 
results. 

Number of Periods 
Description:  This entry specifies the number of time periods in a brand-new dataset. After the new 
dataset is created, periods can be added or deleted at any time. 

Number of Receiving Lanes 
Description:  This entry specifies the count of lanes departing the intersection. This number should be 
separately determined for each left-turn and right-turn movement. Experience indicates that proper 
turning cannot be executed at some intersections because a receiving lane is frequently blocked by 
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double-parked vehicles. For this reason, the number of receiving lanes should be determined from field 
observation whenever possible. 

Impact on model results:  The number of receiving lanes affects the ped-bike saturation flow rate 
adjustment calculations. 

Number of Right-Turn Islands (multimodal) 
Description:  This entry specifies the number of right-turn channelizing islands along the crosswalk. 

Impact on model results:  The number of right-turn islands affects the motorized vehicle volume 
adjustment factor. 

Number of Transit Stops (multimodal) 
Description:  This entry specifies the number of transit stops on the segment for the subject route. 

Impact on model results:  The number of transit stops affects the transit vehicle segment running 
speed. 

O-D Seeds 
Description:  This entry specifies the average proportion of vehicle volumes that travel from each 
upstream (origin) movement to each downstream (destination) movement. 

The volume of traffic that arrives at a downstream intersection for a given downstream movement 
represents the combined volume from each upstream point of entry weighted by its percentage 
contribution to the downstream exit movement. The distribution of these contribution percentages 
between each upstream and downstream pair is represented as an origin-destination distribution matrix.  

The origin-destination matrix is important for estimating the arrival pattern of vehicles at the downstream 
intersection. Hence, the focus here is on upstream entry movements that are signalized, because (a) they 
are typically the higher-volume movements and (b) the signal timing influences their time of arrival 
downstream. For these reasons, the origin-destination distribution is focused on the three upstream 
signalized movements. All other movements (i.e., unsignalized movements at the boundary intersections, 
access point movements, RTOR movements) are combined into one equivalent movement—referred to 
hereafter as the “access point” movement—that is assumed to arrive uniformly throughout the signal 
cycle. 

The use of seed percentages allows the procedure to adapt the origin-destination volume estimates to 
factors or geometric situations that induce greater preference for some entry-exit combinations than is 
suggested by simple volume proportion (e.g., a downstream freeway on-ramp). The default seed 
proportions are listed in HCM Exhibit 30-2:  

 

Movements within the O-D matrix are dependent on the major-street and Forward Direction. The 
upstream intersection movements refer to the movements heading toward the downstream intersection. 
The downstream intersection movements refer to the movements in the downstream intersection of the 
forward direction approach. For example, when the major-street is East-West and the Forward Direction 
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is EB, the Upstream Intersection 1 movements are as follows: L refers to SBL, T refers to EBT, R refers to 
NBR, and M refers to “access point” movements. The Downstream Intersection 2 are as follows: L refers 
to EBL, T refers to EBT, R refers to EBR, and M refers to “access point” movements. 

Example of corresponding movements in O-D matrix: 

Left Origin and Right Destination: if the major-street is East-West and the Forward Direction is EB, then 
the 0.05 found below in red in the O-D matrix refers to the southbound left-turn movement from 
Intersection 1 (upstream intersection) and the eastbound right-turn movement from Intersection 2 
(downstream intersection).   

 

Impact on model results:    This entry is not used unless more than one intersection is being analyzed 
by the (Chapter 18) procedure. Changing the O-D seeds could affect the proportion of arrivals on green 
throughout the urban street system. The proportion of arrivals on green impacts many aspects of the 
overall model; including queue service times, actuated phase times, and control delays. 

Offset 
Description: This entry specifies the difference between the start of green time for the reference interval 
at the subject intersection, and a specified time datum in a system of signalized intersections. The offset 
is used to coordinate timing plans at adjacent intersection along an urban street, ideally allowing vehicles 
to pass through multiple intersection without stopping. 

Impact on model results: For uncoordinated (Chapter 19) operations, the offset is not used. For 
coordinated (Chapter 18) operations, offsets affect many aspects of the overall model; including travel 
speeds, travel times, stops, and control delays. 

Offset Optimization Flag 
Description: This entry specifies whether or not offsets are to be optimized in a signal timing optimization 
run. 

Impact on model results: This entry is only applicable to optimization runs. 

On-Ramp Left Lane Shared 
Description: This checkbox indicated if the specified left-turn movement is in a shared left-thru lane. 

Impact on results: This entry is only applicable to DDI intersection. For DDI in Streets, a coded major-
street exclusive left-turn lane is necessary for the lane configuration. However, this checkbox allows the 
user to specify if that left-turn is in a shared lane. If true, calculation are done internally with consideration 
of the shared lane. 
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On-Street Parking 
Description: This entry specifies the percent of on-street parking on the link, which is converted to a 
proportion for calculations. The proportion of the segment with on-street parking represents that portion of 
the link length that has parking stalls (either marked or unmarked) available along the right side of the 
segment. This proportion is computed as the length of street with parking stalls divided by the link length. 
Parking stalls considered include those described as having either a parallel or angle design. This 
proportion is separately computed for each direction of travel along the segment. 

Impact on model results: On-Street Parking is used in the computation of segment free-flow speed; 
which in turn affects segment running times, and the proportion of vehicle arrivals on green. 

Open RCUT File 
Description: This button opens a dialog box for the user to select and open the second RCUT file to 
complete the coded RCUT. 

Impact on model results: This button is only applicable to RCUT alternative intersections and is 
necessary for the completion of one RCUT alternative intersection. 

Opposing Right-Turn Lane Influence 
Description:  This entry specifies whether or not permitted left turners are influenced by exclusive right-
turn lanes on the opposing approach. This determination should be based on knowledge of local driver 
behavior, traffic conditions, and intersection geometry. 

Impact on model results:  When opposing right-turn lane influence exists, this decreases permitted left-
turn capacity. When opposing right-turn lane influence does not exist, this increases permitted left-turn 
capacity. 

Optimization Objective Function 
Description:  This entry specifies the objective function to be considered in a signal timing optimization 
run. For example, if “travel time” were chosen as the objective function, the optimization process would 
attempt to find a timing plan that would minimize travel time. 

Impact on model results:  This entry is only applicable to optimization runs. 

Optimization Objective Function Direction 
Description:  This entry specifies the objective function direction to be considered in a signal timing 
optimization run. The available options are “Both Major Street Directions”, “Forward Major Street 
Direction”, “Reverse Major Street Direction”, and “All Approaches”. For example, if “Travel Time” were 
chosen as the objective function, and if “Reverse Major Street Direction” were chosen as the objective 
function direction, the optimization process would attempt to find a timing plan that would minimize travel 
times in the urban street reverse direction. The “Forward Major Street Direction” and “Reverse Major 
Street Direction” selections are tantamount to applying 100% objective function weighting to the chosen 
direction, and 0% objective function weighting to the opposite direction. If the “Both Major Street 
Directions” selection or “All Approaches” selection is chosen in conjunction with arterial objective 
functions (travel speed, travel time, spatial stops), the default arterial weighting is 50% in each direction. 
The analyst can specify unequal arterial weightings using the “Forward Direction Weighting” and 
“Reverse Direction Weighting” entries, if desired. 

Impact on model results:  This entry is only applicable to optimization runs. 
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Outgoing Pedestrian Volume (multimodal) 
Description:  This entry specifies the number of pedestrians walking in the forward direction of travel. For 
example, on the eastbound approach, outgoing pedestrians will travel eastbound on the southern-most 
crosswalk. 

Impact on model results:  Outgoing pedestrian volume affects the number of pedestrians arriving at 
each intersection corner during each cycle, and the total number of circulating pedestrians at each corner. 

Outside Object Effective Width (multimodal) 
Description:  This entry specifies the effective width of fixed objects on the outside of the sidewalk. 

Impact on model results:  Outside object effective width is used to compute the effective sidewalk width. 

Outside Thru Lane Width (multimodal) 
Description:  This entry specifies the width of the outside thru vehicle lane on the subject approach. 

Impact on model results:  The outside thru lane width affects the cross section width adjustment factor. 

Parking Exists 
Description:  This entry indicates that on-street parking spaces exist within 250 feet (76.2 meters in 
metric) of the intersection (regardless of whether or not parking maneuvers take place). This entry 
indicates whether on-street parking is allowed along the curb line adjacent to a movement group and 
within 250 feet (76.2 meters in metric) upstream of the stop line during the analysis period. On a one-way 
street with no exclusive turn lanes, the presence of on-street parking is separately noted for each side of 
the street. 

Impact on model results:  The existence of parking decreases the saturation flow rate for associated 
movements, resulting in higher delays, travel times, queues, etc. Note that parking conditions with zero 
maneuvers have a different impact than a no-parking situation. 

Parking Lane Width (multimodal) 
Description: This entry specifies the width of the parking lane on the subject approach. 

Impact on model results: The parking lane width affects the cross section width adjustment factor. 

Parking Maneuver Time 
Description:  This entry specifies the amount of time (default: 18 seconds) needed by a driver to execute 
a parking maneuver. 

Impact on model results:  The parking maneuver time affects the parking adjustment factor, which is 
used to adjust the saturation flow rates. 

Parking Maneuvers per Hour 
Description:  This entry specifies the number of parking maneuvers that occur directly adjacent to a 
movement group and within 250 feet (76.2 meters in metric) upstream of the stop line, as measured 
during the analysis period. A maneuver occurs when a vehicle enters or exits a parking stall. If more than 
180 maneuvers per hour exist, a practical limit of 180 should be used. On a one-way street with no 
exclusive turn lanes, maneuvers are separately counted for each side of the street. The count is divided 
by the analysis period duration to yield an hourly flow rate. 
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Impact on model results:  Non-zero parking maneuvers per hour decrease the saturation flow rate for 
associated movements, resulting in higher delays, travel times, queues, etc. Note that parking conditions 
with zero maneuvers have a different impact than a no-parking situation. 

Passage Time 
Description:  This entry specifies the maximum amount of time one vehicle actuation can extend the 
green interval when green is displayed. It is input for each non-coordinated signal phase. It is also 
referred to as vehicle interval, extension interval, extension, or unit extension. The passage timer starts to 
time from the instant the vehicle actuation is removed. A subsequent actuation will reset the passage 
timer. When the passage timer reaches the passage time setting and there is an actuation on a conflicting 
phase, the phase will terminate by gap out. Passage time values are typically chosen based on 
consideration of detection zone length, detection zone location (relative to the stop line), number of lanes 
served by the phase, and vehicle speed. Longer passage times are often used with shorter detection 
zones, greater distance between the zone and stop line, fewer lanes, and slower speeds. The objective 
when determining the passage time value is to make it large enough to ensure that all queued vehicles 
are served but to not make it so large that it extends for randomly arriving traffic. On high-speed 
approaches, this objective is broadened to include not making the passage time so large that the phase 
frequently extends to its maximum setting (i.e., maxes-out) such that safe phase termination is 
compromised. 

Impact on model results:  Passage time is used to compute maximum allowable headways (MAH) for 
each actuated movement. MAH impacts many aspects of the overall model; including actuated phase 
times, and control delays. 

Passenger Load Factor (multimodal) 
Description:  This entry specifies the number of passengers occupying the transit vehicle divided by the 
number of seats on the vehicle. If the number of passengers equals the number of seats, then the load 
factor equals 1.0. This factor should be measured in the field or obtained from the agency serving the 
transit route. It is an average value for all of the scheduled fixed route transit vehicles that travel along the 
segment during the analysis period. 

Impact on model results:  Passenger load factor is used to compute the perceived travel time rate. 

Paved Shoulder Width (multimodal) 
Description:  This entry specifies the width of the paved outside shoulder on the subject approach. 

Impact on model results:  The paved shoulder width affects the cross section width adjustment factor. 

Pavement Condition Rating (multimodal) 
Description:  This entry, which ranges from 0.0 to 5.0, describes the road surface in terms of ride quality 
and surface defects. PCR values of 4.0 or higher imply new or nearly new superior pavement; free of 
cracks and/or patches, and allowing a good ride. PCR values of 1.0 or lower imply distress over at least 
75% of the surface; with large potholes and/or deep cracks, and an uncomfortable ride. 

Impact on model results:  Pavement condition rating affects the bicycle level of service score for the 
“link”. 

Peak-Hour Factor 
Description:  This entry specifies the proportion of peak-hour volume occurring in the peak 15 minutes. 
Peak 15-minute volume is computed as the hourly volume divided by four times the PHF. 
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Impact on model results:  The PHF (when lower than 1.0) simply factors up the associated movement 
volume, to reflect increased flow rates during the peak 15-minute period. 

Pedestrian Free-Flow Speed (multimodal) 
Description:  This entry specifies the average desired walking speed of all pedestrians on this particular 
sidewalk. 

Impact on model results:  The (average) free-flow walk speed is used to compute the (average) actual 
walk speed. Increasing two-way pedestrian volumes cause actual walk speeds to become increasingly 
lower than free-flow walk speeds. Decreasing effective sidewalk widths cause actual walk speeds to 
become increasingly lower than free-flow walk speeds. 

Pedestrian Signal Head (multimodal) 
Description:  The presence of a pedestrian signal head influences pedestrian crossing behavior. If a 
pedestrian signal head is provided, then pedestrians are assumed to use the crosswalk during the WALK 

and flashing DON’T WALK indications. If no pedestrian signal heads are provided, then pedestrians will 
cross during the green indication provided to vehicular traffic. 

Impact on model results:  The presence of a pedestrian signal head affects the effective walk time for 
all phases. 

Pedestrian Waiting Delay (multimodal) 
Description:  This entry specifies the delay incurred when pedestrians wait at an uncontrolled crossing 
location, if this type of crossing is legal. 

Impact on model results:  Pedestrian waiting delay affects the roadway crossing difficulty factor. 

Pedestrians per Hour 
Description:  This entry specifies the number of pedestrians traveling in the crosswalk that is crossed by 
vehicles turning right from the subject approach during the analysis period. For example, the pedestrian 
flow rate for the westbound approach would describe the pedestrian flow in the crosswalk on the north 
leg. The count is divided by the analysis period duration to yield an hourly flow rate. 

Impact on model results:  Non-zero pedestrians per hour decrease the saturation flow rate for 
associated movements, resulting in higher delays, travel times, queues, etc. 

Percent Grade 
Description:  Approach grade defines the average grade along the approach, as measured along a line 
parallel to the direction of travel and from the stop line to a point 100 feet (30.5 meters in metric) 
upstream of the stop line. An uphill condition has a positive grade, and a downhill condition has a 
negative grade. 

Impact on model results:  Upgrades (above zero) decrease the saturation flow rate for associated 
movements, resulting in higher delays, travel times, queues, etc. Downgrades (below zero) increase the 
saturation flow rate for associated movements, resulting in lower delays, travel times, queues, etc. 

Percent Trucks 
Description:  This entry specifies the percentage of trucks (heavy vehicles) in the traffic stream for each 
movement. A heavy vehicle is defined as any vehicle with more than four tires touching the pavement. 
Local buses that stop near the intersection (as defined in a subsequent section) are not included in the 
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count of heavy vehicles. The percentage of heavy vehicles represents the number of heavy vehicles that 
arrive during the analysis period divided by the total vehicle count for the same period. This percentage is 
provided for each intersection traffic movement; however, one representative value for all movements 
may be used for a planning analysis. 

Impact on model results:  Non-zero truck percentages decrease the saturation flow rate for the 
associated movement, resulting in higher delays, travel times, queues, etc. For the multimodal (bicycles) 
procedure, truck percentages are used to compute the motorized vehicle speed adjustment factor. 

Percent Turns in Shared Lane 
Description:  These entries specify the percentage of left-turn or right-turn vehicles using the shared lane 
instead of the exclusive lane. These entries are only applicable to shared-plus-exclusive lane 
configurations. 

Impact on model results:  The vehicular demands affect most aspects of the overall model; including 
control delay, time until onset of queue spillback, queue lengths, and travel time. 

Percent Unopposed Left Turns 
Description:  Because the HCM procedures do not explicitly support unopposed major-street left turns 
on a one-way street, these conditions can be approximated by adding left-turn volume into the thru 
volume. However, when doing this, saturation flow rates must also be adjusted to account for left turns in 
the traffic stream. This entry allows the user to specify the percentage of major-street left turns within the 
thru movement, which can then automatically adjust saturation flow rates for the thru movement. This 
entry is not applicable for minor side streets, and is not applicable for two-way major streets. This entry is 
also not applicable for one-way major streets on which left turns do not exist. 

Impact on model results:  The percentage of unopposed left turns is used as a multiplier for the left-turn 
equivalency, which defaults to 1.05. For example, thru movement saturation flow rate would be reduced 
by 2.5% if the percent unopposed left turns were coded as 50%. Similarly, thru movement saturation flow 
rate would be reduced by 0.5% if the percent unopposed left turns were coded as 10%. 

Period Dropdown 
Description:  The time period dropdown control allows the user to switch between active time periods for 
editing input data, and for viewing reports. 

Impact on model results:  None 

Permitted Left-Turn Flow (multimodal) 
Description:  This entry specifies the count of vehicles that turn left permissively. A permitted left-turn 
movement can occur with either the permitted or the protected-permitted left-turn mode. For left-turn 
movements served by the permitted mode, the permitted left-turn flow rate is equal to the left-turn 
demand flow rate. For left-turn movements served by the protected-permitted mode, the permitted left-
turn flow rate should be measured in the field because its value is influenced by many factors. 

Impact on model results:  Permitted left-turn flow affects the effective available crosswalk time-space, 
and the motorized vehicle volume adjustment factor. 

Phase 2 Direction 
Description:  This entry specifies the direction of "phase 2" in the timing plan. The phase 2 direction does 
not need to be identical to the urban street forward direction. However, if the urban street forward 
direction is eastbound or westbound, the phase 2 direction must either be eastbound or westbound. If the 
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urban street forward direction is northbound or southbound, the phase 2 direction must either be 
northbound or southbound. 

Impact on model results:  Reversing the phase 2 direction would cause input controller settings for 
phases 1, 2, 5, and 6 to apply to the opposite direction. 

Phase 4 Direction 
Description:  This entry specifies the direction of "phase 4" in the timing plan. The phase 4 direction must 
be perpendicular to the urban street forward direction. 

Impact on model results:  Reversing the phase 4 direction would cause input controller settings for 
phases 3, 4, 7, and 8 to apply to the opposite direction. 

Phase Movement 
Description:  This entry specifies which movements are active during the given signal phase. 

Impact on model results:  Left-turns are typically active during the odd-numbered signal phases. Right-
turns and through movements are typically active during even-numbered signal phases. The main 
exception to this is protected-permissive or permissive-only left-turn phasing, in which left-turners are 
activated (allowed to search for gaps in opposing traffic) during even-numbered phases. Protected-
permissive left-turn phasing is known to allow for lower delays experienced by left-turning vehicles 
(assuming sufficiently low opposing traffic volumes), when compared to protected-only left-turn phasing. 
However, timing plans allowing permissive left-turners are also known to increase the probability of traffic 
accidents under certain conditions, when compared to protected-only left-turn phasing. 

Phase Split 
Description:  This entry specifies a “split” time provided for each non-coordinated phase. A phase split 
represents the sum of the green, yellow change, and red clearance intervals for the phase. The rationale 
for determining the appropriate green interval duration varies among agencies; however, it is often 
equated to the optimum fixed green duration that is obtained from a signal timing optimization software 
program. The phase split for each phase in a concurrent pair (i.e., 1 and 5, 3 and 7, 4 and 8) is not 
required to be equal in most modern controllers; however, it is typically set at the same value. It is 
assumed in this procedure that each phase in the pair has the same split value (split values may vary 
among pairs). 

Impact on model results:  The amount of available green time impacts most aspects of the overall 
model; including queue lengths, stops, and control delays. 

Phasing Sequence Optimization Flag 
Description:  This entry specifies whether or not (lead-lag) phasing sequences are to be optimized in a 
signal timing optimization run. 

Impact on model results:  This entry is only applicable to optimization runs. 

Phasing View 
The signal phasing sequence is specified by clicking on the dual-ring phasing diagram (phases 1 through 
8), also known as “Quick Phases”. Green, yellow, and all-red clearance times may be entered in the 
group box labeled “Timing”. After the signal phasing and timing are entered a sequential phasing diagram 
(labeled “Phasing View”) will display the overall timing plan in an equivalent “single-ring” format. 

The HCM procedure to calculate the average duration of an actuated phase generates the green times in 
the Phasing View. This procedure is used for estimating the average phase duration for an intersection 
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that is operating with actuated control. Where appropriate, the description is extended to include 
techniques for estimating the duration of non-coordinated and coordinated phases. A series of 
calculations (Volume Computations; Queue Accumulation Polygon; Maximum Allowable Headway; 
Equivalent Maximum Green; Average Phase Duration; and Probability of Max Out) is completed in 
sequence as defined in HCM Chapter 31 to obtain estimates of average phase duration and the 
probability of phase termination by extension to its maximum green limit. 

Note: The Phasing View presents average phase times over the analysis period (typically 15 minutes) 
that may not necessarily represent what might be displayed for any given cycle. For example, if a given 
phase has little demand, it may serve the minimum green some cycles and be skipped other cycles, 
yielding an average below the minimum. Also, if the average is less than the clearance time, only the 
green may be displayed with zero shown for the clearance time. And, if the average is equal to the 
clearance time, the green may be displayed as zero. This is necessary to both show the averages and 
have them sum to the cycle length. 

Increasing the “Number of Calculation Iterations” (the default value is 15 iterations) may improve the 
accuracy of phase time estimation under complex conditions, but may increase the amount of time 
required for re-calculation. For pre-timed signals (“Recall Mode” set equal to “Max” for each phase), 
phase durations will usually reflect user-specified maximum green times if the number of iterations is high 
enough. Alternatively, phase durations may be taken directly from user-entered data, by turning on the 
checkbox called “Field-Measured Phase Times”. 

Phasing Wizard 
Description: The phasing wizard is available to help determine what is coded in the Quick Phases 
diagram. The Quick Phases diagram will automatically populate based on the answers provided for the 
following questions along with the lanes coded in the Quick Lanes diagram: 

 Protected Left-Turn Phases? 

 Permitted Left-Turn Phases? 

 Right-Turn Overlap Phases? 

 Lagging Left-Turn Phases? 

Indicating “Yes” for any of these questions will cause the additional question of “Which Approaches?” to 
appear. Checkboxes for all four approaches (i.e., EB, WB, NB, SB) will appear but will only enable if the 
lanes coded in Quick Lanes allow it. 

Platoon Dispersion Factor 
Description:  This entry specifies the calibration factor for platoon dispersion. 

Impact on model results:  Platoon dispersion affects the proportion of arrivals on green. This impacts 
many aspects of the overall model; including queue service times, actuated phase times, and control 
delays. 

Population Size 
Description:  This entry specifies the (genetic algorithm) population size in a signal timing optimization 
run. The population size is the number of individuals within each generation. For example, if 200 
generations of optimization were performed with a population size of 10, this would result in a total of 
2000 model runs. Lower population sizes sometimes allow for faster program running times on the 
computer, but higher population sizes may facilitate genetic diversity and faster optimization of certain 
networks. If the optimization process is converging too quickly, or if the user wishes to examine a wider 
range of timing plan possibilities, then increasing the population size may be helpful. If the optimization 
process is not converging quickly enough, or if the user wishes to acquire a reasonable and effective local 
optimum solution, then decreasing the population size may be helpful. 
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Impact on model results:  This entry is only applicable to optimization runs. 

Presence of Bike Facilities 
Description: Presence of bicycle facilities, including bike lane only, shared bicycle and vehicle lane or 
bicycle storage areas at the approaches. 

Impact on model results: Overall, bike facilities increase the frequency of left-turn against crashes. For 
large intersections, it is also related to more rear-end crashes, while for medium or small intersection, less 
rear-end crashes are expected (see intersection depth definition for intersection size determination). 

Presence of Continuous Barrier (multimodal) 
Description:  This entry specifies presence of any continuous barrier (at least 3 feet, or 0.9 meters in 
metric, high) located between the sidewalk and the outside edge of roadway. 

Impact on model results:  Continuous barrier presence affects the buffer area coefficient, which in turn 
affects the cross section width adjustment factor. 

Presence of Curb (multimodal) 
Description:  This entry specifies whether a curb is present next to the paved outside shoulder on the 
subject approach. 

Impact on model results:  Curb presence affects the adjusted width of paved outside shoulder, which in 
turn affects the cross section width adjustment factor. 

Presence of Mast Arm Signal Display 
Description: DEFINES the study area as residential. This option is only available when the Area Type 
option at the (PRIMARY INPUT DATA / General) is not set as CBD. 

Impact on model results: Overall, this factor is associated to a reduction on right angle crashes. 

Presence of Median Island 
Description: Reflects elevated median islands designed for pedestrian safety and traffic separation. 

Impact on model results: Decreases the proportion of right angle crashes while slightly increasing left-
turn against crashes. 

Presence of Merge on Exit Side 
Description: This variable reflect the situation where the downstream road width decreases due to lane 
drops, blockages, incidents or road works. If, at the Main Input screen, the number of lanes decreases 
from the upstream segment to the next, this variable is automatically checked. 

Impact on model results: This factor increases loss-of-control crashes. 

Presence of Sidewalk (multimodal) 
Description:  This entry specifies whether a sidewalk is present along the subject segment. A sidewalk is 
a paved walkway that is provided at the side of the roadway. It is assumed that pedestrians will walk in 
the street if a sidewalk is not present. 

Impact on model results:  Sidewalk presence affects the adjusted available sidewalk width, which in 
turn affects the pedestrian LOS score. 
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Presence of upstream bus bay within 330 ft of stop bar 
Description: This variable represents the existence of a bus stop with frequent use within 330 ft (or 100.6 
m in metric) of the stop bar. 

Impact on model results: The presence of bus bays close to the stop bar has been found to increase 
the frequency of rear-end crashes at small intersections, with little to no effect on larger ones. 

Presence of upstream parking within 330 ft of stop bar 
Description: This variable represents the existence of continuous curbside parking on either side of the 
road within 330 ft (or 100.6 m in metric) of the stop bar. This includes parallel and angle parking. 

Impact on model results: The presence of parking has not been associated with the increase of any 
type of crash, though reducing run-offs and thus, loss-of-control crashes. 

Pre-Timed Signal Flag 
Description: A checkbox is provided to indicate whether a signal is a pretimed control, which is a fixed 
sequence of phases that are displayed in repetitive order. The duration of each phase is fixed. However, 
the green interval duration can be changed by time of day or day of week to accommodate traffic 
variations. The combination of a fixed phase sequence and fixed duration produces a constant cycle 
length. When a signal is pretimed in Streets, the color of the arrows in the Phase Duration graphic will be 
blue. 

Impact on model results: Indicating pretimed operation for a signal is the equivalent of using maximum 
recall on all phases, which affects the amount of available green time and in turn, impacts most aspects 
of the overall model, including queue lengths, stops, and control delay. 

Project Description 
Description:  This entry documents the analysis with information for identification purposes. 

Impact on model results:  None 

Proportion of CAVs 
Description: This entry specifies the proportion of CAVs in the traffic stream. CAV is a connected 
autonomous vehicle, defined here as a vehicle with an operating cooperative adaptive cruise control 
system. The range of proportion of CAVs in the traffic stream is from 0 to 100. 

Impact on model results: The proportion of CAVs affects the saturation flow rates of a signalized 
intersection. When CAVs are present in the traffic stream, the base saturation flow rates, or s0, are 
adjusted for the through movements. The base saturation flow rate is then applied to Equation 19-8 along 
with other adjustment factors to determine the adjusted saturation flow rate.  

Left-turn movements at signalized intersections may see increases in capacity due to the presence of 
CAVs in the traffic stream. Unlike through movements, the base saturation flow rates do not change for 
left-turn movements. Instead, saturation flow rate adjustment factors are considered. For protected left-
turn movements, the factor is fCAV,prot. For permitted left-turn movements, the factor is fCAV,perm. These 
factors are then applied to Equation 19-8 along with the base saturation flow rate and other adjustment 
factors to determine the adjusted saturation flow rate. 

Proportion of On-Street Parking Occupied (multimodal) 
Description:  This entry specifies the proportion of the intersection’s right-side curb line that has parked 
vehicles present during the analysis period. It is based on a zone that extends from a point 250 feet (or 
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76.2 meters in metric) upstream of the intersection to the intersection, and a second zone that extends 
from the intersection to a point 250 feet (or 76.2 meters in metric) downstream of the intersection. If 
parking is not allowed in these two zones, then this proportion equals 0.0. 

Impact on model results:  The proportion of on-street parking affects the cross section width adjustment 
factor. 

Proportion of Pedestrians who Push Button 
Description:  This entry specifies the proportion of pedestrians who will push the intersection crossing 
button for service. 

Impact on model results:  The pedestrian calling rate is used to compute the probability of a phase call. 
This in turn potentially affects actuated phase times and control delays for all movements. 

Queue Length Percentile 
Description:  This entry specifies the probability that a computed queue length will not be exceeded 
during any one signal cycle. 

Impact on model results:  Queue length percentile affects the back-of-queue adjustment factor; which in 
turn affects queue storage ratio, uniform queue length, and incremental queue length. 

Quick Jump 
Description:  The Quick Jump combo box allows the user to jump to certain sections of the Classic Mode 
user-interface screen. 

Impact on model results:  None 

Quick Lanes 
Description:  Quick Lanes provides a graphical data entry mechanism for specifying lane configuration. 
Lane use combinations can be selected by clicking on the appropriate arrows to place them on the central 
diagram for each approach. To remove a selected arrow combination, simply click on the white arrow on 
the approach itself. 

Impact on model results:  Intersection laneage has a fundamental effect on all aspects of the model 
results. 

Quick Phases 
The signal phasing sequence is specified by clicking on the dual-ring phasing diagram (phases 1 through 
8), also known as “Quick Phases”. Only the left-turn phasing needs to be specified, because thru 
movements and right-turn movements are automatically added to the phasing sequence as a function of 
laneage. The dual-ring phasing diagram contains logic to prevent invalid phasing sequences from being 
entered, given the available laneage. Left-turn movements in odd-numbered phases are used to reflect 
protected left-turns (i.e., “green arrow”), whereas left-turn movements in even-numbered phases are used 
to reflect permitted left-turns (i.e., “green ball”). When exclusive right-turn lanes exist, shielded right-turns 
may be added by clicking twice on the corresponding odd-numbered phase. Green, yellow, and all-red 
clearance times may be entered in the group box labeled “Timing”. After the signal phasing and timing are 
entered a sequential phasing diagram (labeled “Phasing View”) will display the overall timing plan in an 
equivalent “single-ring” format. 
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Random Number Seed 
Description:  This entry specifies the (genetic algorithm) random number seed in a signal timing 
optimization run. Crossover, mutation, and the competition between individuals involve a certain degree 
of randomization. If the random number seed value is left unchanged by the analyst, multiple runs with 
the same input data should always generate the same optimal design. If the random number seed is 
changed by the analyst, this may change the amount of time required to locate the optimal solution. Given 
the necessary G.A. parameter values (i.e., a high maximum number of iterations together with a low 
convergence threshold), the algorithm is designed to converge on the (one and only) global optimum 
solution. In order to obtain internal processes that are truly "mathematically random", it is recommended 
that the random number seed value should end in a '1', '3', '7', or '9'. 

Impact on model results:  This entry is only applicable to optimization runs. 

Recall Mode 
Description:  This entry specifies whether or not the controller will automatically place a call for a 
specified phase each time the controller is servicing a conflicting phase. When “no recall” is entered, 
phases are eligible to be skipped in the absence of vehicular demand. Otherwise, there are three types of 
recalls: minimum recall, maximum recall, and pedestrian recall. Invoking minimum recall causes the 
controller to place a continuous call for vehicle service on the phase, and then service the phase until its 
minimum green interval times out. The phase can be extended if actuations are received. Invoking 
maximum recall causes the controller to place a continuous call for vehicle service on the phase. It results 
in the presentation of the green indication for its maximum duration every cycle. Using maximum recall on 
all phases yields an equivalent pre-timed operation. Invoking pedestrian recall causes the controller to 
place a continuous call for pedestrian service on the phase and then service the phase for at least an 
amount of time equal to its walk and pedestrian clear intervals (more if vehicle detections are received). 
Pedestrian recall is used for phases that have a high probability of pedestrian demand every cycle and no 
pedestrian detection. 

Impact on model results:  Recall mode affects the amount of available green time, which impacts most 
aspects of the overall model; including queue lengths, stops, and control delays. Minimum green time 
may also affect the probability of traffic accidents under certain conditions. 

Red Time 
Description:  This entry specifies the all-red clearance interval duration displayed by the signal for the 
given phase. 

Impact on model results:  Red time affects the amount of available green time, which impacts most 
aspects of the overall model; including queue lengths, stops, and control delays. Red time may also affect 
the probability of traffic accidents under certain conditions. 

Re-Entry Delay (multimodal) 
Description:  This entry specifies the time (in seconds) a transit vehicle spends waiting for a gap to re-
enter the adjacent traffic stream. Re-entry delay is zero at on-line stops. 

Impact on model results:  Re-entry delay is used to compute the overall delay due to a transit stop. 

Reference Phase 
Description:  For uncoordinated (Chapter 19) operations, the reference phase is not used. For 
coordinated (Chapter 18) operations, this entry specifies the coordinated phase number (must be either 2 
or 6) to which the offset is referenced. 
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Impact on model results:  Changing the reference phase number would potentially shift the window of 
major street green time to a different part of the cycle, possibly changing the proportion of arrivals on 
green for one or more movements. The proportion of arrivals on green impacts many aspects of the 
overall model; including queue service times, actuated phase times, and control delays. 

Reference Point 
Description:  For uncoordinated (Chapter 19) operations, the reference point is not used. For 
coordinated (Chapter 18) operations, this entry specifies the location (beginning of green or end of green) 
to which the offset is referenced. 

Impact on model results:  Changing the reference point would potentially shift the window of major 
street green time to a different part of the cycle, possibly changing the proportion of arrivals on green for 
one or more movements. The proportion of arrivals on green impacts many aspects of the overall model; 
including queue service times, actuated phase times, and control delays. 

Residential Area Use 
Description: DEFINES the study area as residential. This option is only available when the Area Type 
option at the (PRIMARY INPUT DATA / General) is not set as CBD. 

Impact on model results: Overall, this factor is associated to a reduction on loss-of-control crashes. 

Rest in Walk Enabled (multimodal) 
Description:  A phase with the rest-in-walk mode enabled will dwell in walk as long as there are no 
conflicting calls. When a conflicting call is received, the pedestrian clear interval will time to its setting 
value before ending the phase. This mode can be enabled for any actuated phase. Signals that operate 
with coordinated-actuated operation may be set to use a coordination mode that enables the rest-in-walk 
mode. Typically, the rest-in-walk mode is not enabled. In this case, the walk and pedestrian clear intervals 
each time to their respective setting values, and then the pedestrian signal indication dwells in a steady 
DON’T WALK indication until a conflicting call is received. 

Impact on model results:  Rest-in-walk affects the effective walk time for actuated phases. 

Reverse Segment Length 
Description:  This entry specifies distance from the subject intersection to the next downstream 
intersection, typically in the "phase 6" direction of travel. 

Impact on model results:  The reverse segment length impacts many aspects of the overall model; 
including the proportion of vehicles arriving on green, time until onset of queue spillback, and travel time. 

Reverse Weighting 
Description:  This entry specifies the reverse arterial weighting in a signal timing optimization run. For 
example, if “Travel Time” were chosen as the objective function, and if “Both Major Street Directions” 
were chosen as the objective function direction, the optimization process would attempt to find a timing 
plan that would minimize travel times that were multiplied by the forward and reverse weighting factors. 
This entry has no effect on the approach-specific objective functions (approach stops, approach delay). 

Impact on model results:  This entry is only applicable to optimization runs. 
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Right Turn Equivalency 
Description:  This entry specifies the ratio of through to right-turn saturation flow rate, at signalized 
intersections. 

Impact on model results:  Right turn equivalency affects the distribution of saturation flow rates among 
lanes, which in turn affects many aspects of the overall model. Right turn equivalency also affects the 
computation of maximum allowable headways (MAH) for each actuated movement, which impacts 
actuated phase times. 

Right Turns on Red 
Description:  This entry specifies the count of vehicles that turn right at the intersection when the signal 
indication is red, divided by the analysis period duration. It is expressed as an hourly flow rate, but may 
represent a time period shorter than one hour. It is difficult to predict the right-turn-on-red (RTOR) flow 
rate because it is based on many factors that vary widely from intersection to intersection. These factors 
include approach lane allocation (shared or exclusive right-turn lane), right-turn flow rate, sight distance 
available to right-turning drivers, volume-to-capacity ratio for conflicting movements, arrival patterns 
during the signal cycle, left-turn signal phasing on the conflicting street, and conflicts with pedestrians. 
Given the difficulty of estimating the RTOR flow rate, it is recommended that this flow rate be measured in 
the field whenever possible. If the analysis is dealing with future conditions or if the RTOR flow rate is not 
known from field data, then the RTOR flow rate for each right-turn movement can be assumed to equal 
zero veh/h. This is a conservative assumption because it may indicate a slightly longer delay than may 
actually be incurred. 

Impact on model results:  The coded value is subtracted from the right-turn demand before the adjusted 
flow rate is computed. 

Right-Hand Curb 
Description:  This entry specifies the percentage of the segment length with a right-hand curb present. 

Impact on model results:  Right-hand curb presence is used in the computation of segment free-flow 
speeds. 

Safety and Emission 
Description: This button opens a dialog box for inputs relevant to signal timing optimization with 
consideration of environment and safety impacts. Outputs are also provided in this dialog box. However, 
changing inputs will not automatically show the updated outputs. Buttons are provided for separately 
calculating Safety outputs and Emission outputs. 

Impact on model results: None 

Saturation Flow Rate 
Description:  This value specifies the maximum steady flow rate at which previously stopped passenger 
cars can cross the stop line of a signalized intersection under typical conditions, assuming that the green 
signal is available and no lost times are experienced. 

Segment “Other” Delays 
Description: This entry specifies the average extra vehicle delay caused by “other” mid-segment 
sources, such as parking. 

Impact on model results: This entry is used to compute segment running times, and the proportion of 
vehicle arrivals on green. 
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Segment Dropdown 
Description:  The segment dropdown control allows the user to switch between active segments for 
editing input data, and for viewing reports. 

Impact on model results:  None 

Segment Length 
Description:  This entry specifies length of the active segment, which is indicated by the segment 
dropdown. Segments are only relevant when there is more than one intersection within the analysis. 

For the purpose of analysis, the roadway is separated into individual elements that are physically 
adjacent and operate as a single entity in serving travelers. Two elements are commonly found on an 
urban streets system: points and links. A point is the boundary between links and is represented by an 
intersection or ramp terminal. A link is a length of roadway between two points. A link and its boundary 
points are referred to as a segment. 

Segment length is the distance between the boundary intersections that define the segment. The point of 
measurement at each intersection is the stop line, the yield line, or the functional equivalent in the subject 
directions of travel. This length is measured along the centerline of the street. If it differs in the two travel 
directions, an average length is used. 

The link length is used in some calculations. It is computed as the segment length minus the width of the 
upstream boundary intersection. 

 

Impact on model results:  Segment lengths are used in the computation of travel speeds and vehicle 
delays. 

Segment Length with Non-Restrictive Median 
Description:  This entry specifies the amount of segment length that contains a non-restrictive median. 

Impact on model results:  Segment median lengths are used in the computation of segment free-flow 
speeds, which in turn affect the proportion of vehicle arrivals on green. 

Segment Length with Restrictive Median 
Description:  This entry specifies the amount of segment length that contains a restrictive median. 
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Impact on model results:  Segment median lengths are used in the computation of segment free-flow 
speeds; which in turn affect segment running times, and the proportion of vehicle arrivals on green. 

Segment Name 
Description:  This entry documents the name of the segment being analyzed. These names can then be 
viewed within output reports, and within Quick Animation. 

Impact on model results:  None 

Segment Number of Access Points on Right 
Description:  This entry specifies the number of access points on the right-hand side of the segment. 
Unlike the “active” access points for which volumes, laneage, and locations are coded, this total number 
of access points may also include “non-active” access points (serving fewer than 10 vehicles per hour). 

Impact on model results:  The total number of access points is used in the computation of segment 
free-flow speeds; which in turn affect segment running times, and the proportion of vehicle arrivals on 
green. 

Segment Width of Intersection 
Description:  This entry specifies the width of the upstream intersection. The intersection width applies to 
the upstream boundary for a given direction of travel and is the effective width of the cross street. On a 
two-way street, it is the distance between the stop (or yield) line for the two opposing segment through 
movements at the boundary intersection, as measured along the centerline of the segment. On a one-
way street, it is the distance from the stop line to the far side of the most distant traffic lane on the cross 
street. 
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Impact on model results:  Intersection width is used in the computation of segment free-flow speed; 
which in turn affects segment running times, and the proportion of vehicle arrivals on green. 

Shared Lanes 
Description:  This entry specifies the existence of shared left-turn lanes and shared right-turn lanes. 

Impact on model results:  Approach lane configuration affects the adjusted volumes and saturation flow 
rates, thus having a fundamental impact on all aspects of the computational procedure. When analyzing 
“shared-plus-exclusive” configurations, the “Percent Turns in Shared Lane” input parameter is used to 
specify a percentage of left-turn or right-turn vehicles using the shared lane. 

Shortest Distance 
Description: This entry specifies the distance measured from the ramp movement stop bar to the conflict 
point in feet (or meters in metric), measured along the centerline of the off-ramp approach. 

Impact on model results: This entry is only applicable to DDI alternative intersections. Along with free-
flow speeds, clear-zone widths, and vehicle lengths, the space between ramp stop bar and conflict zone 
contributes to the calculation of lost times that are applied to DDI off-ramp movements. 

Sidewalk Length Adjacent to Building (multimodal) 
Description:  This entry specifies the proportion of sidewalk length adjacent to a building face. 

Impact on model results:  This proportion is used to calculate the effective sidewalk width. 

Sidewalk Length Adjacent to Fence (multimodal) 
Description:  This entry specifies the proportion of sidewalk length adjacent to a fence or low wall. 

Impact on model results:  This proportion is used to calculate the effective sidewalk width. 

Sidewalk Length Adjacent to Window (multimodal) 
Description:  This entry specifies the proportion of sidewalk length adjacent to a window display. 

Impact on model results:  This proportion is used to calculate the effective sidewalk width. 

Simultaneous Gap Out 
Description:  This entry specifies the manner in which phases are terminated before the barrier can be 
crossed to serve a conflicting call. Depending on the operating circumstances, this mode can be enabled 
or disabled. It is a phase-specific setting; however, it is typically set the same for all phases that serve the 
same street. Simultaneous gap-out dictates controller operation when a barrier must be crossed to serve 
the next call and one phase is active in each ring. If simultaneous gap-out is enabled, it requires that both 
phases reach a point of being committed to terminate (via gap out, max out, or force-off) at the same 
time. If one phase is able to terminate because it has gapped out, but the other phase is not able to 
terminate, then the gapped-out phase will reset its extension timer and restart the process of timing down 
to gap-out. If the simultaneous gap-out feature is disabled, then each phase can reach a point of 
termination independently. In this situation, the first phase to commit to termination maintains its active 
status while waiting for the other phase to commit to termination. Regardless of which mode is in effect, 
the barrier is not crossed until both phases are committed to terminate. 

Impact on model results:  The simultaneous gap-out mode is considered when computing maximum 
allowable headways (MAH) for each actuated movement. MAH impacts many aspects of the overall 
model; including actuated phase times, and control delays. 
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Sneakers 
Description:  This entry specifies the number of left-turns completed at the end of a permissive period. 

Impact on model results:  Sneakers affect the capacity of left-turn movements operating under 
protected-permissive or permissive-only phasing. Left-turn capacity then affects queue length and control 
delay for the left-turn movement. 

Speed Calibration Factor 
Description: This entry is specified by the user to adjust base free-flow speed. The default is 0.0 mi/h. 
However, if desired, a locally representative value can be determined from field-measured estimated of 
the base-free flow speed for several street segments. The local default value can be established for 
typical street segments, or for specific street types. This calibration factor is determined as the one value 
that provides a statistically based best-fit between the prediction from Equation 18-3 and the field 
measured estimates. 

Impact on model results: The Speed Calibration Factor is used in the computation of segment free-flow 
speed; which in turn affects segment running times, and the proportion of vehicle arrivals on green. 

Speed Limit 
Description:  This entry specifies the posted speed limit applicable to each movement. Speed is used in 
the methodology to estimate the maximum allowable headway of the arriving traffic stream. Speed limit is 
highly correlated with the environmental and geometric factors that have a direct influence on driver 
speed choice. As such, it represents a single input variable that is highly correlated with operating speed 
and is used as a convenient way to limit the need for numerous environmental and geometric input data 
to estimate operating speed. The convenience of using speed limit as an input variable comes with a 
caution - the analyst must not infer a cause-and-effect relationship between the input speed limit and the 
estimated performance measures. More specifically, the computed change in performance resulting from 
a change in the input speed limit is not likely to be indicative of performance changes that will actually be 
realized. Research indicates that a change in speed limit has a proportionally smaller effect on the actual 
operating speed. The methodology is based on the assumption that the posted speed limit is: (1) 
consistent with that found on other streets in the vicinity of the subject intersection and (2) consistent with 
agency policy regarding specification of speed limits. If it is known that the posted speed limit does not 
satisfy these assumptions, then the speed limit value that is input to the procedure should be adjusted 
such that it is consistent with the assumptions. 

Impact on model results:  Within the computational procedure, speed limits are first converted to free-
flow speeds (AverageSpeedtoFFSRatio = 0.90 by default) for each movement. Next, the free-flow speeds 
are then used to compute maximum allowable headways (MAH) for each actuated movement. MAH 
impacts many aspects of the overall model; including actuated phase times, and control delays. Speed 
limits are also used to compute accel-decel delays, which affect the computation of uniform stops and 
uniform queue. 

Split Optimization Flag 
Description:  This entry specifies whether or not phase splits are to be optimized in a signal timing 
optimization run. 

Impact on model results:  This entry is only applicable to optimization runs. 

Split Phase 
Description:  This entry specifies whether or not the split phasing is in effect for phases 4 and 8, 
meaning that phases 4 and 8 occur sequentially instead of concurrently. Split phasing is generally not 
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used on the major street (phases 2 and 6). Split phasing is commonly used to reduce the probability of 
accidents at intersections with sight distance problems. 

Impact on model results:  Changing the minor street phasing sequence (via Split Phase) could affect 
the times during which cross street vehicles are released on to the major street, affecting the proportion of 
arrivals on green. The proportion of arrivals on green impacts many aspects of the overall model; 
including queue service times, actuated phase times, and control delays. To the extent that split phasing 
is used in lieu of standard phasing, it will typically increase queue lengths and control delays at the 
subject intersection. However, this is sometimes seen as an acceptable price to pay for reducing the 
probability of accidents (at intersections with sight distance problems). 

Start Time 
Description:  This entry specifies the clock time (hh:mm) at the beginning of the analysis period. For 
example, 17:00 could be used to indicate the beginning of the 5:00 PM peak hour. Start times are listed at 
the top of the formatted reports. 

Impact on model results:  None 

Start-Up Lost Time 
Description:  This entry specifies the additional time consumed by the first few vehicles in a queue at a 
signalized intersection, above and beyond the saturation headway, because of the need to react to the 
initiation of the green phase (and to accelerate). 

Impact on model results:  Start-up lost times affect the calculation of actuated phase times and queue 
service times. 

Stop Speed 
Description:  This entry specifies the speed below which a vehicle is said to be stopped. 

Impact on model results:  Stop speed affects the calculation of accel-decel delays, which in turn affect 
the computation of uniform stops and uniform queue. 

Stops with Benches (multimodal) 
Description:  This entry specifies the proportion of transit stops that provide benches to sit on. A shelter 
with a bench is counted twice, once as a shelter and a second time as a bench. 

Impact on model results:  The proportion of transit stops with benches is used to compute the perceived 
travel time rate. 

Stops with Shelters (multimodal) 
Description:  This entry specifies the proportion of transit stops that provide a structure with a roof and 
three enclosed sides that protect occupants from wind, rain, and sun. A shelter with a bench is counted 
twice, once as a shelter and a second time as a bench. 

Impact on model results:  The proportion of sheltered transit stops is used to compute the perceived 
travel time rate. 

Stored Heavy Vehicle Length 
Description:  This entry specifies the lane length occupied by a queued heavy vehicle. 

Impact on model results:  Stored heavy vehicle length affects the computation of queue storage ratio. 
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Stored Vehicle Length 
Description:  This entry specifies the lane length occupied by a queued vehicle. 

Impact on model results:  Stored vehicle length is considered when estimating the amount of time until 
onset of queue spillback. Stored vehicle length also affects access point operations. 

System Cycle Length 
Description:  This entry specifies the background cycle length applicable to the urban street system. The 
cycle length represents the total time for a signal to complete one cycle. 

Impact on model results:  For uncoordinated (Chapter 19) operations, the cycle length input data entry 
is not used; instead, the cycle length is automatically recomputed by the procedure. For coordinated 
(Chapter 18) operations, the cycle length applies to all intersections, and will not be recomputed by the 
procedure. The cycle length affects most aspects of the overall model; including control delay, queue 
lengths, and travel time. 

Total Number of Access Points (multimodal) 
Description:  This entry specifies the number of access point approaches on the right side in the subject 
direction of travel. 

Impact on model results:  The total number of access points affects the bicycle LOS score for the 
segment. 

Total Walkway Width (multimodal) 
Description:  The total walkway width is measured from the outside edge of the road pavement (or face 
of curb, if present) to the far edge of the sidewalk (as sometimes delineated by building face, fence, or 
landscaping). 

Impact on model results:  Total walkway width is used to compute the effective sidewalk width. 

Transit Frequency (multimodal) 
Description:  This entry specifies the count of scheduled fixed route transit vehicles that stop on or near 
the segment during the analysis period. Scheduled transit vehicles can be considered “local” or 
“nonlocal.”  Local transit vehicles make regular stops along the street (typically every 0.25 miles, or 0.402 
kilometers in metric, or less); although they do not necessarily stop within the analysis segment when 
segment lengths are short, or when stops alternate between the near and far sides of boundary 
intersections. They are always counted, regardless of whether they stop within the subject segment. Non-
local transit vehicles operate on routes with longer stop spacing than local routes (e.g., limited-stop, bus 
rapid transit, or express routes). They are only counted when they stop within the subject segment. 

Impact on model results:  Transit frequency is used to compute the transit wait-ride score. 

Transit Stop Near Side (multimodal) 
Description:  This entry specifies whether a transit stop is located on the near side of a boundary 
intersection or elsewhere. A portion of the time required to serve a near-side transit stop at a boundary 
intersection may overlap with the control delay incurred at the intersection. 

Impact on model results:  Transit stop location is used to compute the transit stop delay due to 
acceleration and deceleration. 
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Transit Stop On-Line (multimodal) 
Description:  This entry specifies whether a transit stop is on-line, where the bus stops entirely or mostly 
in the travel lane and does not have to yield to other vehicles upon exiting the stop, or off-line, where the 
bus pulls out of the travel lane to serve the stop and may have to yield to other vehicles upon exiting. 

Impact on model results:  Transit stop position is used to compute the delay due to a transit stop. 

Turn Bay Length and Segment Length 
Description:  For left-turns and right-turns this entry specifies turn pocket lengths for each approach. For 
through movements this entry specifies segment lengths for each approach. Turn bay length represents 
the length of the bay for which the lanes have full width and in which queued vehicles can be stored. The 
turn bay length does not include the bay taper. Bay length is measured parallel to the roadway centerline. 
If there are multiple lanes in the bay and they have different lengths, then the length entered should be an 
average value. If a two-way left-turn lane is provided for left-turning vehicle storage and adjacent access 
points exist, then the bay length entered should represent the “effective” storage length available to the 
subject left-turn movement. The effective length must consider adjacent access points and their 
associated left-turn vehicles, which may also store in the two-way left-turn lane. 

Impact on model results:  Turn bay lengths and segment lengths affect the "queue storage ratio" output, 
and the time until onset of queue spillback. 

Turn Radius 
Description:  This entry specifies the left-turn radius and right-turn radius. 

Traffic movements that discharge along a curved travel path do so at rates lower than those of through 
movements. The equivalent number of thru cars for a protected turn-movement is calculated with the 
following equation: 

E = 1 + (5.61/R) 

where R is the radius of curvature of the left- or right-turning path (at the center of the path), in feet. 

The default value of 112 ft (or 34.1 m in metric) for left-turn movements yields left-turn equivalency factor 
EL = 1.05 and the default value of 32 ft (or 9.8 m in metric) for right-turn movements yields right-turn 
equivalency factor ER = 1.18. 

Impact on model results:  Turn radius affects the left-turn equivalency factor (typically 1.05), and the 
right-turn equivalency factor (typically 1.18). These equivalency factors affect the saturation flow rate of 
left-turn movements and right-turn movements. 

Two-Way Pedestrian Volume (multimodal) 
Description:  This entry specifies total pedestrian volume traveling along the urban street segment, 
between boundary intersections. 

Impact on model results:  Two-way pedestrian volume affects the pedestrian flow per unit width of 
sidewalk. 

Unblocked Lanes 
Description: This entry specifies the number of open lanes when blockage is present along the segment. 

Impact on model results: The number of unblocked lanes is used in the computation of midsegment 
capacity, which in turn is used in the computation of the adjustment factor for downstream lane blockage. 
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Uncoordinated Flag 
Description:  If an intersection is flagged as uncoordinated, it will be analyzed in accordance with 
Chapter 19 (signalized intersections) procedures. If an intersection is flagged as coordinated, it will be 
analyzed in accordance with Chapter 18 (urban streets) procedures. 

Impact on model results:  For uncoordinated (Chapter 19) operations, each intersection is analyzed 
independently of all other intersections, and the cycle length is variable. For coordinated (Chapter 18) 
operations, each intersection is potentially affected by the operation of nearby intersections, and the cycle 
length is constant. 

Unsignalized Delay 
Description: When a movement is marked as Unsignalized, this field will enable, allowing the user to 
manually input control delay for the movement, instead of having the signalized control delay calculated. 

Impact on model results: Unsignalized delay will affect the approach and intersection delay. 

Unsignalized Movement 
Description: This checkbox allows the user to mark a movement as Unsignalized. If the movement is 
considered as Unsignalized, it is considered as not controlled by traffic signals and all relevant signalized 
calculations will be hidden for the specified movement. 

Impact on model results: Marking a movement as unsignalized will affect the approach and intersection 
delay. 

Upstream 
Description: This button opens a dialog box for the user to select and open the upstream crossover 
junction file coded in TWSC. Once opened, the TWSC file (.xtw) becomes attached in the Streets module. 

Impact on model results: This button is only applicable to MUT with TWSC alternative intersections and 
is necessary for the completion of one MUT with Stop Signs alternative intersection. 

Upstream Filtering Adjustment Factor 
Description:  This entry accounts for the effect of “filtered” arrivals from upstream signals on delay. In 
other words, the upstream filtering adjustment factor (I) reflects the way that an upstream signal 
decreases the variance in the number of arrivals per cycle at the subject intersection. The decrease in 
variance can reduce cycle failure frequency and resulting delay. The filtering adjustment factor varies in 
value from 0.09 to 1.0. A value of 1.0 is appropriate for an isolated intersection (i.e., one that is at least 
one mile, or 1.6 kilometers in metric, from the nearest upstream signalized intersection). A value of less 
than 1.0 is appropriate for non-isolated intersections. The equation I = 1.0 - 0.91Xu^2.68 is used to 
compute I for non-isolated intersections. The variable Xu is computed as the weighted volume-to-capacity 
ratio of all upstream movements contributing to volume in the subject movement group. This ratio is 
computed as a weighted average with the volume-to-capacity ratio of each contributing upstream 
movement weighted by its discharge volume. The procedure automatically performs this calculation for 
internal movements with an upstream signal. If desired the user may override the computed value with 
their own entered value, or restore the computed value by blanking out the input field. For planning and 
preliminary design analyses, Xu can be approximated as the weighted volume-to-capacity ratio of the 
movement groups serving through movements at the upstream signalized intersection. Note: The 
adjacent button will open a file dialog screen to identify the Signals file for the upstream signal. If a file is 
selected, the appropriate volume-to-capacity ratios will be averaged as described above and the I-factor 
computed automatically. 
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Impact on model results:  The upstream filtering adjustment factor (also known as the I-factor) is used 
in the calculation of incremental delay, incremental queue, and incremental stops. Note: Since flow rates 
and signal timing can affect the volume-to-capacity ratio of the upstream signal due to changes in the flow 
profile, changes to these values in the subject intersection can cause the I-factor to change in the subject 
intersection. 

Urban Street 
Description:  This entry is used to document the name of the urban street. 

Impact on model results:  None 

Urban Street Forward Direction 
Description:  This entry typically specifies the direction of "phase 2" in the timing plan. 

Impact on model results:  Reversing the urban street forward direction could cause forward direction 
segment-specific MOEs (e.g., running speed, travel time) to be reported for the reverse direction, and 
vice-versa. 

U-Turn Crossover Median Width 
Description:  This entry specifies the U-turn crossover median width range for RCUT alternative 
intersections. 

Impact on model results:  This entry is only applicable to RCUT alternative intersections. U-turn 
crossover median width affects the saturation flow rate of the u-turn crossover movements. 

U-Turn Volume 
Description:  This entry specifies the U-turn volume for interchange ramp terminals. Please note that this 
field is for the interchange (not intersection) U-turn demands – the traffic exiting the freeway in one 
direction, then navigating the arterial to reenter the freeway traveling in the opposite direction. Typically, 
each intersection would include one value as appropriate for the interchange design. 

Impact on model results:  U-turn volume affects the lane utilization adjustment factor for interchange 
ramp terminals. 

Walk plus Pedestrian Clear Setting 
Description:  The walk interval is intended to give pedestrians adequate time to perceive the WALK 
indication and depart the curb before the pedestrian change interval begins. The walk setting is typically 7 
seconds, or more, for an actuated or a non-actuated coordinated phase. Longer walk durations should be 
considered in school zones and areas with large numbers of elderly pedestrians. It is assumed that the 
rest-in-Walk mode is not enabled for actuated phases and non-coordinated phases. For a pre-timed 
phase, the walk interval is often set at a value equal to the green interval duration less the pedestrian 
clear setting (provided that it exceeds the minimum time need for pedestrian perception and reaction). For 
a coordinated phase, the controller is sometimes set to use a coordination mode that extends the walk 
interval for most of the green interval duration. This functionality is not explicitly modeled in the 
automobile methodology but it can be approximated by setting the walk interval to a value equal to the 
phase split less the pedestrian clear setting and less the change period (i.e., the yellow change interval 
plus the red clearance interval). If the walk and pedestrian clear settings are provided for a phase, then it 
is assumed that a pedestrian signal head is also provided. If these settings are not used, then it is 
assumed that any pedestrian accommodation needed is provided in the minimum green setting. The 
pedestrian clear interval (also referred to as the pedestrian change interval) is intended to provide time for 
pedestrians that depart the curb during the WALK indication to reach the opposite curb (or the median). 
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Some agencies set the pedestrian clear equal to the “crossing time,” where crossing time equals the 
curb-to-curb crossing distance in ft (or m in metric) divided by the pedestrian walking speed of 3.5 ft/s 
(1.07 m/s in metric). Other agencies set the pedestrian clear equal to the crossing time less the change 
period. This choice is dependent on agency policy. A flashing DON’T WALK indication is displayed during 
this interval. 

Impact on model results:  The Walk + PC interval is used to compute the probability of a phase call. 
This in turn potentially affects actuated phase times and control delays for all movements. 

Walkway Width (multimodal) 
Description:  The total walkway width is measured from the outside edge of the road pavement (or face 
of curb, if present) to the far edge of the sidewalk (as sometimes delineated by building face, fence, or 
landscaping). 

Impact on model results:  Walkway width affects the available corner time-space. 

Weights, % 
Description: Defines the weight given to each performance measure to the objective function used by 
Streets optimization algorithm. Must add up to 100%. 

Impact on model results: Changing the weight scheme may lead to slightly different timing results when 
different feasible results exist. 

Width of Clear Zone 
Description: This entry specifies the width of the clear zone for the longest vehicle path in feet (or meters 
in metric), measured along the centerline of the outside lane, which is the closest conflicting vehicle path 
to the ramp. 

Impact on model results: This entry is only applicable to DDI alternative intersections. Along with free-
flow speeds, vehicle lengths, and the space between ramp stop bar and conflict zone, clear-zone widths 
contribute to the calculation of lost times that are applied to DDI off-ramp movements. 

Work Zone Approach Width 
Description:  The approach width during the work zone is coded in feet (or meters in metric) for all open 
left, thru and right lanes. 

Impact on model results:  This generates the saturation flow rate adjustment for approach width during 
work zone presence. This value is used in the computation of the overall saturation flow rate adjustment 
factor for work zone presence to further reduce the default of 0.858 if applicable. 

Work Zone Left Thru Lanes Open 
Description:  The number of left and thru lanes open during the work zone is used to compare with the 
number coded for normal operations. 

Impact on model results:  This generates the saturation flow rate adjustment for reducing lanes during 
work zone presence. This value is used in the computation of the overall saturation flow rate adjustment 
factor for work zone presence to further reduce the default of 0.858 if applicable. 

Work Zones 
Description:  Identifying an approach as having a work zone implements a series of equations to 
compute a saturation flow rate adjustment factor. 
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Impact on model results:  The saturation flow rate adjustment factor is applied to lane groups 
associated with the approach, to model the work zone presence. 

Yellow Time 
Description:  This entry specifies the yellow (or amber) change interval duration displayed by the signal 
for the given phase. 

Impact on model results:  Yellow time affects the amount of available green time, which impacts most 
aspects of the overall model; including queue lengths, stops, and control delays. Yellow time may also 
affect the probability of traffic accidents under certain conditions. 
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